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Розглянуто ключові поняття, пов’язані з сучасним розвитком 

інформаційних систем та комп’ютерних технологій. Наведено основні 

елементи структури сучасних комп’ютерів та периферійних пристроїв. 

Проаналізовано структуру та особливості сучасного програмного 

забезпечення. Наведено класифікацію сучасних операційних систем. 

Розраховано на підготовку кваліфікованих користувачів, які знають 

будову комп’ютера й основні принципи його роботи.  

Рекомендовано для студентів напрямів підготовки «Туризм», 

«Бізнес-адміністрування», «Менеджмент інноваційної діяльності». 

 

 

Key aspects, connected with the modern development of information 

computer systems and technologies are considered. Basic elements of 

modern computers and peripherals are given. The structure and peculiarities 

of modern software are analyzed. The classification of modern operation 

systems is given. It is meant for preparation of qualified users, who know the 

structure and main principles of computers’ work. 

It is recommended for students of preparatory direction “Tourism”, 

“Business Administration”, “Innovations management”.  
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Preface 

This summary of lectures has been prepared for the use by students 

interested in information systems and technologies. While we have tried to 

present our advice as clearly and as fully as it is possible within a short form, 

this handbook is not a substitute for direct contact with the faculty. 

What is information systems and technologies? First of all it is not about 

programming. It is more concentrated on how computers function and how 

they run different programs. That’s why the object of this handbook is 

represented by the study of basic principles that govern operation of modern 

personal computers. Within this concept a special attention is given to the 

analysis of computer architecture, computer periphery and basic computer 

software. Each part of computer hardware is disclosed in detail and in close 

interconnection with other parts. Basic MS Office package applications are 

considered and given a detailed explanation. The purpose of this handbook 

is to make students of economic specialities become aware of information 

systems and technologies basic principles and concepts and as a result get 

the following professional competencies: 

to know basic trends in information systems development in the context 

of the economy of a new type; 

to know what parts a personal computer consists of and what the 

purpose of each part is; 

to know what kinds of computer peripherals can be connected to a 

personal computer and what their purpose and architecture is; 

to be aware of existing types of computer software and the role and 

purpose of each type of software. 

The summary of lectures covers the first part of the “Information 

systems and technologies” discipline called “Computer science”. The course 

is taught to the first-year students of economic specialities. Structurally the 

summary of lectures is divided into six separate sections which together 

cover the lecture material for first-year students of the “Tourism”, “Business 

Administration” and “Innovations management” specialities. 

The handbook is constructed to make it easy for readers to find and 

learn the basic points of the theoretic material. This is achieved through the 

use of visual accents for most important parts of the material and also thanks 

to a considerable number of original illustrations. Most relaxing pictures, used 

to make the study of the discipline a real fun, are taken from the caricatures 

created by a renowned caricaturist Herluf Bidstrup. 
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Section 1. Theoretic basics of information systems 

and technologies as a field of scientific research. 

Computer hardware and its structure 

Theme 1. Introduction to information systems and 

technologies and its connection to computer science 
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Fig. 1.1. System elements of the theme 
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 Introduction 

The purpose of this theme is to give a basic idea of the role of 

information in computer science and in human activity in general. The theme 

covers questions such as the place of information in facilitating processes 

connected with information tendencies such as coming of the Information 

age, increasing role of information work etc. Special attention is given to 

interdisciplinary relations of information technologies and computer science. 

Clue notions of the theme include: information; information work; 

information age; stages of economic development; information system; 

information technology; branches of computer science; forms of information. 

This theme covers the following topics: Connection of information 

systems and technologies to computer science. What is information? What 

are the forms of information? Which stages did the humankind pass during its 

economic development? What are the main branches of computer science? 

How is computer science connected with other disciplines? What is 

information technology and how does it affect the development of computer 

science? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the notion and concept of information; 

they would learn the nature of computer science and its interdisciplinary 

connections; 

they would become aware of what information technologies are and 

how they influence the development of modern society and computer science 

in particular. 

 

1.1. Information systems and technologies. Computer science. 

Connection of computer science to other disciplines 

 Information systems and technologies (IS&T) is an 

academic/professional discipline concerned with the strategic, managerial 

and operational activities involved in the gathering, processing, storing, 

distributing and use of information, and its associated technologies, in society 

and organizations. 

The term “information systems and technologies” is also used to 

describe an organizational function that applies information systems and 
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technologies knowledge in industry, government agencies and not-for-profit 

organizations. 

Information systems are implemented within an organization for the 

purpose of improving the effectiveness and efficiency of that organization. 

Capabilities of the information system and characteristics of the organization, 

its work systems, its people, and its development and implementation 

methodologies together determine the extent to which that purpose is 

achieved. 

As an area of study, IS&T includes the multidisciplinary business field 

and the interdisciplinary computer science field that is evolving toward a new 

scientific discipline. IS&T course is a broader field that includes computer 

science course as its main constituent part. At this point we would consider 

IS&T and computer science to be coinciding notions. 

 Computer Science is study of the theory, experimentation, and 

engineering that forms the basis for the design and use of computers — 

devices that automatically process information.               

Computer science traces its roots to the work done by English 

mathematician Charles Babbage, who first proposed a programmable 

mechanical calculator in 1837 (fig. 2). 

 

Fig. 1.2. Charles Babbage’s difference engine [14] 
 

Until the advent of electronic digital computers in the 1940s, computer 

science was not generally distinguished as being separate from mathematics 

and engineering. Since then it has sprouted numerous branches of research 

that are unique to the discipline. 

The general public sometimes confuses computer science with 

vocational areas that deal with computers (such as information technology), 

http://en.wikipedia.org/wiki/Information_technology
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or think that it relates to their own experience of computers, which typically 

involves activities such as gaming, web-browsing, and word-processing.  

However, the focus of computer science is more on understanding the 

properties of the programs used to implement software such as games and 

web-browsers, and using that understanding to create new programs or 

improve existing ones. 

The early foundations of what would become computer science predate 

the invention of the modern digital computer. Machines for calculating fixed 

numerical tasks, such as the abacus, have existed since antiquity. Wilhelm 

Schickard built the first mechanical calculator in 1623. Charles Babbage 

designed a difference engine in Victorian times helped by Ada Lovelace. 

Around 1900, punch-card machines were introduced. However, all of these 

machines were constrained to perform a single task, or at best some subset 

of all possible tasks. 

During the 1940s, as newer and more powerful computing machines 

were developed, the term computer came to refer to the machines rather 

than their human predecessors. As it became clear that computers could be 

used for more than just mathematical calculations, the field of computer 

science broadened to study computation in general. Computer science began 

to be established as a distinct academic discipline in the 1960s, with the 

creation of the first computer science departments and degree programs. 

Since practical computers became available, many applications of computing 

have become distinct areas of study in their own right. 

Although many initially believed it impossible that computers them-

selves could actually be a scientific field of study, in the late fifties it gradually 

became accepted among the greater academic population. 

It is the now well-known IBM brand that formed part of the computer 

science revolution during this time. IBM (short for International Business 

Machines) released the IBM 704 and later the IBM 709 computers, which 

were widely used during the exploration period of such devices. "Still, working 

with the IBM [computer] was frustrating...if you had misplaced as much as 

one letter in one instruction, the program would crash, and you would have to 

start the whole process over again". During the late 1950s, the computer 

science discipline was very much in its developmental stages, and such 

issues were commonplace. 

Time has seen significant improvements in the usability and 

effectiveness of computer science technology. Modern society has seen a 

http://en.wikipedia.org/wiki/Digital_computer
http://en.wikipedia.org/wiki/Abacus
http://en.wikipedia.org/wiki/Wilhelm_Schickard
http://en.wikipedia.org/wiki/Wilhelm_Schickard
http://en.wikipedia.org/wiki/Charles_Babbage
http://en.wikipedia.org/wiki/Difference_engine
http://en.wikipedia.org/wiki/Victorian_era
http://en.wikipedia.org/wiki/Ada_Lovelace
http://en.wikipedia.org/wiki/Key_punch
http://en.wikipedia.org/wiki/Computation
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significant shift from computers being used solely by experts or professionals 

to a more widespread user base. 

Computer science can be divided into four main fields (fig. 1.3): 

software development, computer architecture (hardware), human-computer 

interfacing (the design of the most efficient ways for humans to use 

computers), and artificial intelligence (the attempt to make computers behave 

intelligently). 

Computer science

Artificial intelligence 

Human-computer 

interfacing

Software development

Computer architecture 

Information systems and 

technologies

 

Fig. 1.3. The structure of computer science 
 

Software development is concerned with creating computer programs 

that perform efficiently. Computer architecture is concerned with developing 

optimal hardware for specific computational needs. The areas of artificial 

intelligence (AI) and human-computer interfacing often involve the 

development of both software and hardware to solve specific problems. 

Software Development. In developing computer software, computer 

scientists and engineers study various areas and techniques of software 

design, such as the best types of programming languages and algorithms to 

use in specific programs, how to efficiently store and retrieve information, and 

the computational limits of certain software-computer combinations.  

Algorithms and data structures are the building blocks of computer 

programs and software applications. 
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 An algorithm is a precise step-by-step procedure for solving a 

problem within a finite time and using a finite amount of memory. 

 
Software engineers use programming languages to communicate 

algorithms to a computer. Natural languages such as English are ambiguous, 

meaning that their grammatical structure and vocabulary can be interpreted in 

multiple ways, so they are not suited for programming. Instead, simple and 

unambiguous artificial languages are used.  

Computer Architecture. Computer architecture is the design and 

analysis of new computer systems. Computer architects study ways of 

improving computers by increasing their speed, storage capacity, and 

reliability, and by reducing their cost and power consumption. The 

optimization of computer architecture to specific tasks often yields higher 

performance, lower cost, or both. 

Artificial Intelligence. Artificial intelligence (AI) research seeks to 

enable computers and machines to imitate human intelligence and sensory 

processing ability, and models human behavior with computers to improve 

our understanding of intelligence. The many branches of AI research include 

machine learning, inference, cognition, knowledge representation, problem 

solving, case-based reasoning, natural language understanding, speech 

recognition, computer vision, and artificial neural networks. 

Human-Computer Interfacing. Human-computer interfaces provide 

the means for people to use computers. An example of a human-computer 

interface is the keyboard, which lets humans enter commands into a 

computer and enter text into a specific application. 

Connection of computer science to other disciplines. 

Because computer science grew out of mathematics and electrical 

engineering, it retains many close connections to those disciplines. 
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Theoretical computer science draws many of its approaches from 

mathematics and logic. Research in numerical computation overlaps with 

mathematics research in numerical analysis. Computer architects work 

closely with the electrical engineers who design the circuits of a computer. 

Beyond these historical connections, there are strong ties between AI 

research and psychology, neurophysiology, and linguistics. Human-computer 

interface research also has connections with psychology. Roboticists work 

with both mechanical engineers and physiologists in designing new robots. 

Computer science also has indirect relationships with virtually all 

disciplines that use computers. Applications developed in other fields often 

involve collaboration with computer scientists, who contribute their knowledge 

of algorithms, data structures, software engineering, and existing technology. 

In return, the computer scientists have the opportunity to observe novel 

applications of computers, from which they gain a deeper insight into their 

use. These relationships make computer science a highly interdisciplinary 

field of study. 

 
Some universities teach computer science as a theoretical study of 

computation and algorithmic reasoning. These programs often feature the 

theory of computation, analysis of algorithms, formal methods, concurrency 

theory, databases, computer graphics and systems analysis, among others. 

They typically also teach computer programming, but treat it as a vessel for 

the support of other fields of computer science rather than a central focus of 

high-level study. 

Other colleges and universities, as well as secondary schools and 

vocational programs that teach computer science, emphasize the practice of 

advanced programming rather than the theory of algorithms and computation 

http://en.wikipedia.org/wiki/Theory_of_computation
http://en.wikipedia.org/wiki/Analysis_of_algorithms
http://en.wikipedia.org/wiki/Formal_methods
http://en.wikipedia.org/wiki/Concurrency_(computer_science)
http://en.wikipedia.org/wiki/Concurrency_(computer_science)
http://en.wikipedia.org/wiki/Databases
http://en.wikipedia.org/wiki/Computer_graphics
http://en.wikipedia.org/wiki/Systems_analysis
http://en.wikipedia.org/wiki/Computer_programming
http://en.wikipedia.org/wiki/Secondary_school
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in their computer science curricula. Such curricula tend to focus on those 

skills that are important to workers entering the software industry. The 

practical aspects of computer programming are often referred to as software 

engineering. However, there is a lot of disagreement over the meaning of the 

term, and whether or not it is the same thing as programming. 

 

1.2. Information. Basic forms of information. Information age 

Information always has been extremely important. Throughout history 

some information has had value beyond measure. 

The lack of information often cost huge amounts of money and, 

sometimes, many lives. 

 Information as a concept has a diversity of meanings, from 

everyday usage to technical settings. Generally speaking, the concept of 

information is closely related to notions of constraint, communication, control, 

data, form, instruction, knowledge, meaning, mental stimulus, pattern, 

perception,  representation.               

Information is: 

1) knowledge acquired through experience or study; 

2) knowledge of specific and timely events or situations; news; 

3) the act of informing or the condition of being informed (fig. 1.4). 

INFORMATIONMessage

Pattern Sensory input

Impulse to 

transformation 

Records
Impulse to pattern 

transformation 

 
Fig. 1.4. Forms of information 

There exist several basic forms of information. 

1. Information as a message. 

Information is the state of a system of interest. Message is the 

information materialized. 

http://en.wikipedia.org/wiki/Software_engineering
http://en.wikipedia.org/wiki/Software_engineering
http://en.wikipedia.org/wiki/Debates_within_software_engineering
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Information is always about something. Viewed in this manner, 

information does not have to be accurate; it may be a truth or a lie, or just the 

sound of a falling tree.  

This model assumes there is a definite sender and at least one 

receiver. Many refinements of the model assume the existence of a common 

language understood by the sender and at least one of the receivers. 

2. Information as a pattern. 

Information is any represented pattern. This assumes a separation 

between an object and its representation. Consider the following example: 

economic statistics represent an economy. 

But if information can be defined merely as a pattern, does that mean 

that neither utility nor meaning are necessary components of information? 

Arguably a distinction must be made between raw unprocessed data and 

information which possesses utility, value or some quantum of meaning. On 

this view, information may indeed be characterized as a pattern; but this is a 

necessary condition, not a sufficient one. The gap between data and 

information is only closed by a behavioral bridge whereby some value, utility 

or meaning is added to transform mere data or pattern into information. 

3. Information as sensory input. 

Often information is viewed as a type of input to an organism or 

designed device. Inputs are of two kinds. Some inputs are important to the 

function of the organism (for example, food) or device (energy) by 

themselves. Other inputs (information) are important only because they are 

associated with causal inputs and can be used to predict the occurrence of a 

causal input at a later time. For example, light is often a causal input to plants 

but provides information to animals. 

4. Information as an influence which leads to a transformation. 

5. Information is any type of pattern that influences the formation 

or transformation of other patterns. 

6. Information as records. 

Records are a specialized form of information. Essentially, records are 

information produced consciously or as by-products of business activities or 

transactions and retained because of their value. For example, in the 

previous sense, there is no need for a conscious mind to perceive, much less 

appreciate, the pattern. Consider, for example, DNA. The sequence of 

nucleotides is a pattern that influences the formation and development of an 

organism without any need for a conscious mind. 

http://en.wikipedia.org/wiki/Sender
http://en.wikipedia.org/wiki/Pattern
http://en.wikipedia.org/wiki/Economic_statistics
http://en.wikipedia.org/wiki/Economics
http://en.wikipedia.org/wiki/Utility
http://en.wikipedia.org/wiki/Value_(economics)
http://en.wikipedia.org/wiki/Necessary
http://en.wikipedia.org/wiki/Sufficient
http://en.wikipedia.org/wiki/Input
http://en.wikipedia.org/wiki/Organism
http://en.wikipedia.org/wiki/Energy
http://en.wikipedia.org/wiki/DNA
http://en.wikipedia.org/wiki/Nucleotide
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Information itself is useless unless it is used in some process that 

brings some economic effect or value. So, information must work in order to 

be information, not just data. Information is a very important participant in 

information work. As Bill Gates stated, “information work is thinking work. 

When thinking and working together are significantly assisted bу computer 

technology, уоu have а digital nervous system. It consists of the advanced 

digital processes that knowledge workers use to make better decisions – to 

think, act, react, and adapt”. 

The notion of information is closely connected with the notion of 

Information age. Information age is considered the last and most progressive 

stage of human development. 

Thus the following stages of economic development can be marked 

out: 

1. Pre-industrial stage – farming, mining and mineral extraction. 

2. Industrial stage – producing of goods. 

3. Post-industrial stage – producing of services. 

4. Information stage (Information Age) – producing, processing, 

exchange and consumption of information (see metaphor on fig. 1.5). 

 
Fig. 1.5. Information Age metaphor [17] 

 

 Information Age is a term that has been used to refer to the present 

era. The name alludes to the global economy's shift in focus away from the 

production of physical goods (as exemplified by the industrial age) and 

towards the manipulation of information.               

Most researchers connect quick coming of the information age with fast 

development of Internet technologies. The Internet was originally conceived 

as a distributed, fail-proof network that could connect computers together and 

be resistant to any one point of failure; the Internet can't be totally destroyed 

http://en.wikipedia.org/wiki/Internet
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in one event, and if large areas are disabled, the information is easily re-

routed. It was with the invention of the World Wide Web in 1989 that the 

Internet really became a global network. Today the Internet has become the 

ultimate place to accelerate the flow of relevant information and the fastest 

growing form of media. 

The Information Age means something different to everyone. In 1956 in 

the United States, researchers noticed that the number of people holding 

"white collar" jobs had just exceeded the number of people holding "blue 

collar" jobs. These researchers realized that this was an important change, 

as it was clear that the Industrial Age was coming to an end. As the Industrial 

Age ended, the newer times adopted the title of "the Information Age". Of 

course, at that time relatively few jobs had much to do with computers and 

computer-related technology. What was occurring was a steady trend away 

from people holding Industrial Age manufacturing jobs. An increasing number 

of people held jobs as clerks in stores, office workers, teachers, nurses, etc. 

The Western world was shifting into a service economy. 

Eventually, Information and Communication Technology — computers, 

computerized machinery, fiber optics, communication satellites, Internet, and 

other ICT tools — became a significant part of the economy. Microcomputers 

were developed, and many business and industries were greatly changed by 

ICT. Nicholas Negroponte captured the essence of these changes in his 1995 

book, Being Digital. At the time, he was the head of the Massachusetts 

Institute of Technology's Media Lab. His book discusses similarities and 

differences between products made of atoms and products made of bits. In 

essence, one can very cheaply and quickly make a copy of a product made of 

bits, and ship it across the country or around the world both quickly and at 

very low cost. Nowadays, many people tend to think of the Information Age in 

terms of cell phones, digital music, high definition television, digital cameras, 

email on the Internet, the Web, computer games, and other relatively new 

products and services that have come into widespread use. The pace of 

change brought on by such technology has been very rapid. 

 

1.3. Information technologies 

 Information technology (IT) is the study, design, development, 

implementation, support or management of computer-based information 

systems, particularly software applications and computer hardware.               

http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Researchers
http://en.wikipedia.org/wiki/White_collar
http://en.wikipedia.org/wiki/Blue_collar
http://en.wikipedia.org/wiki/Blue_collar
http://en.wikipedia.org/wiki/Industrial_Revolution
http://en.wikipedia.org/wiki/Service_economy
http://en.wikipedia.org/wiki/Information_and_Communication_Technology
http://en.wikipedia.org/wiki/Nicholas_Negroponte
http://en.wikipedia.org/wiki/Being_Digital
http://en.wikipedia.org/wiki/Massachusetts_Institute_of_Technology
http://en.wikipedia.org/wiki/Massachusetts_Institute_of_Technology
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IT deals with the use of electronic computers and computer software to 

convert, store, protect, process, transmit, and securely retrieve information. 

The term Information Technology (IT) was coined by Jim Domsic of 

Michigan in November 1981. Domsic created the term to modernize the 

outdated phrase "data processing". Domsic at the time worked as a computer 

manager for an automotive related industry. 

Today, the term “information technology” has ballooned to encompass 

many aspects of computing and technology, and the term has become very 

recognizable. The information technology umbrella can be quite large, 

covering many fields. IT professionals perform a variety of duties that range 

from installing applications to designing complex computer networks and 

information databases. A few of the duties that IT professionals perform may 

include data management, networking, engineering computer hardware, 

database and software design, as well as the management and 

administration of entire systems. 

When computer and communication technologies are combined, the 

result is information technology, or “infotech”. Information Technology (IT) is a 

general term that describes any technology that helps to produce, 

manipulate, store, communicate, and/or disseminate information. When 

speaking of Information Technology (IT) as a whole, it should be noted that 

the use of computers and information are associated. 

 

 

 Questions 

 

1. What is computer science and which branches does it include? 

2. How do information technologies affect the development of 

Information age tendencies? 

3. What is information work and what is the difference between this 

kind of work and other kinds of human activities? 

4. What are the basic stages of economic development? 

5. What is information technology and what areas does it cover? 

 

 

 

 

 

http://en.wikipedia.org/wiki/Computers
http://en.wikipedia.org/wiki/Computer_software
http://en.wikipedia.org/wiki/Data_conversion
http://en.wikipedia.org/wiki/Computer_data_storage
http://en.wikipedia.org/wiki/Data_security
http://en.wikipedia.org/wiki/Data_processing
http://en.wikipedia.org/wiki/Data_transmission
http://en.wikipedia.org/wiki/Classified_information
http://en.wikipedia.org/wiki/Information_retrieval
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/Database
http://en.wikipedia.org/wiki/Data_management
http://en.wikipedia.org/wiki/Computer_hardware
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Theme 2. Computer architecture 
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Fig. 2.1. System elements of the theme 
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 Introduction 

The purpose of this theme is to give a clear understanding of the 

structure of computer architecture as a field of scientific research. A thorough 

consideration is given to the analysis of factors that determine the efficiency 

of computer architecture operation. A close attention is given to the study of 

the constituent parts of computer hardware. 

Clue notions of the theme include: computer architecture; computer 

hardware; latency; throughput; clock speed; on-board devices; peripheral 

devices; computer memory. 

This theme covers the following topics: What is computer architecture? 

What are the categories that are included in the general structure of computer 

architecture? What are the main criteria for assessing computer architecture 

efficiency? What devices are included in computer hardware? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the notion and structure of computer architecture; 

they would learn retrospective peculiarities in the development process 

of computer architecture; 

they would become aware of the basic components hat form computer 

hardware and understand the place and interconnection of each part inside 

the computer chassis. 

 

2.1. Computer architecture basics 

 Computer architecture is the conceptual design and fundamental 

operational structure of a computer system. It is a blueprint and functional 

description of requirements (especially speeds and interconnections) and 

design implementations for the various parts of a computer — focusing 

largely on the way by which the central processing unit (CPU) performs 

internally and accesses addresses in memory.               

The term also covers the design of system software, such as the 

operating system (the program that controls the computer), as well as 

referring to the combination of hardware and basic software that links the 

machines on a computer network. Computer architecture refers to an entire 

structure and to the details needed to make it functional. 

Thus, computer architecture covers computer systems, 
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microprocessors, circuits, and system programs. Typically the term does not 

refer to application programs, such as spreadsheets or word processing, 

which are required to perform a task but not to make the system run. 

Computer architecture may also be defined as the science and art of 

selecting and interconnecting hardware components to create computers that 

meet functional, performance and cost goals. 

Computer architecture comprises at least three main subcategories 

(fig. 2.2): 
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Fig. 2.2. The structure of computer architecture 

 

Instruction set architecture, or ISA, is the abstract image of a 

computing system that is seen by a machine language (or assembly 

language) programmer, including the instruction set, memory address modes, 

processor registers, and address and data formats.  

Microarchitecture, also known as Computer organization is a lower 

level, more concrete and detailed, description of the system that involves how 

the constituent parts of the system are interconnected and how they 

interoperate in order to implement the ISA. The size of a computer's cache for 

instance, is an organizational issue that generally has nothing to do with the 

ISA.  

System Design which includes all of the other hardware components 

within a computing system such as:  

1) system interconnects such as computer buses and switches; 

2) memory controllers and hierarchies; 

3) CPU off-load mechanisms such as direct memory access; 

4) issues like multi-processing. 

http://en.wikipedia.org/wiki/Instruction_set
http://en.wikipedia.org/wiki/Machine_language
http://en.wikipedia.org/wiki/Assembly_language
http://en.wikipedia.org/wiki/Assembly_language
http://en.wikipedia.org/wiki/Instruction_set
http://en.wikipedia.org/wiki/Addressing_mode
http://en.wikipedia.org/wiki/Processor_register
http://en.wikipedia.org/wiki/Microarchitecture
http://en.wikipedia.org/wiki/Cache
http://en.wikipedia.org/wiki/Computer_bus
http://en.wikipedia.org/wiki/Memory_controller
http://en.wikipedia.org/wiki/Direct_memory_access
http://en.wikipedia.org/wiki/Multi-processing
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Once both ISA and microarchitecture have been specified, the actual 

device needs to be designed into hardware. This design process is called 

implementation. Implementation is usually not considered architectural 

definition, but rather hardware design engineering. 

Implementation can be further broken down into three (not fully distinct) 

pieces: 

Logic Implementation – design of blocks defined in the 

microarchitecture at (primarily) the register-transfer and gate levels.  

Circuit Implementation – transistor-level design of basic elements 

(gates, multiplexers, latches etc) as well as of some larger blocks (ALUs, 

caches etc) that may be implemented at this level, or even (partly) at the 

physical level, for performance reasons.  

Physical Implementation – physical circuits are drawn out, the 

different circuit components are placed in a chip floor-plan or on a board and 

the wires connecting them are routed.  

The exact form of a computer system depends on the constraints and 

goals for which it was optimized. Computer architectures usually trade off 

standards, cost, memory capacity, latency and throughput. Sometimes other 

considerations, such as features, size, weight, reliability, expandability and 

power consumption are factors as well. 

The most common scheme carefully chooses the bottleneck that most 

reduces the computer's speed. Ideally, the cost is allocated proportionally to 

assure that the data rate is nearly the same for all parts of the computer, with 

the most costly part being the slowest. This is how skillful commercial 

integrators optimize personal computers. 

Main criteria for computer architecture efficiency. 

1. Performance. 

Computer performance is often described in terms of clock speed 

(usually in MHz or GHz). This refers to the cycles per second of the main 

clock of the CPU. However, this metric is somewhat misleading, as a 

machine with a higher clock rate may not necessarily have higher 

performance. As a result manufacturers have moved away from clock speed 

as a measure of performance. 

Computer performance can also be measured with the amount of cache 

a processor has. If the speed, MHz or GHz, were to be a car then the cache 

is like a traffic light. No matter how fast the car goes, it still will be stopped by 

a red traffic light. The higher the speed, and the greater the cache, the faster 
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a processor runs. Modern CPUs can execute multiple instructions per clock 

cycle, which dramatically speeds up a program. Other factors influence 

speed, such as the mix of functional units, bus speeds, available memory, 

and the type and order of instructions in the programs being run. 

There are two main types of speed, latency and throughput. 

 Latency is the time between the start of a process and its 

completion.              

 

 Throughput is the amount of work done per unit time.             

 
Computer performance development is believed to submit to Moore’s 

Law. In 1965 semiconductor pioneer Gordon Moore predicted that the 

number of transistors contained on a computer chip would double every year. 

This is now known as Moore’s Law, and it has proven to be somewhat 

accurate. The number of transistors and the computational speed of 

microprocessors currently doubles approximately every 18 months. 

Components continue to shrink in size and are becoming faster, cheaper, and 

more versatile. 

2. Power consumption 

Power consumption is another design criterion that factors in the design 

of modern computers. Power efficiency can often be traded for performance 

or cost benefits. With the increasing power density of modern circuits as the 

number of transistors per chip scales, power efficiency has increased in 

importance. 
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Recent processor designs such as the Intel Core 2 put more emphasis 

on increasing power efficiency. Also, in the world of embedded computing, 

power efficiency has long been and remains the primary design goal next to 

performance. 

 
The term “architecture” in computer literature can be traced to the 

work of Lyle R. Johnson and Frederick P. Brooks, Jr., members in 1959 of the 

Machine Organization department in IBM’s main research center. 

Johnson had occasion to write a proprietary research communication 

about Stretch, an IBM-developed supercomputer for Los Alamos Scientific 

Laboratory; in attempting to characterize his chosen level of detail for 

discussing the luxuriously embellished computer, he noted that his 

description of formats, instruction types, hardware parameters, and speed 

enhancements aimed at the level of “system architecture” – a term that 

seemed more useful than “machine organization.” 

Subsequently Brooks, one of the Stretch designers, started Chapter 2 

of a book (Planning a Computer System: Project Stretch, ed. W. Buchholz, 

1962) by writing, “Computer architecture, like other architecture, is the art of 

determining the needs of the user of a structure and then designing to meet 

those needs as effectively as possible within economic and technological 

constraints.” Brooks went on to play a major role in the development of the 

IBM System/360 line of computers, where “architecture” gained currency as a 

noun with the definition “what the user needs to know.” Later the computer 

world would employ the term in many less-explicit ways. 

The first mention of the term architecture in the referred computer 

literature is in a 1964 article describing the IBM System/360. The article 

defines architecture as the set of “attributes of a system as seen by the 

http://en.wikipedia.org/wiki/Intel_Core_2


 22 

programmer, i.e., the conceptual structure and functional behavior, as distinct 

from the organization of the data flow and controls, the logical design, and the 

physical implementation.” In the definition, the programmer perspective of the 

computer’s functional behavior is key. The conceptual structure part of an 

architecture description makes the functional behavior comprehensible, and 

extrapolatable to a range of use cases. Only later on did ‘internals’ such as 

“the way by which the CPU performs internally and accesses addresses in 

memory,” mentioned above, slip into the definition of computer architecture. 

 

2.2. Computer hardware 

Once both ISA (instruction set architecture) and microarchitecture has 

been specified, the actual device needs to be designed into hardware. A 

personal computer is made up of computer hardware, multiple physical 

components onto which can be loaded into a multitude of software that 

perform the functions of the computer. 

 Computer hardware is the equipment involved in the function of a 

computer. Computer hardware consists of the components that can be 

physically handled. 

The function of these components is typically divided into three main 

categories: input, output, and storage. Though a PC comes in many different 

form factors, a typical personal computer consists of a case or chassis in a 

tower shape (desktop) and the following parts (fig. 2.3): 

 
1. Monitor. 2. Motherboard. 3. CPU. 4. RAM Memory. 5. Expansion card. 6. Power 

Supply. 7. CD-rom. 8. Hard Disk. 9. Keyboard. 10. Mouse 

Fig. 2.3. Hardware of a personal computer [10] 
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Typical PC hardware consists of the following elements (fig. 2.4): 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2.4. Typical PC hardware elements 
 

Motherboard – the motherboard is sometimes alternatively known as 

the mainboard, system board, or, on Apple computers, the logic board. It is 

also sometimes casually shortened to mobo. It is the "body" or mainframe of 

the computer, through which all other components interface (fig. 2.5). 

 
Fig. 2.5. Computer motherboard 
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Central processing unit (CPU) – performs most of the calculations 

which enable a computer to function, sometimes referred to as the "backbone 

or brain" of the computer. 

Computer fan – is used to lower the temperature of the computer. A 

fan is almost always attached to the CPU, and the computer case will 

generally have several fans to maintain a constant airflow. Liquid cooling can 

also be used to cool a computer, though it focuses more on individual parts 

rather than the overall temperature inside the chassis. 

Random Access Memory (RAM) – is a form of computer data storage. 

Today it takes the form of integrated circuits that allows the stored data to be 

accessed in any order (i.e., at random). The word random thus refers to the 

fact that any piece of data can be returned in a constant time, regardless of 

its physical location and whether or not it is related to the previous piece of 

data. It is the physical memory of the computer in the form of DRAM memory 

modules. RAM is a fast-access memory that is cleared when the computer is 

powered-down. RAM attaches directly to the motherboard, and is used to 

store programs that are currently running. 

Internal storage (HDD – hard disk drive) – hardware that keeps data 

inside the computer for later use and remains persistent even when the 

computer has no power. 

Video display controller – produces the output for the visual display 

unit. This will either be built into the motherboard or attached in its own 

separate slot (PCI or AGP), in the form of a graphics card. Graphics card is 

an expansion card whose function is to generate and output images to a 

display. Some video cards offer added functions, such as video capture, TV 

tuner adapter, MPEG-2 and MPEG-4 decoding, FireWire, light pen, TV 

output, or the ability to connect multiple monitors. 

Power supply – is the component that supplies power to a computer. It 

usually includes a case control, and (usually) a cooling fan. Most common 

types of power supplies are AT and ATX (Advanced Technology Extended). 

On newer ATX power supplies, the switch goes to the motherboard, allowing 

other hardware or software to turn the system on or off. 

Buses – in computer architecture, a bus is a subsystem that transfers 

data between computer components inside a computer or between 

computers. Unlike a point-to-point connection, a bus can logically connect 

several peripherals over the same set of wires. Each bus defines its set of 

connectors to physically plug devices, cards or cables together. 
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Early computer buses were literally parallel electrical buses with 

multiple connections, but the term is now used for any physical arrangement 

that provides the same logical functionality as a parallel electrical bus. 

Modern computer buses can use both parallel and bit-serial connections, and 

can be wired in either a multidrop (electrical parallel) or daisy chain topology, 

or connected by switched hubs, as in the case of USB. PC buses fall into two 

groups (fig. 2.5): 

 
Fig. 2.6. Position of computer buses on the motherboard 

 

Internal Buses – Connections to various internal components. For 

example, PCI, PCI-E, USB, AGP, IDE etc.  

External Buses – used to connect to external peripherals, such as 

printers and input devices. These ports may also be based upon expansion 

cards, attached to the internal buses.  

Sound card – enables the computer to output sound to audio devices, 

as well as accept input from a microphone. Most modern computers have 

sound cards built-in to the motherboard, though it is common for a user to 

install a separate sound card as an upgrade. 

Removable media devices include: 

CD, CD-ROM Drive, DVD (digital versatile disc), DVD-ROM Drive, Blu-

ray CD, HD DVD CD – optical storages, which store information in deformities 

on the surface of a circular discs and read this information by illuminating the 

surface with a laser diode and observing the reflection. Optical disc storages 

are non-volatile. The deformities may be permanent (read only media), 

Internal 
buses 

External 
buses 
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formed once (write once media) or reversible (recordable or read/write 

media).  

Floppy disk – an outdated storage device consisting of a thin disk of a 

flexible magnetic storage medium.  

USB flash drive – a flash memory data storage device integrated with a 

USB interface, typically small, lightweight, removable, and rewritable.  

Tape drive – a device that reads and writes data on a magnetic tape, 

used for long term storage. 

Other peripherals. In addition, hardware devices can include external 

components of a computer system. The following are either standard or very 

common. Peripheral devices include various input and output devices, usually 

external to the computer system. 

Input devices: 

Text input devices.  

Keyboard – a device to input text and characters by depressing buttons 

(referred to as keys), similar to a typewriter. The most common English-

language key layout is the QWERTY layout. The QWERTY design is based 

on a layout created by Christopher Latham Sholes in 1873 for the Sholes and 

Glidden typewriter and sold to Remington in the same year, when it first 

appeared in typewriters (fig. 2.7). 

 

 
Fig. 2.7. Typewriter and PC QWERTY layouts [11] 
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Pointing devices. 

Mouse – a pointing device that detects two dimensional motion relative 

to its supporting surface.  

Trackball – a pointing device consisting of an exposed protruding ball 

housed in a socket that detects rotation about two axes (fig. 2.8). 

 
Fig. 2.8. A trackball       Fig. 2.9.  A gamepad 

 

Gaming devices. 

Joystick – a general control device that consists of a handheld stick 

that pivots around one end, to detect angles in two or three dimensions.  

Gamepad – a general handheld game controller that relies on the digits 

(especially thumbs) to provide input (fig. 2.9).  

Game controller – a specific type of controller specialized for certain 

gaming purposes.  

Image, Video input devices. 

Image scanner – a device that provides input by analyzing images, 

printed text, handwriting, or an object.  

Webcam – a low resolution video camera used to provide visual input 

that can be easily transferred over the internet.  

Audio input devices. 

Microphone – an acoustic sensor that provides input by converting 

sound into electrical signals. 

Output devices: 

Image, Video output devices. 

Printer – a peripheral which produces a hard copy (that is a permanent 

human-readable text and/or graphics) of documents stored in electronic form, 

usually on physical print media such as paper or transparencies 
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Monitor – a piece of electrical equipment which displays images 

generated from the video output of devices such as a PC graphics card, 

without producing a permanent record. 

Audio output devices. 

Speakers – are external sound producing devices, commonly equipped 

with a low-power internal amplifier. The standard audio connection is a 

3.5mm (1/8 inch) stereo jack plug often colour-coded lime green (following 

the PC 99 standard) for computer sound cards. 

Headset – a pair of small loudspeakers, or less commonly a single 

speaker, with a way of holding them close to a user's ears and a means of 

connecting them to a signal source such as an audio amplifier, radio or CD 

player. They are also known as earphones, earbuds, stereophones, headsets 

or, informally cans. 

 

2.3. Computer memory: HDDs, optical discs, flash drives 

There are two types of memory which are at a disposal of a personal 

computer: random access memory (RAM) and permanent memory (hard disc 

drives). Random access memory was given a close attention in the previous 

section, so now we’ll focus on PC’s permanent memory that is represented by 

hard disc drives (HDD). 

 A hard disk drive (HDD), commonly referred to as a hard drive, 

hard disk, or fixed disk drive, is a non-volatile storage device which stores 

digitally encoded data on rapidly rotating platters with magnetic surfaces. 

Strictly speaking, "drive" refers to a device distinct from its medium, 

such as a tape drive and its tape, or a floppy disk drive and its floppy disk. 

Early HDDs had removable media; however, an HDD today is typically a 

sealed unit (except for a filtered vent hole to equalize air pressure) with fixed 

media. 

HDDs record data by magnetizing ferromagnetic material 

directionally, to represent either a 0 or a 1 binary digit. They read the data 

back by detecting the magnetization of the material. A typical HDD design 

consists of a spindle which holds one or more flat circular disks called 

platters, onto which the data are recorded (fig. 2.10). The platters are made 

from a non-magnetic material, usually aluminum alloy or glass, and are 

coated with a thin layer of magnetic material. Older disks used iron oxide as 

the magnetic material, but current disks use a cobalt-based alloy. 
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Fig. 2.10. The structure of HDD surface [15] 

 

Initially the regions were oriented horizontally, but beginning about 

2005, the orientation was changed to perpendicular (2.11). 

 
Fig. 2.11. The direction of recording layers [15] 

 

The platters are spun at very high speeds. Information is written to a 

platter as it rotates past devices called read-and-write heads that operate 

very close (tens of nanometers in new drives) over the magnetic surface. The 

read-and-write head is used to detect and modify the magnetization of the 

material immediately under it. There is one head for each magnetic platter 

surface on the spindle, mounted on a common arm. An actuator arm (or 

access arm) moves the heads on an arc (roughly radially) across the platters 

as they spin, allowing each head to access almost the entire surface of the 

platter as it spins. The arm is moved using a voice coil actuator or (in older 

designs) a stepper motor. 
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HD heads are kept from contacting the platter surface by the air that is 

extremely close to the platter; that air moves at, or close to, the platter speed. 

The record and playback head are mounted on a block called a slider, and 

the surface next to the platter is shaped to keep it just barely out of contact. 

It's a type of air bearing (fig. 2.12). 

 
Fig. 2.12. Computer hard drive’s structural parts [15] 

 

The magnetic surface of each platter is conceptually divided into many 

small sub-micrometre-sized magnetic regions, each of which is used to 

encode a single binary unit of information. In today's HDDs, each of these 

magnetic regions is composed of a few hundred magnetic grains. Each 

magnetic region forms a magnetic dipole which generates a highly localized 

magnetic field nearby. The write head magnetizes a region by generating a 

strong local magnetic field. 

 Flash memory is a non-volatile computer storage chip that can be 

electrically erased and reprogrammed. 

Since flash memory is non-volatile, no power is needed to maintain the 

information stored in the chip. It is primarily used in memory cards, USB flash 

drives, MP3 players and solid-state drives for general storage and transfer of 

data between computers and other digital products.  

Flash memory was invented by Dr. Fujio Masuoka while working for 

Toshiba circa 1980. Dr. Masuoka presented the invention at the IEEE 1984 

International Electron Devices Meeting (IEDM) held in San Francisco, 

California. According to Toshiba, the name "flash" was suggested by Dr. Ma-
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suoka's colleague, Mr. Shoji Ariizumi, because the erasure process of the 

memory contents reminded him of the flash of a camera.  

First flash memory devices worked only with large block sizes. That 

meant that in order to erase a piece of data the whole data had to be erased. 

Modern flash memory is erasable and rewritable in small blocks, typically 

bytes. 

Singaporean Trek Technology and IBM began selling the first USB flash 

drives commercially in 2000. The model under the brand name 

"ThumbDrive", and "DiskOnKey" became available on December 15, 2000, 

and had a storage capacity of 8 MB, more than five times the capacity of the 

then-common floppy disks (fig. 2.13). 

 
Fig. 2.13. First USB flash drive [18] 

 

Storage capacities in 2011 can be as large as 512 GB with steady 

improvements in size and price per capacity expected. Some allow 1 million 

write or erase cycles and have a 10-year data retention cycle.  

Most commercially available flash products are guaranteed to withstand 

around 100,000 program-erase (P/E) cycles, before the wear begins to 

deteriorate the integrity of the storage. Flash drives can be defragmented, but 

this brings little advantage as there is no mechanical head that moves from 

fragment to fragment.  Defragmenting shortens the life of the drive by making 

many unnecessary writes. There also exist viruses that “kill” or shorten the 

operation period of a flash drive by making a lot of unnecessary read-write 

operations. Flash memory stores information in an array of memory cells 

made from floating-gate transistors. In traditional devices, each cell stores 

only one bit of information (fig.2.14). 

 
Fig. 2.14. Flash memory structure 
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A flash cell can be programmed, or set to a binary "0" value, by the 

following procedure: 

an elevated on-voltage (typically >5 V) is applied to the CG; 

the channel is now turned on, so electrons can flow from the source to 

the drain; 

the source-drain current is sufficiently high to cause some high energy 

electrons to jump through the insulating layer onto the FG, via a process 

called hot-electron injection (fig. 2.15). 

 
Fig. 2.15. Flash memory operation principles 

 

In order to “erase” a flash cell a large voltage of the opposite polarity is 

applied between the CG and source, pulling the electrons off the FG. 

There are typically four parts to a flash drive: 

USB connector – provides a physical interface to the host computer; 

USB mass storage controller – implements the USB host controller. 

The controller contains a small microcontroller with a small amount of on-chip 

ROM and RAM; 

flash memory chip – stores data; 

crystal oscillator – produces the device's main 12 MHz clock signal 

and controls the device's data output through a phase-locked loop (fig. 2.16). 

 
Fig. 2.16. Typical parts of a flash drive 
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 Optical read only memory is represented by compact optical discs 

(also known as a CDs or DVDs) that are used to store digital data. 

It was originally developed to store sound recordings exclusively, but 

later it also allowed the preservation of other types of data. Standard CDs 

have a diameter of 120 mm and can hold up to 80 minutes of uncompressed 

audio (700 MB of data for common CDs or 4.7 Gb for DVDs). 

Sony first publicly demonstrated an optical digital audio disc in 

September 1976. The first test CD was presented at a conference in 

Hannover, Germany, by the Polydor Pressing Operations plant in 1982. The 

disc contained a recording of Richard Strauss's Eine Alpensinfonie (in English 

language, An Alpine Symphony). 

The size and length of the first CD had to be enough to hold the 9th 

Symphony of Beethoven – the favorite composition of the head of Sony 

Corporation. Later it became a standard. 

CD data are stored as a series of tiny indentations known as "pits", 

encoded in a spiral track molded into the top of the polycarbonate layer. The 

areas between pits are known as "lands". Each pit is approximately 100 nm 

deep by 500 nm wide, and varies from 850 nm to 3.5 nm in length. The 

distance between the tracks, the pitch, is 1.6 nm (fig. 2.17). 

 
Fig. 2.17. Optical disc structure 

 

A typical CD consists of a set of layers (fig.2.18): 

A. A polycarbonate disc layer has the data encoded by using bumps. 

B. A shiny layer reflects the laser. 

C. A layer of lacquer helps keep the shiny layer shiny. 

D. Artwork is screen printed on the top of the disc. 

E. A laser beam reads the CD and is reflected back to a sensor, which 

converts it into electronic data 
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Fig. 2.18. Optical disc layers [16] 

 

Optical discs can be recorded in Disc At Once, Track At Once, 

Session at Once (i.e. multiple burning sessions for one disc), or packet 

writing modes. Many disc manufacturers extend a recordable disc to leave a 

small margin of extra groove at the outer edge. This lead-out was originally 

intended to provide tolerance for the read head of an audio CD player should 

it overseek, by providing a padding of up to 90 seconds of silent digital audio. 

It can be used to “overburn” a disc. 

 Overburning is the process of recording data past the normal size 

limit of a compact disc. 

An optical disc is designed to support one of three recording types: 

read-only (e.g.: CD and CD-ROM), recordable (write-once, e.g. CD-R), or re-

recordable (rewritable, e.g. CD-RW). Write-once optical discs commonly have 

an organic dye recording layer between the substrate and the reflective layer. 

Rewritable discs typically contain an alloy recording layer composed of a 

phase change material that can restore its original state. 

 

 

 Questions 

 

1. What is computer hardware? What elements does it include? 

2. How does magnetic memory work? 

3. What is the operational principle of flash memory devices? 

4. What are the basic elements of a compact disc? 

5. What is overburning? 
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Theme 3. Computer periphery: basic devices overview 
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 Introduction 

The purpose of this theme lies in a close study of the basic peripheral 

devices that can be connected (directly or indirectly) to a personal computer. 

Although most common peripheral devices are named, a special attention is 

given to a thorough consideration of two types of computer peripherals that 

are commonly used by most users: scanners and printers. All types of 

scanners and printers are analyzed including architecture features and 

common areas of use. 

Clue notions of the theme include: computer periphery; scanner; 

printer; dot-matrix technology; laser technology; dye-sublimation technology; 

drum scanners; flatbed scanners; hand scanners; films; inks and dyes. 

This theme covers the following topics: What is computer periphery? 

What devices can be named computer peripherals? What is a scanner, for 

what purposes can it be used? What is a printer, for what purposes can it be 

used? What are the most widespread types of printers and scanners? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the basic devices that form computer architecture 

environment; 

they would learn the types of scanners most widely used for office work, 

their architectural features and ways of implementation; 

they would become aware of the principles that govern the work of most 

types of printers most widely used for office work and industrial tasks. 

 

3.1. Peripheral devices: short overview 

Generally, a periphery is a boundary or outer part of any space or body. 

In computer science, a peripheral is a device added to a host computer in 

order to expand its abilities. 

 So, a peripheral is a device attached to a host computer behind the 

chipset whose primary functionality is dependent upon the host, and can 

therefore be considered as expanding the host’s capabilities, while not 

forming part of the system's core architecture. 

Some of the more common peripheral devices are printers, scanners, 

disk drives, tape drives, microphones, speakers, and cameras. Peripheral 

devices can also include other computers on a network system. A device can 
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also refer to a non-physical item, such as a pseudo terminal, a RAM drive, or 

a virtual network adapter (fig. 4.2). 

Fig. 3.2. Computer periphery 
 

The term is different from computer accessories: computer peripheral 

has a narrow meaning that refers only to the input-output devices of a 

computer, whereas, computer accessories has a broader meaning, that refers 

to all the parts that support a computer which include motherboards, sensors, 

chips, including all the input and output devices. 

Some people consider internal devices such as video capture cards, 

disk drives, TV-tuners, tape drives etc. also peripheral devices because they 

have external appendages. 

 

3.2. Image scanners. Architecture and basic types of scanners 

 A scanner is a device that optically scans images, printed text, 

handwriting, or an object, and converts it to a digital image. 

Common examples found in offices are variations of the desktop (or 

flatbed) scanner where the document is placed on a glass window for 

scanning. Hand-held scanners, where the device is moved by hand, have 

evolved from text scanning "wands" to 3D scanners used for industrial 

design, reverse engineering, test and measurement, orthotics, gaming and 

other applications. Mechanically driven scanners that move the document are 

typically used for large-format documents, where a flatbed design would be 

impractical. 

Another category of scanner is digital camera scanners, which are 

based on the concept of reprographic cameras. Due to increasing resolution 
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and new features such as anti-shake, digital cameras have become an 

attractive alternative to regular scanners.  

There are three  most widespread types of scanners:  

drum scanners; 

flatbed scanners; 

hand scanners; 

Drum scanners capture image information with photomultiplier tubes 

(PMT), rather than the charge-coupled device (CCD) arrays found in flatbed 

scanners and inexpensive film scanners. Reflective and transmissive 

originals are mounted on an acrylic cylinder, the scanner drum, which rotates 

at high speed while it passes the object being scanned in front of precision 

optics that deliver image information to the PMTs. Most modern color drum 

scanners use 3 matched PMTs, which read red, blue, and green light 

respectively. Light from the original artwork is split into separate red, blue, 

and green beams in the optical bench of the scanner. 

The drum scanner gets its name from the clear acrylic cylinder, the 

drum, on which the original artwork is mounted for scanning. One of the 

unique features of drum scanners is the ability to control sample area and 

aperture size independently. The sample size is the area that the scanner 

encoder reads to create an individual pixel. The aperture is the actual 

opening that allows light into the optical bench of the scanner. The ability to 

control aperture and sample size separately is particularly useful for 

smoothing film grain when scanning black-and-white and color negative 

originals (fig. 4.4). 

 
Fig. 3.3. A typical drum scanner 

 

Only a few companies continue to manufacture drum scanners. 

However, drum scanners continue to be used in high-end applications, such 

as museum-quality archiving of photographs and print production of high-

quality books and magazine advertisements.  
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A flatbed scanner is usually composed of a glass pane (or platen), 

under which there is a bright light (often xenon or cold cathode fluorescent) 

which illuminates the pane, and a moving optical array in CCD scanning. 

CCD type scanners typically contain three rows (arrays) of sensors with red, 

green, and blue filters. CIS scanning consists of a moving set of red, green 

and blue LEDs strobed for illumination and a connected monochromatic 

photodiode array for light collection (fig. 3.4).  

 
Fig.3.4. Flatbed scanners: operation principles [12] 

 

Images to be scanned are placed face down on the glass, an opaque 

cover is lowered over it to exclude ambient light, and the sensor array and 

light source move across the pane, reading the entire area. An image is 

therefore visible to the detector only because of the light it reflects. 

Transparent images do not work in this way, and require special accessories 

that illuminate them from the upper side. Many scanners offer this as an 

option. 

Basic scanner characteristics include three components (fig. 3.5). 

Color depth is the number of bits used to represent the color of a 

single pixel in a bitmapped image. Color depth varies depending on the 

scanning array characteristics, but is usually at least 24 bits. High quality 

models have 48 bits or more color depth. 
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SCANNERS

CHARACTERISTICS

color depth

resolution 

density range 

 
Fig. 3.5. A typical scanner’s characteristics 

 

Resolution is the number of pixels (dots) per unit of measurement 

(such as inch or centimeter). The size of the file created increases with the 

square of the resolution; doubling the resolution quadruples the file size. A 

resolution must be chosen that is within the capabilities of the equipment, 

preserves sufficient detail, and does not produce a file of excessive size. 

Density range means the ability of a scanner to reproduce shadow 

details and brightness details in one scan. A high density range means that 

the scanner is able to reproduce shadow details and brightness details in one 

scan. 

 

3.3.  Printers. Dot-matrix, laser and dye-sublimation printers 

 In computing, a printer is a peripheral which produces a hard copy 

(permanent human-readable text and/or graphics) of documents stored in 

electronic form, usually on physical print media such as paper or 

transparencies.  

Many printers are primarily used as local peripherals, and are attached 

by a printer cable or, in most newer printers, a USB cable to a computer 

which serves as a document source. Some printers, commonly known as 

network printers, have built-in network interfaces (typically wireless or 

Ethernet), and can serve as a hardcopy device for any user on the network. 

Individual printers are often designed to support both local and network 

connected users at the same time. 

In addition, a few modern printers can directly interface to electronic 

media such as memory sticks or memory cards, or to image capture devices 

such as digital cameras, scanners; some printers are combined with scanners 

and/or fax machines in a single unit, and can function as photocopiers. 

Printers that include non-printing features are sometimes called Multifunction 
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Printers (MFP), Multi-Function Devices, or All-In-One printers. Most MFPs 

include printing, scanning, and copying among their features. 

Printers are designed for low-volume, short-turnaround print jobs 

requiring virtually no setup time to achieve a hard copy of a given document. 

However, printers are generally slow devices (30 pages per minute is 

considered fast; and many inexpensive consumer printers are far slower than 

that), and the cost per page is actually relatively high. The world's first 

computer printer was a 19th century mechanically driven apparatus invented 

by Charles Babbage for his Difference Engine. 

Now there exist a wide range of printers. Printers can be categorized in 

any of several ways (fig. 3.6).  

TYPES OF PRINTERS

 Print 

technology

 Character 

formation

Method of 

transmission

Print capability

 Method of 

printing

dot-matrix

ink-jet

laser

thermal

daisy-wheel

fully formed 

characters 

made of 

continuous 

lines

characters 

composed of 

patterns of 

dots

character by 

character

line by line

page by page

text-only

text-and-

graphics

byte-by-byte 

transmission

bit-by-bit 

transmission

Fig. 3.6. A typical scanner’s characteristics 
 

 A dot matrix printer or impact matrix printer is a type of computer 

printer with a print head that runs back and forth, or in an up and down 

motion, on the page and prints by impact, striking an ink-soaked cloth ribbon 

against the paper, much like a typewriter.  

Unlike a typewriter letters are drawn out of a dot matrix, and thus, 

varied fonts and arbitrary graphics can be produced. Because the printing 

involves mechanical pressure, these printers can create carbon copies and 

carbonless copies. 

Each dot is produced by a tiny metal rod, also called a "wire" or "pin", 

which is driven forward by the power of a tiny electromagnet or solenoid, 
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either directly or through small levers (pawls) (fig. 3.7). Facing the ribbon and 

the paper is a small guide plate (often made of an artificial jewel such as 

sapphire or ruby) pierced with holes to serve as guides for the pins. 

 
Fig. 3.7. Dot-matrix pin structure 

 

The moving portion of the printer is called the print head, and when 

running the printer as a generic text device generally prints one line of text at 

a time. Most dot matrix printers have a single vertical line of dot-making 

equipment on their print heads; others have a few interleaved rows in order to 

improve dot density (fig. 3.8). 

 

 

 

 

 

Fig. 3.8. Typical output from a dot matrix printer [13] 
 

These machines can be highly durable. When they do wear out, it is 

generally due to ink invading the guide plate of the print head, causing grit to 

adhere to it; this grit slowly causes the channels in the guide plate to wear 

from circles into ovals or slots, providing less and less accurate guidance to 

the printing wires. Eventually, even with tungsten blocks and titanium pawls, 

the printing becomes too unclear to read. 

In the 1970s and 1980s, dot matrix impact printers were generally 

considered the best combination of expense and versatility, and until the 

1990s they were by far the most common form of printer used with personal 

computers. In the 1990-s the desktop impact printer was gradually replaced 

by the inkjet printer. The main use of dot-matrix printers now is in areas of 

intensive transaction-processing systems that churn out quite a lot of printing. 

Many companies who might have started off with dot-matrix printers are not 

so easily convinced to go for printers based on other technologies. Dot matrix 
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printers are the dominant type of printer in small firms and offices. They are 

still used to fulfill mass printing tasks that don't require high quality printing. 

Dot matrix impact technology remains in use in devices such as cash 

registers, ATM, and many other point-of-sales terminals. 

 A laser printer is a common type of computer printer that rapidly 

produces high quality text and graphics on plain paper.  

As with digital photocopiers and multifunction printers (MFPs), laser 

printers employ a xerographic printing process but differ from analog 

photocopiers in that the image is produced by the direct scanning of a laser 

beam across the printer's photoreceptor. 

A laser beam projects an image of the page to be printed onto an 

electrically charged rotating drum coated with selenium. Photoconductivity 

removes charge from the areas exposed to light. Dry ink (toner) particles are 

then electrostatically picked up by the drum's charged areas. The drum then 

prints the image onto paper by direct contact and heat, which fuses the ink to 

the paper (fig. 3.9). 

 
Fig. 3.9. Laser printer operation 

 

The laser printer was invented at Xerox in 1969 by researcher Gary 

Starkweather, who had an improved printer working by 1971 and 

incorporated into a fully functional networked printer system by about a year 

later. The prototype was built by modifying an existing xerographic copier. 

Starkweather disabled the imaging system and created a spinning drum with 
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8 mirrored sides, with a laser focused on the drum. Light from the laser would 

bounce off the spinning drum, sweeping across the page as it traveled 

through the copier. The hardware was completed in just a week or two, but 

the computer interface and software took almost 3 months to complete. 

The first commercial implementation of a laser printer was the IBM 

model 3800 in 1976, used for high-volume printing of documents such as 

invoices and mailing labels. It is often cited as "taking up a whole room," 

implying that it was a primitive version of the later familiar device used with a 

personal computer. The first laser printer designed for use with an individual 

computer was released with the Xerox Star 8010 in 1981. Although it was 

innovative, the Star was an expensive ($17,000) system that was purchased 

by only a relatively small number of businesses and institutions. After 

personal computers became more widespread, the first laser printer intended 

for a mass market was the HP LaserJet 8ppm, released in 1984, using a 

Canon engine controlled by HP software. The HP LaserJet printer was 

quickly followed by laser printers from Brother Industries, IBM, and others. 

There are typically seven steps involved in the laser printing process 

(refer to fig. 3.9): 

1. Raster image processing.  

2. Charging. 

3. Exposing. 

4. Developing. 

5. Transferring. 

6. Fusing. 

7. Cleaning. 

 Inkjet printers operate by propelling variably-sized droplets of liquid 

or molten material (ink) onto almost any sized page. 

They are the most common type of computer printer for the general 

consumer due to their low cost, high quality of output, capability of printing in 

vivid color, and ease of use. There are three main technologies in use in 

contemporary inkjet printers: thermal; piezoelectric; continuous; 

Thermal inkjets. Most consumer inkjet printers use print cartridges with 

a series of tiny electrically heated chambers. To produce an image, the 

printer runs a pulse of current through the heating elements causing a steam 

explosion in the chamber to form a bubble, which propels a droplet of ink onto 

the paper. The ink's surface tension as well as the condensation and thus 

contraction of the vapor bubble, pulls a further charge of ink into the chamber 

through a narrow channel attached to an ink reservoir. The principle was 

discovered by Canon engineer Ichiro Endo in August 1977. 

http://en.wikipedia.org/wiki/Computer_printer
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Piezoelectric  inkjets. Most commercial and industrial ink jet printers 

use a piezoelectric material in an ink-filled chamber behind each nozzle 

instead of a heating element. When a voltage is applied, the piezoelectric 

material changes shape or size, which generates a pressure pulse in the fluid 

forcing a droplet of ink from the nozzle. This is essentially the same 

mechanism as the thermal inkjet but generates the pressure pulse using a 

different physical principle. Piezoelectric (also called Piezo) ink jet allows a 

wider variety of inks than thermal or continuous ink jet but the print heads are 

more expensive. 

Continuous inkjets. The continuous ink jet method is used 

commercially for marking and coding of products and packages. The idea 

was first patented in 1867, by Lord Kelvin and the first commercial devices 

(medical strip chart recorders) were introduced in 1951 by Siemens. In 

continuous ink jet technology, a high-pressure pump directs liquid ink from a 

reservoir through a gunbody and a microscopic nozzle, creating a continuous 

stream of ink droplets. Continuous ink jet is one of the oldest ink jet 

technologies in use and is fairly mature. Mostly it is used for printing mass 

low-quality graphics for industrial needs. 

Special types of printers: heat printers (dye-sublimation printers) 

 A dye-sublimation printer (or dye-sub printer) is a computer printer 

which employs a printing process that uses heat to transfer dye to a medium 

such as a plastic card, printer paper, poster paper, or fabric. 

Most consumer and professional dye-sublimation printers are designed 

and used for producing high-quality photographic prints.  

It uses CMYO (cyan (blue), magenta (red), yellow, overcoating) color 

transfer technology instead of CMYK (cyan, magenta, yellow, key (black)) 

used by color inkjet and laser printers. The overcoating is thin laminate which 

protects the print from discoloration from UV light and the air while also 

rendering the print water-resistant. 

 Sublimation is when a substance transitions between the solid and 

gas states without going through a liquid stage. 

In a dye-sublimation printer the printing dye is heated up until it turns 

into a gas, at which point it diffuses onto the printing media and solidifies. 

The dye is stored on a cellophane ribbon. The ribbon is made up of 

three colored panels (cyan, magenta, and yellow) and one clear panel which 
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holds the lamination material for the overcoating. Each colored panel is the 

size of the media that is being printed on. So the printer can print on the 

media only of a certain size. 

During the printing cycle, the printer rollers move the media and one of 

the colored panels together under a thermal printing head. Tiny heating 

elements on the head change temperature rapidly, laying different amounts of 

dye depending on the amount of heat applied (fig. 3.10).  

 
Fig. 3.10. Dye-sublimation printer work scheme 

 

After the printer finishes covering the media in one color, it winds the 

ribbon on to the next color panel and partially ejects the media from the 

printer to prepare for the next cycle. The entire process is repeated four times 

in total: the first three lay the colors onto the media to form a complete image, 

while the last one lays the laminate over top. This layer protects the dye from 

resublimating when handled or exposed to warm conditions. 

 

 

 Questions 

 

1. What is computer periphery? What computer peripherals do you 

know? 

2. What is a scanner? Name basic types of scanners. 

3. What is the scheme of scanner operation? 

4. What is a printer? What types of media can be used for printing? 

5. What are the classification criterion for computer printers? 

6. Name basic types of printers. 

7. What are the areas of use of dye-sublimation printers? 
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Section 2. Computer software. MS Windows operating 

system 

Theme 4. Computer software: structure and principles of 

organization 
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 Introduction 

The purpose of this theme lies in a close study of the peculiar features 

of computer software. The nature of computer software is analyzed and 

questions connected with software copyright protection are given a special 

consideration. A thorough analysis covers different types of computer 

software and their use by particular groups of users. 

Clue notions of the theme include: computer software; copyright; 

patent law; trademark law; shrink-wrap licenses; system software; program-

ming software; application software. 

This theme covers the following topics: What is computer software? 

What ways of protecting computer software do exist? What are the basic 

types of computer software? What is the role of the system software in 

sustaining computer operation? What are the basic types of computer 

application software? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the difference between computer software and 

hardware; 

they would learn the basic types of computer software; 

they would become aware of the types of software used for solving of 

tasks arising as a result of economic activities of individuals and enterprises. 

 

4.1. Overview: software relationship to computer hardware 

 Software is an ordered sequence of instructions for changing the 

state of the computer hardware in a particular sequence. 

Computer software is often regarded as anything but hardware, 

meaning that the "hard" are the parts that are tangible while the "soft" part is 

the intangible objects inside the computer. Besides users often presume that 

“hardware” is the part of a computer which does most of the job. 

Software encompasses an extremely wide array of products and 

technologies developed using different techniques like programming 

languages, scripting languages, microcode etc. The types of software include 

web pages developed by technologies like HTML, PHP, Perl, JSP, ASP.NET, 

XML, and desktop applications like OpenOffice, Microsoft Word developed by 

technologies like C, C++, Java,or C#. 
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Software usually runs on underlying software operating systems such 

as Microsoft Windows, Linux or MacOS. Software also includes video games 

and the logic systems of modern consumer devices such as automobiles, 

televisions, and toasters. 

Computer software is so called to distinguish it from computer 

hardware, which encompasses the physical interconnections and devices 

required to store and execute (or run) the software. At the lowest level, 

software consists of a machine language specific to an individual processor. 

A machine language consists of groups of binary values signifying processor 

instructions that change the state of the computer from its preceding state. 

It is usually written in high-level programming languages that are easier 

and more efficient for humans to use (closer to natural language) than 

machine language. High-level languages are compiled or interpreted into 

machine language object code. Software may also be written in an assembly 

language, essentially, a mnemonic representation of a machine language 

using a natural language alphabet. Assembly language must be assembled 

into object code via an assembler.  

The term “software” was first used in this sense by John W. Tukey in 

1958. In computer science and software engineering, computer software is all 

computer programs. The theory that is the basis for most modern software 

was first proposed by Alan Turing in his 1935 essay “Computable numbers 

with an application to the Entscheidungsproblem”. 

So, to sum it up, computer software is represented by a set of 

instructions that cause a computer to perform one or more tasks. The set of 

instructions is often called a program or, if the set is particularly large and 

complex, a system. Computers cannot do any useful work without instructions 
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from software; thus a combination of software and hardware (the computer) is 

necessary to do any computerized work. A program must tell the computer 

each of a set of minuscule tasks to perform, in a framework of logic, such that 

the computer knows exactly what to do and when to do it. 

 
Programs are usually written in programming languages, especially 

designed to facilitate the creation of software. 

In the 1950s, programming languages were numerical languages easily 

understood by computer hardware; often, programmers said they were writing 

such programs in machine language. The programmable aspects of computer 

hardware have not changed much since the 1950s. Computers still have 

numerical operations, and numerical addresses by which data may be 

accessed. However, programmers now use high-level languages, which look 

much more like English than a string of numbers or operation codes. 

Until the personal computer revolution began in the 1980s, software 

was written mainly for business, government, and the military, which 

employed large mainframe computers as hardware. With the introduction of 

personal computers, which have rapidly increased in power and performance, 

software has emerged as an important commercial product that can be 

marketed to individuals and small business as well as big business and the 

government. 

 

4.2. Types of computer software 

Practical computer systems divide software systems into three major 

classes: system software, programming software and application software, 

although the distinction is arbitrary, and often blurred (fig. 4.2). 
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Fig. 4.2. Classes of computer software 

 

Computer software has to be "loaded" into the computer's storage (such 

as a hard drive, memory, or RAM). Once the software is loaded, the computer 

is able to execute the software. Computers operate by executing the 

computer program. This involves passing instructions from the application 

software, through the system software, to the hardware which ultimately 

receives the instruction as machine code. Each instruction causes the 

computer to carry out an operation – moving data, carrying out a 

computation, or altering the control flow of instructions. 

System software helps run the computer hardware and computer 

system. It includes a combination of the following: 

device drivers (a computer program allowing higher-level computer 

programs to interact with a hardware device); 

operating systems (an interface between hardware and user); 

utilities (computer software designed to help manage and tune the 

computer hardware, operating system or application software by performing a 

single task or a small range of tasks); 

windowing systems (a component of a graphical user interface which 

supports the implementation of window managers, and provides basic 

support for graphics hardware, pointing devices such as mice, and 

keyboards). 

The purpose of systems software is to unburden the applications 

programmer from the often complex details of the particular computer being 

used, including such accessories as communications devices, printers, 

device readers, displays and keyboards, and also to partition the computer's 

resources such as memory and processor time in a safe and stable manner. 

Examples are Windows, Linux and Mac. 
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Programming software usually provides tools to assist a programmer 

in writing computer programs, and software using different programming 

languages in a more convenient way. The tools include: 

compilers; 

debuggers; 

interpreters; 

linkers; 

text editors. 

An Integrated development environment is a single application that 

attempts to manage all these functions. 

After a piece of software is created using programming software, it 

becomes either system software or application software. 

Application software allows end users to accomplish one or more 

specific (not directly computer development related) tasks, such as writing 

letters, computing formulas, playing games, or carrying out desktop 

publishing tasks. Typical applications fall into one of the following groups. 

1. Writing tasks previously done on typewriters with considerable effort 

can now be easily completed with word-processing software. Writing tasks 

such as keying in reports, letters, and tables, as well as merging documents, 

can be performed easily. Documents can be easily edited and formatted. 

Revisions can be made by deleting (cutting), inserting, moving (cutting and 

pasting), and copying data. Documents can be stored (saved) and opened 

again for revisions and/or printing. Many styles and sizes of fonts are 

available to make the document attractive. 

2. Spreadsheet software permits performance of an almost endless 

variety of quantitative tasks such as budgeting, keeping track of inventory, 

preparing financial reports, or manipulating numbers in any fashion, such as 
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averaging each of ten departmental monthly sales over a six-month period. A 

spreadsheet contains cells, the intersection of rows and columns. Each cell 

contains a value keyed in by the user. Cells also contain formulas with many 

capabilities, such as adding, multiplying, dividing, subtracting, averaging, or 

even counting. An outstanding feature is a spreadsheet's ability to recalculate 

automatically. If one were preparing a budget, for example, and wanted to 

change a variable such as an increase in salary or a change in amount of car 

payments, the formulas would automatically recalculate the affected items 

and the totals. 

3. Database software contains a list of information items that are 

similar in format and/or nature. An example is a phone book that lists a name, 

address, and phone number for each entry. Once stored in a database, 

information can be retrieved in several ways, using reports and queries. For 

example, all the names listed for a given area code could be printed out and 

used for a commercial mailing to that area. 

4. Desktop publishing software permits the user to prepare 

documents by using both word-processing devices and graphics. Desktop 

publishing software uses word-processing software, with all its ease of 

entering and revising data, and supplements it with sophisticated visual 

features that stem from graphics software. For example, one can enhance a 

printed message with virtually any kind of illustration, such as drawings, 

paintings, and photographs. 

5. Presentation software is used to organize a slide show presentation 

for an audience. Text, graphics, sound, and movies can easily be included in 

the presentation. An added feature is that the slide show may be enhanced 

by inclusion of handouts with two to six slides printed on a page. The page 

may be organized to provide space for notes to be written in by the audience 

as the presentation ensues. An example of this is Power Point. Preparation of 

the software is simplified by the use of 'wizards' that walk the user through the 

creation of the presentation. 

6. Office suite software puts together complete programs of software. 

A typical suite package might include word processing, spreadsheet, 

databases, and presentation software. Depending on the jobs that need to be 

done, the suite provides the tools to make professional-looking documents.  

Each piece of software works independently as well as with other parts 

of the suite. Items on the menu bar – such as File, Insert, and Format – work 
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similarly on all the programs in a suite. Thus, familiarity with one program 

makes it easy to work with the other programs. 

 

4.3. Software copyright protection 

Software is, under the law, intellectual property and therefore entitled to 

protection from persons who seek to exploit it illegally. Software can be 

protected through the use of trade secrets, copyright, patents, and 

trademarks. 

Once software is developed and is ready to be sold, it can be 

copyrighted. Copyright protects the expression of an idea, not the idea itself. 

For example, a person could not copyright the idea of a computer database 

management system but could copyright the structure and content of a 

database software program that expresses the idea of a database system. 

Patent law supplies another avenue of protection for software 

companies. A patent protects the idea itself. It is often an unattractive option, 

however, because it takes a significant amount of time and money to obtain a 

patent.  

Trademark law protects the name of the software, not the software 

itself. Protecting a name from being used by others can be more valuable 

than other forms of protection. 

When software is leased or sold, the purchaser usually must agree to 

accept a software license. When a business negotiates with a software 

company, it will sign a license agreement that details how the software is to 

be used and limits its distribution. A software license is an effective tool in 

preventing piracy. When consumers buy software from a software company 

or through a third-party business, they find in the packaging a software 

license. The license is typically on the sealed envelope that contains the 

software media, which itself is sealed in plastic wrapping. These “shrink-

wrap licenses” describe contractual conditions regarding the purchaser's 

use of the software.  
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The opening of the shrink-wrap, according to the license, constitutes 

acceptance of all of the terms contained in the license agreement. The 

purchaser is informed that the software is licensed and not sold to the 

purchaser.  

By retaining title to the software, the computer software company seeks 

to impose conditions upon the purchaser, or licensee, that are not otherwise 

permissible under the copyright law. The principal terms of the shrink-wrap 

license include prohibiting the unauthorized copying and renting of the 

software, prohibiting reverse engineering and modifications of the software, 

limiting the use of the software to one computer, disclaiming warranties, and 

limiting liabilities. 

Software developers have legitimate concerns about software piracy. 

Counterfeiting is an international problem that results in the sale of millions of 

dollars of pirated software. The Software Publisher's Association (SPA) and 

the Business Software Alliance (BSA) are major organizations that combat 

software piracy. The SPA is the leading international trade association for the 

personal computer software industry. Both SPA and BSA have collected 

millions of dollars worldwide from companies that have used pirated software. 

Most companies using pirated software are reported by former employees. 

 

 

 Questions 

 

1. What is computer software? What is the difference between 

computer software and hardware? 

2. What ways of protecting computer software do exist? 

3. What are the basic types of computer software? 

4. What is the role of the system software in sustaining computer 

operation? 

5. What are the basic types of computer application software? 

6. Name the basic types of computer application software. 

7. What is the difference between different types of computer software 

(system, programming and application)? 
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Theme 5. MS Windows operating system  
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 Introduction 

The purpose of this theme lies in a close study of the peculiar features 

of computer operating systems. The nature of computer operating systems is 

analyzed and questions connected with operating systems at work are given 

a special consideration. A thorough analysis covers different types of MS 

Windows computer operating systems and their use by different groups of 

users. 

Clue notions of the theme include: computer operating system; 

security; operation modes; Windows; built-in applications, personalization. 

This theme covers the following topics: What is a computer operating 

system? What work is done by computer operating systems? How do 

computer operating systems control computer operation? What are the basic 

types of MS Windows computer operating systems? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the difference between operating systems and other 

types of computer software; 

they would learn the basic principles that guide computer operating 

systems` work; 

they would become aware of the features of the most known computer 

operating systems. 

 

5.1. Introduction to computer operating systems 

 An Operating System (OS) is an interface between hardware and 

user which is responsible for the management and coordination of activities 

and the sharing of the resources of the computer that acts as a host for 

computing applications run on the machine. 

 

As a host, one of the purposes of an operating system is to handle the 

details of the operation of the hardware. This relieves application programs 

from having to manage these details and makes it easier to write applications. 

Almost all computers (including handheld computers, desktop compu-

ters, supercomputers, video game consoles) as well as some robots, 

domestic appliances (dishwashers, washing machines), and portable media 

players use an operating system of some type (fig. 5.2). 
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Fig. 5.2. The place of the operating system in the process of user-

computer interaction 
 

Operating systems offer a number of services to application programs 

and users. Applications access these services through application program-

ming interfaces (APIs) or system calls. By invoking these interfaces, the 

application can request a service from the operating system, pass 

parameters, and receive the results of the operation. 

 
Users may also interact with the operating system with some kind of 

software user interface (SUI) like typing commands by using command line 

interface (CLI) or using a graphical user interface (GUI, commonly 

pronounced “gooey”). For hand-held and desktop computers, the user 

interface is generally considered part of the operating system. 

Common contemporary operating systems include BSD, Darwin (Mac 

OS X), Linux, SunOS (Solaris/OpenSolaris), and Windows NT (XP/Vista/7). 

While servers generally run Unix or some Unix-like operating system, 

embedded system markets are split amongst several operating systems, 



 59 

although the Microsoft Windows line of operating systems has almost 90% of 

the client PC market. 

Modern operating systems provide the capability of running multiple 

application programs simultaneously, which is referred to as multiprogram-

ming. Each program running is represented by a process in the operating 

system. The operating system provides an execution environment for each 

process by sharing the hardware resources so that each application does not 

need to be aware of the execution of other processes. The central processing 

unit (CPU) of the computer can be used by only one program at a time. The 

operating system can share the CPU among the processes by using a 

technique known as time slicing. In this manner, the processes take turns 

using the CPU. Single-user desktop personal computers (PCs) may simplify 

this further by granting the CPU to whichever application the user has 

currently selected and allowing the user to switch between applications at will. 

 
The main memory of a computer (referred to as random access 

memory, or RAM) is a finite resource. The operating system is responsible for 

sharing the memory among the currently running processes. When a user 

initiates an application, the operating system decides where to place it in 

memory and may allocate additional memory to the application if it requests 

it. The operating system may use capabilities in the hardware to prevent one 

application from overwriting the memory of another. This provides security 

and prevents applications from interfering with one another. 

The details of device management are left to the operating system. The 

operating system provides a set of APIs to the applications for accessing 

input/output (I/O) devices in a consistent and relatively simple manner 

regardless of the specifics of the underlying hardware. The operating system 

itself will generally use a software component called a device driver to control 

an I/O device. This allows the operating system to be upgraded to support 
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new devices as they become available. In addition to a device driver for the 

network I/O device, the operating system includes software known as a 

network protocol and makes various network utilities available to the user. 

Operating systems provide security by preventing unauthorized access 

to the computer's resources. Many operating systems also prevent users of a 

computer from accidentally or intentionally interfering with each other. The 

security policies that an operating system enforces range from none in the 

case of a video game console, to simple password protection for hand-held 

and desktop computers, to very elaborate schemes for use in high-security 

environments. 

 

5.2. WINDOWS OS: general characteristic 

Microsoft Windows is a series of software operating systems and 

graphical user interfaces produced by Microsoft. Microsoft first introduced an 

operating environment named Windows in November 1985 as an add-on to 

MS-DOS in response to the growing interest in graphical user interfaces 

(GUIs). 

Microsoft Windows came to dominate the world's personal computer 

market, overtaking Mac OS, which had been introduced previously. As of July 

2010, Windows had approximately 90% of the market share of the client 

operating systems for usage on the Internet. The most recent client version of 

Windows is Windows Vista; the most recent server version is Windows 

Server 2008. Vista's successor, Windows 7 is currently at release to 

manufacturing (see fig. 6.3). 

As of June 2010, Microsoft Windows holds a large amount of the 

worldwide desktop market share. In recent years, Microsoft has spent 

significant marketing and research & development money to demonstrate that 

Windows is capable of running any enterprise application, which has resulted 

in consistent price/performance records and significant acceptance in the 

enterprise market. 

On October 2001, Microsoft released Windows XP, a popular version 

built on the Windows NT kernel that also retained the consumer-oriented 

usability of Windows 95 and its upcoming successors (see Windows topology 

on fig. 5.3). This version was widely praised in computer magazines. It 

shipped in two distinct editions, “Home” and “Professional”, the former lacking 

many of the superior security and networking features of the Professional 
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edition. Additionally, the first “Media Center” edition was released in 2002, 

with an emphasis on support for DVD and TV functionality including program 

recording and a remote control. Mainstream support for Windows XP ended 

on April 14, 2009. Extended support will continue until April 8, 2014. 

 
Fig. 5.3. OS Windows family 

 

On January 30, 2007, Microsoft released Windows Vista. It contains a 

number of new features, from a redesigned shell and user interface to 

significant technical changes, with a particular focus on security features. It is 

available in a number of different editions, and has been subject to some 

criticism. 

On October 22, 2009, Microsoft released Windows 7. Unlike its 

predecessor, Windows Vista, which introduced a large number of new 

features, Windows 7 was intended to be a more focused, incremental 

upgrade to the Windows line, with the goal of being compatible with 

applications and hardware which Windows Vista was not at the time. 

Windows 7 has multi-touch support, a redesigned Windows shell with a new 

taskbar, referred to as the Superbar, a home networking system called 

HomeGroup, and performance improvements. 

Windows 8, the successor to Windows 7, is currently in development. 

Microsoft has posted a blog in Dutch on October 22, 2010 hinted that 

Windows 8 will be released after 2 years. 

 

5.3. Modern versions of MS Windows OS: XP, Vista, Seven 

A bit less than three years ago, Windows Vista was officially launched 

after a long delay. The operating system brought a raft of long-overdue new 

features to the Windows platform to make it truly fit for hardware of the 21st 

century. In came a new graphics stack and sound stack, as well as significant 

security, networking, and storage changes. 
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The changes were all well and good — the graphics work in particular 

was essential to allow Windows to offer functionality equivalent to that found 

in Mac OS X for many years — but they came at a high cost. To take 

advantage of all the new features required the use of all-new Windows Vista 

hardware drivers. As for its impact on users, Vista also brought with it higher 

hardware demands that caused many to recoil in horror. This wasn't a new 

phenomenon, of course; Windows XP and Windows 2000 before it both had 

the same effect. So big, so bloated, so slow — these are traditional criticisms 

leveled at any new Windows release, and Vista was no exception. In truth, 

Vista's hardware requirements were not egregious; the problem was that in 

comparison to XP's ancient, five-year-old requirements, Vista's requirements 

represented a big step up, especially in the area of video hardware. 

So when Windows Vista became publicly available in early 2007, the 

reception was rather lukewarm. Third-party hardware and software support 

was spotty, backwards compatibility was reduced, and system demands were 

markedly higher. This led to a computing public that clamored for the 

continued availability of Windows XP, and many businesses (chipmaker Intel 

among them) swore off the new version of Windows in favor of its ancient 

predecessor.  

The thing that XP had on its side was time. XP should have been 

replaced by Windows Longhorn in 2004 or 2005, but the cancellation of the 

Longhorn project and subsequent wait for Vista meant that everyone — 

users, software developers, hardware vendors — treated Windows XP as the 

main (or even only) version of Windows, with the result that everything 

worked with XP. The early woes were forgotten, and XP, old and clunky as it 

was, became the version of Windows that everyone loved and adored (or at 

least, tolerated). 

Although Windows Vista may have caused vendors and users alike 

some amount of pain, it was all for a good reason. Vista was progress, and it 

paved the way for Windows 7. To take advantage of modern video cards, 

Windows needed a new graphics stack; to withstand the increasing malware 

onslaught, Windows needed to tighten security and make running as a 

regular user more comfortable. These changes were not made lightly; the 

break with the past was necessary to put the operating system on the same 

footing as its competition and to address long-standing, legitimate criticisms 

of the platform. Microsoft was never going to revert to a more XP-like 

operating system, no matter how desperately some cling to the old OS. 
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The Start menu wasn't the only positive change in Vista. Vista moved 

the bulk of video drivers into user mode, which means that they can crash 

and be restarted more or less seamlessly. In a similar vein, upgrading video 

drivers without rebooting is now a reality. Moving from video to sound, Vista's 

new sound stack lets users set audio volume on a per-application basis, 

which is another good feature. In the end, Vista brought a lot of good stuff. It 

was a major overhaul of the platform, and in retrospect, it's not entirely 

surprising that the transition was somewhat imperfect. Third parties could, 

and should, have done better, but they have at least caught up now. 

Windows 7 can take advantage of the two and a half years of progress 

that hardware and software vendors have made in supporting Vista. It can 

exploit the fact that Moore's Law means even cheap netbooks have got the 

horsepower to run the new OS. Vista's life was always going to be hard; any 

major update to a platform as diverse and widely used as Windows is always 

going to be met with resistance. But Vista has done its job; XP is no longer 

the target platform for developers, and vendors are producing hardware and 

software that works with the stricter security and modernized graphics and 

audio subsystems. 

Windows 7 has an important job to do. First, it must consolidate the 

architectural changes that made Vista so painful, and to provide small 

refinements to the platform and smooth off rough edges. And second, it has 

to be a version of Windows that people want to run, and it needs to be this 

right out the gate. 

 

5.4. MS Windows OS concept: user interface, file system, built-in tools 

and applications 

Windows 7 has been around for some time now and since its release 

on July 22, 2009 more and more users are working with it. So we’ll use it as 

an example in order to characterize Windows OS of today. 

One of the first things you'll notice when you boot into the Windows 7 desktop 

for the first time is how pristine things are by default. There's only a single icon on 

the desktop, Recycle Bin. The taskbar includes only three buttons by default – 

Internet Explorer, Windows Media Player, and Windows Explorer – and the 

notification area has just three, Action Center, Networking, and Volume. Those that 

like to populate the desktop with shortcuts are still free to do so, of course. You can 

also add a selection of Desktop Gadgets to the desktop, if you're so inclined. In 

Vista, these gadgets were part of an extraneous bit of UI called the Sidebar, and it 
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was enabled by default. This time around, the Sidebar is gone but the gadgets 

remain. Indeed, the stock collection of gadgets is largely unchanged from that 

which was offered with Vista, an odd shortcoming (fig. 5.4). 

 

Fig. 5.4. Windows gadgets list 
 

The familiar right-click desktop menu has been simplified since Vista, with the 

screen resolution and other personalization options separated for quicker access. 

The Personalization control panel has been significantly overhauled with support for 

new Aero Themes which combine wallpaper (or, optionally, constantly rotating sets 

of wallpaper), an Aero window color, a sound scheme, and a screensaver into a 

single, savable, and shareable entity. Windows 7 ships with a number of very high 

quality themes, and you can download more online from a variety of places or make 

your own (fig. 5.5). 

 

Fig. 5.5. Personalization window 
 

Windows Flip – what most people think of as "ALT + TAB" since that's how 

you access it – has been updated to provide full-screen previews of the currently 
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selected window only. So as you scroll through the list of open windows, all 

windows but the currently-selected one will be hidden (fig. 5.6). 

 

Fig. 5.6.  Windows Flip picks up a nice windows preview capability 
 

In Windows 7, the taskbar has been significantly elevated from its previous 

pedestrian use as a way to track open windows. Now, it takes on double duty, 

managing both running and non-running applications (and open and unopened 

windows). So in Windows 7, Microsoft has combined the Quick Launch toolbar right 

into the taskbar (fig. 5.7). The Windows 7 taskbar is bigger by default than previous 

versions, with bigger, easier-to-see and read buttons. 

 
Fig. 5.7. The new Windows 7 taskbar combines shortcuts for non-

running applications with buttons for running applications. 
 

Regardless of the view style you use, the new taskbar does provide some 

other interesting new capabilities. If you mouse over the button for an open window 

or running application, the taskbar displays a handy pop-up thumbnail of the 

underlying window. The taskbar buttons and previews are all live. So if you 

minimize, say, Windows Media Player while it's playing a video and then mouse 

over the application's taskbar button, you'll see the video playing in the thumbnail 

that appears (fig. 5.8). 

 
Fig. 5.8. Taskbar thumbnails are live 
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Though the Start Menu has lost some of its mojo to the new taskbar in 

Windows 7, one long-time bit of Start Menu functionality is being made more 

broadly available in this system courtesy of a new feature called Jump Lists. 

Whereas the global Start Menu was a central jumping off point for all applications 

and documents, however, Jump Lists are like mini, application- and control panel-

specific Start Menus.They appear, attached to applications (and control panel) 

shortcuts, in both the Start Menu and on the new taskbar. And like the Start Menu 

itself, Jump Lists are highly customizable, by both application developers and 

users. 

Jump Lists exhibit two types of behaviors: those that are automatic and those 

that are customized. By default, application Jump Lists will display a list of the 

most-recently-used documents that are associated with that application. In the Start 

Menu, those lists appear like so, expanding out into the right-hand side of the Start 

Menu (fig. 5.9). 

 
Fig. 5.9. A Jump List in the Start Menu. 

 

At first, you won't see much in an application's Jump List: Just the name of 

the application (which can be clicked to launch a new instance of that application, 

or window) and a Close window option. 

If you have pinned the shortcut to the Start Menu or taskbar and enable the 

Jump List from that location, you'll also see an option related to unpinning it. 

Document-based applications will auto-populate their Jump Lists with links to the 10 

most-recently-used documents. 

In previous Windows versions, there were special shell folders like My 
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Documents and My Music that mapped to specific locations in the shell hierarchy. 

In Windows 7, these locations still exist, but instead, Microsoft provides four virtual 

folders, or Libraries – Documents, Music, Photos, and Videos – which aggregate 

content from a variety of shell locations and provide the basis for Windows 7's 

document and media sharing capabilities (fig. 5.10). 

 
 

Fig. 5.10. Some unique arrangement views are available only in Library 

windows 
 

Applications that are bundled with Windows 7 OS 

Microsoft bundles a number of applications and utilities in Windows OS, and 

several are worth longer discussions. Two applications, Paint and WordPad, have 

been updated fairly dramatically, both for the first time in years. The most obvious 

change to both, of course, is the addition of the second-generation ribbon user 

interface called Scenic Ribbon. This toolbar-like construct exposes features that 

were previously hidden and you're probably at least passingly familiar with the first 

generation ribbon that debuted in Office 2007 (fig. 5.11). 

 
 

Fig. 5.11. The Scenic Ribbon appears in Paint and WordPad 
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Paint, in particular, has gotten a surprisingly thorough makeover in Windows 

7. There are many new capabilities, including numerous brushes and shapes, easy 

transparent selections, and more.  

WordPad picks up the ribbon too, but the changes there are less dramatic. It 

does support the new Open XML (*.docx) and Open Document (*.odf) document 

formats, however, so this app is a great tool for those with older Office versions 

who need to read newer documents.  

On the utility front, there are some interesting changes and additions. The 

age-old Calculator utility has been dramatically updated for Windows 7, and spots 

numerous modes and built-in functions and worksheets (fig. 5.12). 

 
 

Fig. 5.12. Calculator picks up a bunch of new functionality, including 

this handy mortgage calculator 
 

Windows 7 also includes a Sticky Notes application instead of the Notes 

gadget that graced Windows Vista. This one runs like a normal application and so 

provides a taskbar button along with an associated (if not hugely useful) Jump List 

(fig. 5.13). 

 
Fig. 5.13. Sticky Notes 

 

XPS Viewer staggers in from Windows Vista – does anyone ever actually use 

this thing? – along with the Snipping Tool screen capture utility that debuted in 
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Windows XP Tablet PC Edition and is now available in all mainstream Windows 7 

versions. (Don't worry, the PRTSCN screen capture methods still work too.) For you 

old-timers, Windows Fax and Scan soldiers along in Windows 7, as does the 

Windows Journal application, which also debuted first on tablet PCs. 

Enterprise features. Windows 7 comes with a range of new features to 

improve manageability and security, and enterprise deployment of Windows 7 

builds on the new features introduced with Vista. 

AppLocker. Software Restriction Policies are an effective and widely used 

mechanism for locking down Windows installations and permitting only specific 

applications to run. 

AppLocker, a new SRP-like technology, improves this situation. AppLocker 

allows policies to be set in a more flexible way. For example, a policy might say 

"Allow the program Acrobat Reader, as long as its publisher (verified by digital 

signature) is Adobe and the version is at least 9." Such a rule would allow 

deployment of bugfixes without any need to create new rules. 

BitLocker To Go. It has become a popular pastime amongst government 

employees to load as much sensitive data as possible onto a laptop and then 

deposit that laptop in a public place so that someone can find it. This hobby has 

likely spread to the private sector too, although it attracts less attention there. 

Windows Vista's BitLocker feature enabled encryption of whole partitions, requiring 

a PIN or suitable USB key to decrypt them. 

However, the data-losers are an inventive bunch, and many of them have 

noticed that you can use removable media to lose data quite effectively, too. One 

solution has been to block the use of removable media entirely, but this is often a 

rather heavy-handed approach. Windows 7 provides an alternative; it supports the 

use of BitLocker on removable media, "BitLocker To Go." This supports USB flash 

drives, external hard disks, memory cards, and anything else that's NTFS, FAT, 

FAT32, or exFAT-formatted. The use of BitLocker To Go can further be mandated, 

to ensure that all removable media are secure. Unencrypted disks can still be read, 

but any attempts to write are blocked until secured. 

The Problem Steps Recorder should be a boon for helpdesks everywhere. 

This simple tool lets you make a recording of the steps required to reproduce a 

problem. The recording includes screenshots, system information, and optional 

annotations as necessary, and should do a good job of taking the guesswork out of 

supporting end-user problems. 

PowerShell 2.0 is installed as standard, which should in principle make it 

easier to write and use complex login scripts. PowerShell scripts can also be 

http://arstechnica.com/reviews/os/vista-under-the-hood.ars/5
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invoked remotely, allowing an administrator on a single PC to perform standard 

management actions on a set of PCs at once, or take specific action on a single 

remote machine. 

Offline Files, one of the things that has seen some refinements. Policies can 

now be applied to prevent, for example, MP3s from being synced. The offline file 

store can also now be used as a cache. 

Normally with Offline Files a PC with a network connection will still depend on 

the fileserver for all access to the file. If access to the fileserver is slow for whatever 

reason then so is access to the file. 

By enabling Transparent Caching through GPOs (it's not enabled by default), 

the client machine will use the local cache in preference to the network. To ensure 

the file is kept up-to-date the network still needs to be queried, but unless the file 

has been changed, no data will be transferred, making an excellent feature even 

better. By now you can probably guess which OS is required on the server for this 

capability. 

The new enterprise features are all pretty compelling. But there is a common 

refrain to many of them; they need Windows Server 2008 R2 to work. Most of the 

network-related features, including the improved deployment capabilities, won't 

work until the server infrastructure is updated in tandem. 

 

 

 Questions 

 

1. What is a computer operating system? 

2. What is the difference between operating systems and other types of 

computer software? 

3. What work is done by computer operating systems? 

4. How do computer operating systems control computer operation? 

5. What are the basic types of MS Windows computer operating 

systems? 

6. Can a personal computer run any operating system without 

reconfiguring its hardware? 

 

 

 

 

 

 



 71 

Section 3. Text processing engines. MS Office Word 

Theme 6. Introduction to MS Office Word essentials 
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Fig. 6.1. System elements of the theme 
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 Introduction 

The purpose of this theme is connected with the study of main features 

of MS Office Word text processing engine. The program’s interface is 

considered in detail and basic operations concerned with the creation and 

modification of text documents are given a special attention. 

Clue notions of the theme include: office button; ribbon; pop-up 

menus; text formatting; tables; lists; fonts, paragraphs. 

This theme covers the following topics: What is text document? How to 

create and save a document? What are the basic text formatting operations? 

How to work with tables, lists and special objects? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would learn how to create, modify and save text documents; 

they would master main text formatting techniques; 

they would learn the basic operations with tables and special objects; 

they would become aware of the text proofing options available in MS 

Office Word. 

 

6.1. Microsoft Office Word workspace 

 Microsoft Word is a non-free word processor designed by Microsoft. 

It was first released in 1983 under the name Multi-Tool Word for Xenix 

systems. Subsequent versions were later written for several other platforms 

including IBM PCs running DOS (1983), the Apple Macintosh (1984), the 

AT&T Unix PC (1985), Atari ST (1986), SCO UNIX, OS/2, and Microsoft 

Windows (1989). It is a component of the Microsoft Office system; it is also 

sold as a standalone product and included in Microsoft Works Suite. The 

current versions are Microsoft Word 2010 for Windows and 2011 for Mac. 

When you launch MS Word, the workspace appears and your screen 

looks similar to the one shown below (fig. 6.2). 

When you begin to explore MS Word you will notice a new look to the 

menu bar. There are three features that you should remember as you work 

within Word: the Microsoft Office Button, the Quick Access Toolbar, and the 

Ribbon. These three features contain many of the functions that were in the 

menu of previous versions of Word. 
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Fig. 6.2. MS Office Word interface 

The Microsoft Office button performs many of the functions that were 

located in the File menu of older versions of Word. This button allows you to 

create a new document, open an existing document, save or save as, print, 

send (through email or fax), publish or close (fig. 3). 

 

Fig. 6.3. MS Office Button 

The Ribbon is the panel at the top portion of the document. It has seven 

tabs: Home, Insert, Page Layout, References, Mailings, Review, and View 

that contain many new and existing features of Word. Each tab is divided into 

groups. The groups are logical collections of features designed to perform 

functions that you will utilize in developing or editing your Word document. 
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Fig. 6.4. MS Office Word ribbon area 

Each of the tabs contains the following tools: 

Home: Clipboard, Fonts, Paragraph, Styles, and Editing. 

Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and 

Symbols 

Page Layout: Themes, Page Setup, Page Background, Paragraph, 

Arrange 

References: Table of Contents, Footnote, Citation & Bibliography, 

Captions, Index, and Table of Authorities 

Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview 

Results, Finish 

Review: Proofing, Comments, Tracking, Changes, Compare, Protect 

View: Document Views, Show/Hide, Zoom, Window, Macros 

The quick access toolbar is a customizable toolbar that contains 

commands that you may want to use. You can place the quick access toolbar 

above or below the ribbon. To change the location of the quick access 

toolbar, click on the arrow at the end of the toolbar and click on Show Below 

the Ribbon (fig 5). 

 
Fig. 6.5. Quick Access toolbar 

 

You can also add items to the quick access toolbar. Right click on any 

item in the Office Button or the Ribbon and click on Add to Quick Access 

Toolbar and a shortcut will be added to the Quick Access Toolbar. 

 

6.2. Working with documents: editing a document, formatting text 

and paragraphs 

There are several ways to create new documents, open existing 

documents, and save documents in Word: 
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Click the Microsoft Office Button  and Click New or Press CTRL+N. 

You will notice that when you click on the Microsoft Office Button and 

Click New, you have many choices about the types of documents you can 

create. If you wish to start from a blank document, click Blank.  If you wish to 

start from a template you can browse through your choices on the left, see 

the choices on center screen, and preview the selection on the right screen. 

Opening an Existing Document. Click the Microsoft Office Button  and 

Click Open, or Press CTRL+O on the keyboard, or if you have recently used 

the document you can click the Microsoft Office Button and click the name of 

the document in the Recent Documents section of the window Insert picture 

of recent docs 

Saving a Document. Click the Microsoft Office Button  and 

Click Save or Save As (remember, if you’re sending the document to 

someone who does not have newer Office, you will need to click the Office 

Button, click Save As, and Click Word 97-2003 Document), or Press CTRL+S 

on the keyboard, or Click the File icon on the Quick Access Toolbar: 
 

 
 

Renaming Documents. To rename a Word document while using the 

program: 

Click the Office Button and find the file you want to rename. Right-click 

the document name with the mouse and select Rename from the shortcut 

menu. Type the new name for the file and press the ENTER key. 

Working on Multiple Documents. Several documents can be opened 

simultaneously if you are typing or editing multiple documents at once.  All 

open documents will be listed in the View Tab of the Ribbon when you click 

on Switch Windows.  The current document has a checkmark beside the file 

name.  Select another open document to view it (fig. 6).  
 

 
Fig. 6.6. Window switch option 
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There are many ways to view a document in Word.  

Print Layout:  This is a view of the document as it would appear when 

printed.  It includes all tables, text, graphics, and images. 

Full Screen Reading:  This is a full length view of a document.  Good 

for viewing two pages at a time. 

Web Layout:  This is a view of the document as it would appear in a 

web browser. 

Outline:  This is an outline form of the document in the form of bullets. 

Draft:  This view does not display pictures or layouts, just text. 

To enter text, just start typing it. The text will appear where the blinking 

cursor is located. Move the cursor by using the arrow buttons on the 

keyboard or positioning the mouse and clicking the left button. The keyboard 

shortcuts listed below are also helpful when moving through the text of a 

document (table 1). 

Table 6.1 

Keyboard shortcuts 

Move Action Keystroke 

Beginning of the line HOME 

End of the line END 

Top of the document CTRL+HOME 

End of the document CTRL+END 
 

To change any attributes of text it must be highlighted first. Select the 

text by dragging the mouse over the desired text while keeping the left mouse 

button depressed, or hold down the SHIFT key on the keyboard while using 

the arrow buttons to highlight the text. The following table contains shortcuts 

for selecting a portion of the text (table 2). 

Table 6.2 

Text selecting shortcuts 

Selection Technique 

Whole word double-click within the word 

Whole paragraph triple-click within the paragraph 

Several words or 

lines 

drag the mouse over the words, or hold 

down SHIFT while using the arrow keys 

Entire document choose Editing | Select | Select All from the 

Ribbon, or press CTRL+A 
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Deselect the text by clicking anywhere outside of the selection on the 

page or press an arrow key on the keyboard. 

Text can be inserted in a document at any point using any of the 

following methods: 

Type Text:  Put your cursor where you want to add the text and begin 

typing. 

Copy and Paste Text:  Highlight the text you wish to copy and right 

click and click Copy, put your cursor where you want the text in the document 

and right click and click Paste. 

Cut and Paste Text:  Highlight the text you wish to copy and right click 

and click Cut, put your cursor where you want the text in the document and 

right click and click Paste. 

Drag Text:  Highlight the text you wish to move, click on it and drag it to 

the place where you want the text in the document. 

To find a particular word or phrase in a document: 

Click Find on the Editing Group on the Ribbon 

To  find and replace a word or phrase in the document, click Replace on 

the Editing Group of the Ribbon (fig. 6.7). 

 
Fig. 6.7. Text Editing group 

 

Work with text styles. 

 A style is a format enhancing tool that includes font typefaces, font 

size, effects (bold, italics, underline, etc.), colors and more. 

You will notice that on the Home Tab of the Ribbon, that you have 

several areas that will control the style of your document:  Font, Paragraph, 

and Styles (fig. 6.8). 

 

Fig. 6.8. Text Style area of the Ribbon 
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To change the font typeface click the arrow next to the font name and 

choose a font. Remember that you can preview how the new font will look by 

highlighting the text, and hovering over the new font typeface. 

To change the font size click the arrow next to the font size and choose 

the appropriate size, or click the increase or decrease font size buttons (see 

fig. 6.9). 

 
Fig. 6.9. Font group 

 

It is also possible to change font styles and effects. Font styles are 

predefined formatting options that are used to emphasize text.  They 

include: Bold, Italic, and Underline.  To add these to text select the text and 

click the Font Styles included on the Font Group of the Ribbon, or Select the 

text and right click to display the font tools (fig. 6.9) 

To change the text color select the text and click the Colors button 

included on the Font Group of the Ribbon (fig. 9), or Highlight the text and 

right click and choose the colors tool.  

If you have already formatted text the way you want it and would like 

another portion of the document to have the same formatting, you can copy 

the formatting.  To copy the formatting, do the following: 

select the text with the formatting you want to copy; 

copy the format of the text selected by clicking the Format 

Painter button on the Clipboard Group of the Home Tab; 

apply the copied format by selecting the text and clicking on it (fig. 

6.10). 

 
Fig. 6.10. Formatting copy tool 

 

Formatting of paragraphs. Formatting paragraphs allows you to 

change the look of the overall document.  You can access many of the tools 

of paragraph formatting by clicking the Page Layout Tab of the Ribbon or 

the Paragraph Group on the Home Tab of the Ribbon (fig. 6.11). 
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Fig. 6.11. Paragraph group of the Ribbon 

 

The paragraph alignment allows you to set how you want text to 

appear.  To change the alignment click the Home Tab and choose the 

appropriate button for alignment on the Paragraph Group (fig. 6.11). 

Indenting paragraphs allows you set text within a paragraph at different 

margins. There are several options for indenting. 

First Line:  Controls the left boundary for the first line of a paragraph. 

Hanging:  Controls the left boundary of every line in a paragraph 

except the first one. 

Left:  Controls the left boundary for every line in a paragraph. 

Right:  Controls the right boundary for every line in a paragraph. 

To indent paragraphs, you can do the following click the Indent buttons 

to control the indent (fig. 6.11).  

You can change the space between lines and paragraphs by doing the 

following: 

select the paragraph or paragraphs you wish to change; 

on the Home Tab, Click the Paragraph Dialog Box; 

click the Indents and Spacing Tab; 

in the Spacing section, adjust your spacing accordingly (fig. 6.12). 

 
Fig. 6.12. Paragraph dialog box 
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6.3. Working with tables: create, modify the table structure and format a 

table. The use of special characters and equations 

Tables are used to display data in a table format. To create a table: 

place the cursor on the page where you want the new table; 

click the Insert Tab of the Ribbon; 

click the Tables Button on the Tables Group. 

You can create a table one of four ways: highlight the number of row 

and columns; click Insert Table and enter the number of rows and columns; 

click the Draw Table, create your table by clicking and entering the rows and 

columns; click Quick Tables and choose a table (fig. 6.13). 

 
Fig. 6.13. Table creation options 

 

To modify the structure of a table click the table and notice that you 

have two new tabs on the Ribbon:  Design and Layout.  These pertain to the 

table design and layout (fig. 6.14). 
 

 
Fig. 6.14. Table styles option 
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To format a table, click the table and then click the Layout Tab on the 

Ribbon.  This Layout tab allows you to: 

view Gridlines and Properties (from the Table Group); 

insert Rows and Columns (from the Rows & Columns Group); 

delete the Table, Rows and/or Columns (from the Rows & Columns 

Group); 

merge or Split Cells (from the Merge Group); 

increase and Decrease cell size (Cell Size Group); 

align text within the cells and change text directions (Alignment Group) 

(fig. 6.15). 

 
Fig. 6.15. Table tools part of the Ribbon 

 

MS Word allows you to insert special characters, symbols, pictures, 

illustrations, and watermarks. Special characters are punctuation, spacing, or 

typographical characters that are not generally available on the standard 

keyboard. To insert symbols and special characters: 

place your cursor in the document where you want the symbol; 

click the Insert Tab on the Ribbon; 

click the Symbol button on the Symbols Group; 

choose the appropriate symbol (fig. 6.16). 

 
Fig. 6.16. Special character insert tab on the Ribbon 

 

MS Word also allows you to insert mathematical equations.  To access 

the mathematical equations tool: 
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place your cursor in the document where you want the symbol 

click the Insert Tab on the Ribbon 

click the Equation Button on the Symbols Group 

choose the appropriate equation and structure or click Insert New 

Equation (fig. 6.17) 

 

 
Fig. 6.17. Equation tools on the Symbols group 

 

To edit the equation click the equation and the Design Tab will be 

available in the Ribbon 

 

6.4. Bulleted and numbered lists. Page margins and orientations. 

Spelling and grammar checking 

Lists allow you to format and organize text with numbers, bullets, or in 

an outline. Bulleted lists have bullet points, numbered lists have numbers, 

and outline lists combine numbers and letters depending on the organization 

of the list. 

To add a list to existing text select the text you wish to make a list and 

from the Paragraph Group on the Home Tab, Click the Bulleted or Numbered 

Lists button (fig. 6.18). 

 
Fig. 6.18. Bulleted or Numbered Lists button 

 

A nested list is list with several levels of indented text. To create a 

nested list: 

create your list following the directions above; 

click the Increase or Decrease Indent button: 
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The bullet image and numbering format can be changed by using 

the Bullets or Numbering dialog box. Select the entire list to change all the 

bullets or numbers, or place the cursor on one line within the list to change a 

single bullet, right click an then click the arrow next to the bulleted or 

numbered list and choose a bullet or numbering style (fig. 6.19). 

 
Fig. 6.19. Custom bullets option 

 

In some cases it may become necessary to change the page margins of 

the document. The page margins can be modified through the following 

steps: 

click the Page Layout Tab on the Ribbon; 

on the Page Setup Group, Click Margins; 

click a Default Margin, or click Custom Margins and complete the dialog 

box (fig. 6.20). 

I  

Fig. 6.20. Change margins group 
 

To change the Orientation, Size of the Page, or Columns: 

click the Page Layout Tab on the Ribbon; 
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on the Page Setup Group, Click the Orientation, Size, or Columns drop 

down menus; 

click the appropriate choice; 
 

It is also possible to customize page borders. To apply a page border or 

color click the Page Layout Tab on the Ribbon and on the Page Background 

Group, click the Page Colors or Page Borders drop down menus (fig. 6.21) 

 
Fig. 6.21. Page Borders option 

 

 Headers and footers are special areas of the page that can contain 

some additional information. 

To insert Header and Footer information such as page numbers, date, 

or title, first, decide if you want the information in the header (at the top of the 

page) or in the Footer (at the bottom of the page), then: 

click the Insert Tab on the Ribbon; 

click Header or Footer; 

choose a style (fig. 6.22). 

I  

Fig. 6.22. The Header/Footer Design tab of the Ribbon 
 

Choose the information that you would like to have in the header or 

footer (date, time, page numbers, etc.) or type in the information you would 

like to have in the header or footer. 
 

Proofreading a Document. In MS Word there are many features to 

help you proofread your document.  These include:  Spelling and Grammar, 

Thesaurus, AutoCorrect, Default Dictionary, and Word Count. To check the 

spelling and grammar of a document: 

place the cursor at the beginning of the document or the beginning of 

the section that you want to check; 
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click the Review Tab on the Ribbon; 

click Spelling & Grammar on the Proofing Group (fig. 6.23).  
 

 
Fig. 6.23. Spelling & Grammar group 

Any errors will display a dialog box that allows you to choose a more 

appropriate spelling or phrasing: 

 
 

If you wish to check the spelling of an individual word, you can right click any 

word that has been underlined by Word and choose a substitution. 

 

 

 Questions 

 

1. What are the main elements of the MS Word interface? 

2. What is the reason to save documents in a different format so that 

they could be usable by earlier versions of MS Word? 

3. What is a text style? 

4. What types of lists are available in MS Word? 

5. How many ways are there in MS Word to create a table? 

6. What are Headers and Footers for? 

7. What is the reason to use text proofing options in MS Word? 
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Section 4. Spreadsheet processing engines basics. 

MS Office Excel 

Theme 7. Introduction to MS Office Excel essentials 
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Fig. 7.1. System elements of the theme 
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 Introduction 

The purpose of this theme is concerned with the study of main features 

of MS Office Excel spreadsheet processing engine. 

The program’s interface is considered in detail and basic operations 

concerned with the creation and modification of spreadsheet documents are 

given a special attention. 

Clue notions of the theme include: office button; ribbon; pop-up 

menus; tables formatting; cells; lists; fonts, formulas; functions; printing. 

This theme covers the following topics: Introduction to MS Excel 

electronic tables organizer. Program’s interface customizing and basic 

options study. Entering and erasing data. Basic operations with numbers. Use 

of functions. Cells addressing. Manipulations with cells, columns and rows. 

Basic operations with the simplest formulas and functions. Study of different 

ways of automatic cells filling. Headers and Footers of the document. Page 

adjusting and printing. 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would get acquainted with the program’s interface features; 

they would learn how to input and edit data and move across the 

worksheet; 

they would learn how to perform basic operations with numbers; 

they would become aware of the use of basic functions and simple 

formulas; 

they would learn how to fill parts of Header and Footer areas; 

they would practice different ways of adjusting page options before 

printing. 

 

7.1. Microsoft Office Excel workspace 

 Microsoft Excel is an electronic spreadsheet. It can be used to 

organize various data into rows and columns. It can also be used to perform 

mathematical calculations and manage databases. 

 

After you start Microsoft Excel the Microsoft Excel window appears and 

the screen looks similar to the one shown below (fig. 7.2).  

http://www.baycongroup.com/excel2007/01_excel.htm#formulabar#formulabar
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Fig. 7.2. Microsoft Excel window 

 

Your screen will probably not look exactly like the screen shown. In MS 

Excel, how a window displays depends on the size of your window, the size of 

your monitor, and the resolution to which your monitor is set.  

In the upper-left corner of the Excel window is the Microsoft Office 

button . When you click the button, a menu appears. You can use the 

menu to create a new file, open an existing file, save a file, and perform many 

other tasks. 

Next to the Microsoft Office button is the Quick Access toolbar. The 

Quick Access toolbar gives you access to commands you frequently use. By 

default, Save, Undo, and Redo appear on the Quick Access toolbar. You can 

use Save to save your file, Undo to roll back an action you have taken, and 

Redo to reapply an action you have rolled back. 

Next to the Quick Access toolbar is the Title bar. On the Title bar, 

Microsoft Excel displays the name of the workbook you are currently using. At 

the top of the Excel window, you should see "Microsoft Excel - Book1" or a 

similar name. 

You use commands to tell Microsoft Excel what to do. In Microsoft 

Excel, you use the Ribbon to issue commands. The Ribbon is located near 

the top of the Excel window, below the Quick Access toolbar. At the top of the 

Ribbon are several tabs; clicking a tab displays several related command 

groups. Within each group are related command buttons (fig. 7.3). 

http://www.baycongroup.com/excel2007/01_excel.htm#formulabar#formulabar
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Fig. 7.3. The Ribbon areas 

 

You click buttons to issue commands or to access menus and dialog 

boxes. You may also find a dialog box launcher in the bottom-right corner of a 

group. When you click the dialog box launcher, a dialog box makes additional 

commands available. 

Microsoft Excel consists of worksheets. Each worksheet contains 

columns and rows. The columns are lettered A to Z and then continuing with 

AA, AB, AC and so on; the rows are numbered 1 to 1,048,576. The number of 

columns and rows you can have in a worksheet is limited by your computer 

memory and your system resources. 

The combination of a column coordinate and a row coordinate make up 

a cell address. For example, the cell located in the upper-left corner of the 

worksheet is cell A1, meaning column A, row 1. Cell E10 is located under 

column E on row 10. You enter your data into the cells on the worksheet (fig. 

7.4). 

 
Fig. 7.4. Cell address area 

 

The Formula Bar is used to show the formula or other contents of a cell 

(fig. 7.5). 

 
Fig. 7.5. Formula Bar 

 

If the Formula bar is turned on, the cell address of the cell you are in 

displays in the Name box which is located on the left side of the Formula bar. 

Cell entries display on the right side of the Formula bar.  

The Status bar appears at the very bottom of the Excel window and 
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provides such information as the sum, average, minimum, and maximum 

value of selected numbers (fig. 7.6). You can change what displays on the 

Status bar by right-clicking on the Status bar and selecting the options you 

want from the Customize Status Bar menu. You click a menu item to select it. 

You click it again to deselect it. A check mark next to an item means the item 

is selected. 

  

Fig. 7.6. MS Excel Status bar 
 

By using the arrow keys, you can move around your worksheet. You 

can use the down arrow key to move downward one cell at a time. You can 

use the up arrow key to move upward one cell at a time. You can use the Tab 

key to move across the page to the right, one cell at a time. You can hold 

down the Shift key and then press the Tab key to move to the left, one cell at 

a time. You can use the right and left arrow keys to move right or left one cell 

at a time. The Page Up and Page Down keys move up and down one page at 

a time. If you hold down the Ctrl key and then press the Home key, you move 

to the beginning of the worksheet. 

 

7.2. Operations with Excel formulas and data formatting tools 

 A major strength of Excel is that you can perform mathematical 

calculations and format your data. 



 91 

In Microsoft Excel, you can enter not only text, but also numbers and 

mathematical formulas into cells. Whether you enter a number or a formula, 

you can reference the cell when you perform mathematical calculations such 

as addition, subtraction, multiplication, or division. When entering a 

mathematical formula, precede the formula with an equal (=) sign. Use the 

following to indicate the type of calculation you wish to perform: 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Exponential 

You can use the AutoSum button on the Home tab to automatically 

add a column or row of numbers. When you press the AutoSum button , 

Excel selects the numbers it thinks you want to add. If you then click the 

check mark on the Formula bar or press the Enter key, Excel adds the 

numbers. If Excel's guess as to which numbers you want to add is wrong, you 

can select the cells you want. 

When you type text into a cell, by default your entry aligns with the left 

side of the cell. When you type numbers into a cell, by default your entry 

aligns with the right side of the cell. You can change the cell alignment. You 

can center, left-align, or right-align any cell entry. Look at cells A1 to D1. Note 

that they are aligned with the left side of the cell (fig. 7.7). 

 
Fig. 7.7. Default cell alignment 

 

In Excel, you can copy data from one area of a worksheet and place the 

data you copied anywhere in the same or another worksheet. In other words, 

after you type information into a worksheet, if you want to place the same 

information somewhere else, you do not have to retype the information. You 

simply copy it and then paste it in the new location.  

You can use Excel's Cut feature to remove information from a 

worksheet.  Then you can use the Paste feature to place the information you 

cut anywhere in the same or another worksheet.   In other words, you can 

move information from one place in a worksheet to another place in the same 

or different worksheet by using the Cut and Paste features. 
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Microsoft Excel records cell addresses in formulas in three different 

ways, called absolute, relative, and mixed. The way a formula is recorded is 

important when you copy it. With relative cell addressing, when you copy a 

formula from one area of the worksheet to another, Excel records the position 

of the cell relative to the cell that originally contained the formula. 

With absolute cell addressing, when you copy a formula from one area 

of the worksheet to another, Excel references the same cells, no matter 

where you copy the formula. You can use mixed cell addressing to keep the 

row constant while the column changes, or vice versa. The following 

exercises demonstrate. 

You can insert and delete columns and rows. When you delete a 

column, you delete everything in the column from the top of the worksheet to 

the bottom of the worksheet. When you delete a row, you delete the entire 

row from left to right. Inserting a column or row inserts a completely new 

column or row. 

You can use borders to make entries in your Excel worksheet stand 

out. You can choose from several types of borders. When you press the 

down arrow next to the Border button , a menu appears. By making the 

proper selection from the menu, you can place a border on the top, bottom, 

left, or right side of the selected cells; on all sides; or around the outside 

border. Accountants usually place a single underline above a final number 

and a double underline below. 

A font is a set of characters represented in a single typeface. Each 

character within a font is created by using the same basic style. Excel 

provides many different fonts from which you can choose. The size of a font is 

measured in points. There are 72 points to an inch. The number of points 

assigned to a font is based on the distance from the top to the bottom of its 

longest character. You can change the Font, Font Size, and Font Color of the 

data you enter into Excel. 

In Microsoft Excel, each workbook is made up of several or more 

worksheets. Each worksheet has a tab. By default, a workbook has three 

sheets and they are named sequentially, starting with Sheet1. The name of 

the worksheet appears on the tab. Before moving to the next topic, move to a 

new worksheet. 
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7.3. Creating Excel functions, automatic cells filling. Headers and 

Footers of Excel workbooks 

By using functions, you can quickly and easily make many useful 

calculations, such as finding an average, the highest number, the lowest 

number, and a count of the number of items in a list. Microsoft Excel has 

many functions that you can use.  

To use functions, you need to understand reference operators. 

Reference operators refer to a cell or a group of cells. There are two types of 

reference operators: range  and union. 

A range reference refers to all the cells between and including the 

reference. A range reference consists of two cell addresses separated by a 

colon. The reference A1:A3 includes cells A1, A2, and A3. The reference 

A1:C3 includes cells A1, A2, A3, B1, B2, B3, C1, C2, and C3. 

A union reference includes two or more references. A union reference 

consists of two or more numbers, range referneces, or cell addresses 

separated by a comma. The reference A7,B8:B10,C9,10 refers to cells A7, B8 

to B10, C9 and the number 10. 

Functions are prewritten formulas. Functions differ from regular 

formulas in that you supply the value but not the operators, such as +, -, *, /. 

For example, you can use the SUM function to add. When using a function, 

remember the following: 

use an equal sign to begin a formula; 

specify the function name; 

supply all the operators that are needed to build up the function and 

make it work (e.g. if you look for the highest number, be sure to supply the 

range of cells, under which to perform the check). 

To fulfill the third demand correctly, enclose arguments within 

parentheses. Arguments are values on which you want to perform the 

calculation. For example, arguments specify the numbers or cells you want to 

add. Use a comma to separate arguments. 

Here is an example of a function: =SUM(2,13,A1,B2:C7) 

In this function: 

the equal sign begins the function; 

SUM is the name of the function; 

2, 13, A1, and B2:C7 are the arguments; 

parentheses enclose the arguments; 

commas separate the arguments. 
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After you type the first letter of a function name, the AutoComplete list 

appears. You can double-click on an item in the AutoComplete list to 

complete your entry quickly. Excel will complete the function name and enter 

the first parenthesis. 

The SUM function adds argument values (fig. 7.8).  

 

 
Fig. 7.8. The SUM function 

 

You can use the AVERAGE function to calculate the average of a series 

of numbers (fig. 7.9). 

 

 
Fig. 7.9. The AVERAGE function 

 

You can use the MIN function to find the lowest number in a series of 

numbers. You can use the MAX function to find the highest number in a 

series of numbers. 

You can use Microsoft Excel to fill cells automatically with a series. For 

example, you can have Excel automatically fill your worksheet with days of 

the week, months of the year, years, or other types of series. 

Before doing this exercise first you need to create sample lists which 

later would be used to accomplish automatic filling. 

For this go to Office button→Excel options→Popular→Edit custom lists. 

In the opening window create two sets of  lists: full and abbreviated names of 

weekdays (fig. 7.10) 
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Fig. 7.10. Sample lists creation tool 

 

After doing all these operations with auto filling it is possible to try other 

ways of  automatic “predefined” filling of cells with numbers using options in 

Home tab – Editing – Fill. Pay special attention at ways of filling using Filling – 

Series. Look at results depending on different ways you use Series options 

(fig. 7.11). 

 
Fig. 7.11.  Series fill option 

 

You can use the Header & Footer button on the Insert tab to create 

headers and footers. A header is text that appears at the top of every page of 

your printed worksheet. A footer is text that appears at the bottom of every 

page of your printed worksheet. When you click the Header & Footer button, 

the Design context tab appears and Excel changes to Page Layout view. A 

context tab is a tab that only appears when you need it. Page Layout view 

structures your worksheet so that you can easily change the format of your 

document. You usually work in Normal view. 

You can type in your header or footer or you can use predefined 

headers and footers. To find predefined headers and footers, click the Header 

or Footer button or use the Header & Footer Elements group's buttons. When 

you choose a header or footer by clicking the Header or Footer button, Excel 
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centers your choice. The table shown here describes each of the Header & 

Footer Elements group button options (table 7.1). 

Table 7.1 

Header & Footer Elements 

Button Purpose 

Page Number Inserts the page number 

Number of Pages 
Inserts the number of pages in the 

document 

Current Time Inserts the current time 

File Path Inserts the path to the document 

File Name Inserts the file name 

Sheet Name Inserts the name of the worksheet 

Picture Enables you to insert a picture 

 

Both the header and footer areas are divided into three sections: left, 

right, and center. When you choose a Header or Footer from the Header & 

Footer Elements group, where you place your information determines whether 

it appears on the left, right, or center of the printed page. You use the Go To 

Header and Go To Footer buttons on the Design tab to move between the 

header and footer areas of your worksheet. 

 

7.4. Workbook print options: page orientation, margins, print order 

There are many print options that are supported by Excel. You set print 

options on the Page Layout tab. Among other things, you can set your 

margins, set your page orientation, and select your paper size. 

Margins define the amount of white space that appears on the top, 

bottom, left, and right edges of your document. The Margin option on the 

Page Layout tab provides several standard margin sizes from which you can 

choose.  

There are two page orientations: portrait and landscape. Paper, such 

as paper sized 8 1/2 by 11, is longer on one edge than it is on the other. If you 

print in Portrait, the shortest edge of the paper becomes the top of the page. 
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Portrait is the default option. If you print in Landscape, the longest edge of the 

paper becomes the top of the page:  
 

Portrait 
  

Landscape 
 

Paper comes in a variety of sizes. Most business correspondence uses 

8 1/2 by 11 paper, which is the default page size in Excel. If you are not using 

8 1/2 by 11 paper, you can use the Size option on the Page Layout tab to 

change the Size setting. 

In order to set the page layout: 

choose the Page Layout tab; 

click Margins in the Page Setup group. A menu appears; 

click Wide. Word sets your margins to the Wide settings (fig. 7.12). 

 
Fig. 7.12. Page layout 

 

In order to set the page orientation (fig. 7.13): 

choose the Page Layout tab; 

click Orientation in the Page Setup group. A menu appears; 
 

 
Fig 7.13. Page orientation 
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click Landscape. Excel sets your page orientation to landscape.  

In order to set the paper size: 

choose the Page Layout tab; 

click Size in the Page Setup group. A menu appears; 

click the paper size you are using. Excel sets your page size (fig. 7.14). 

 
Fig. 7.14. Paper size 

 

The simplest way to print is to click the Office button, highlight Print on 

the menu that appears, and then click Quick Print in the Preview and Print 

the Document pane. 

Dotted lines appear on your screen, and your document prints. The 

dotted lines indicate the right, left, top, and bottom edges of your printed 

pages. 

You can also use the Print Preview option to print. When using Print 

Preview, you can see onscreen how your printed document will look when 

you print it. 

If you click the Page Setup button while in Print Preview mode, you can 

set page settings such as centering your data on the page. 

If your document is several pages long, you can use the Next Page and 

Previous Page buttons to move forward and backward through your 

document. 

If you check the Show Margins check box, you will see margin lines on 

your document. You click the Print button when you are ready to print. The 

Print dialog box appears (fig. 7.15). 

Print dialog box contains a set of options that allow to adjust the 

parameters that would be further used by the printing device to produce a 

hard copy of the document. 
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Fig. 7.15. Print dialog box 

You can choose to print the entire worksheet or specific pages. If you 

want to print specific pages, enter the page numbers in the From and To 

fields. You can enter the number of copies you want to print in the Number of 

Copies field: 

click the Print button. The Print dialog box appears; 

click the down arrow next to the name field and select the printer to 

which you want to print; 

click OK. Excel sends your worksheet to the printer. 

 

 

 Questions 

 

1. What are the main elements of the MS Excel interface? 

2. What is the principle of data organization in MS Excel? 

3. What is a workbook? What is the difference between a workbook and 

a worksheet? 

4. What methods are available in MS Excel to automatically filling cells? 

5. Is there any difference between a formula and a function? 

6. What are Headers and Footers used for? 

7. What are the main print options in MS Excel? 
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Theme 8. Use of formulas and logical functions in MS Excel. 

Error trapping and formula auditing 
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 Introduction 

The purpose of this theme lies in a close study of main logical 

functions available in MS Office Excel spreadsheet processor. Basic types of 

data that MS Excel works with are analyzed in detail and error messages that 

appear in case of a misuse of data types in formulas are considered. Major 

formula auditing tools are used to trace precedent and dependent cells in a 

sequence of related calculations. 

Clue notions of the theme include: error values; conditions; logical 

functions; error-trapping; formula auditing; precedents; dependents. 

This theme covers the following topics: Study of data types. Basic 

operations with logical functions. Study of different ways of errors check. 

Formulas audit and dependences detection. 

As a result of the study of the material presented in this theme students 

will acquire the following competencies: 

they would master basic data types used in MS Excel; 

they would understand formula error values; 

they would learn main logical functions; 

they would study the use of IF formulas that can trap errors; 

they would master formula auditing tools. 

 

8.1. MS Excel data types. Error value indicators 

Excel normally processes data strictly depending on its type. The type 

of data, that each cell contains, has to be manually specified by the user in 

order for Excel to work correctly with it. The type of data stored in a cell is 

specified through a Format Cell dialog box (fig. 8.2). 
 

 

Fig. 8.2. Format cell dialog box 
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In the Number category of the Format Cell dialog box the user has to 

specify the type of data contained in a cell by choosing between the available 

data categories (fig. 8.3). 

 
Fig. 8.3. Basic data categories 

 

General – is used for cells that have no specific number format; 

Number – is used for general display of numbers. 

Currency – is used for general monetary values. 

Accounting – formats line up the currency symbols and decimal points 

in a column 

Date – displays date and time serial numbers as date values. Date 

formats that begin with an asterisk (*) respond to changes in regional date 

and time settings that are specified for the operating system. Formats without 

an asterisk are not affected by operating system settings. 

Time – displays date and time serial numbers as date values. Time 

formats that begin with an asterisk (*) respond to changes in regional date 

and time settings that are specified for the operating system. Formats without 

an asterisk are not affected by operating system settings. 

Percentage – multiplies the cell value by 100 and displays the result 

with a percent symbol. 

Text – it makes cells treated as text even when a number is in the cell. 

The cell is displayed exactly as entered. 

Special – is useful for tracking list and database values 

It is extremely important to correctly specify the type of data stored in a 

cell otherwise it may become the main source of errors. 
 

 If you build a legitimate formula, Excel either computes the answer 

and displays it in the current cell in the worksheet or, if unable to successfully 

calculate the answer, the program displays one of the following error values 

in the cell. 
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#NULL! appears when your formula specifies an intersection of two 

ranges that do not, in fact, intersect. 

#DIV/0! appears when your formula attempts to divide by zero. 

#VALUE! appears when your formula contains some sort of improper 

argument type or operand (such as a text entry when the operator requires a 

value). 

#REF! appears when your formula contains an improper cell reference. 

#NAME? appears when your formula contains a text reference that 

Excel doesn’t recognize (such as a reference to a range name that no longer 

exists in the workbook) 

#NUM! appears when your formula contains invalid numeric values 

(such as a text entry where a number is required) 

#N/A appears when your formula refers to a value that is not available 

to it  

The biggest problem with errors in formulas — besides how ugly such 

values as #REF! and #DIV/0! are — is that they spread like wildfire through 

the workbook to other cells containing formulas that refer to their error-laden 

cells. 

If you're dealing with a large worksheet in a really big workbook, you 

may not be able to tell which cell actually contains the formula that's causing 

all the hubbub. And if you can't apprehend the cell that is the cause of all this 

unpleasantness, you really have no way of restoring law and order to your 

workbook. 

If a formula in your worksheet contains a reference to a cell that returns 

an error value, that formula returns that error value as well. This can cause 

error values to appear throughout the worksheet, thus making it very difficult 

for you to discover which cell contains the formula that caused the original 

error value so that you can fix the problem. 

 

8.2. Logical functions and error-trapping formulas 

Excel uses the following seven logical functions, which appear on the 

Logical command button's drop-down menu on the Formulas tab of the 

Ribbon (Alt+ML). All the logical functions (except IFERROR) return either the 

logical TRUE or logical FALSE to their cells when their functions are 

evaluated. Here are the names of the functions along with their argument 

syntax: 
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AND(logical1,logical2,...) — tests whether the logical arguments are 

TRUE or FALSE. If they are all TRUE, the AND function returns TRUE to the 

cell. If any are FALSE, the AND function returns FALSE; 

FALSE() — takes no argument and simply enters logical FALSE in its 

cell; 

IF(logical_test,value_if_true,value_if_false) — tests whether the 

logical_test expression is TRUE or FALSE. If TRUE, the IF function uses the 

value_if_true argument and returns it to the cell. If FALSE, the IF function 

uses the value_if_false argument and returns it to the cell; 

IFERROR(value,value_if_error) — tests whether the value expression 

is an error. IFERROR returns value_if_error if the expression is an error, or 

value of the expression if it is not an error; 

NOT(logical) — tests whether the logical argument is TRUE or FALSE. 

If TRUE, the NOT function returns FALSE to the cell. IF FALSE, the NOT 

function returns TRUE to the cell; 

OR(logical1,logical2,...) — tests whether the logical arguments are 

TRUE or FALSE. If any are TRUE, the OR function returns TRUE. If all are 

FALSE, the OR function returns FALSE; 

TRUE() — takes no argument and simply enters logical TRUE in its cell. 

 

The logical_test and logical arguments that you specify for these logical 

functions usually employ the comparison operators (=, <, >, <=, >=, or <>), 

which themselves return logical TRUE or logical FALSE values. For example, 

suppose that you enter the following formula in your worksheet: 

=AND(B5=D10,C15>=5 00) 

In this formula, Excel first evaluates the first logical argument to 

determine whether the contents in cell B5 and D10 are equal to each other. If 

they are, the first comparison returns TRUE. If they are not equal to each 

other, this comparison returns FALSE. The program then evaluates the 

second logical argument to determine whether the content of cell C15 is 

greater than or equal to 500. If it is, the second comparison returns TRUE. If it 

is not greater than or equal to 500, this comparison returns FALSE. 

After evaluating the comparisons in the two logical arguments, the AND 

function compares the results: If logical argument 1 and logical argument 2 

are both found to be TRUE, then the AND function returns logical TRUE to 

the cell. If, however, either argument is found to be FALSE, then the AND 

function returns false to the cell. 
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When you use the IF function, you specify what's called a logical-test 

argument whose outcome determines whether the value_true or value_false 

argument is evaluated and returned to the cell. The logical-test argument 

normally uses comparison operators, which return either the logical TRUE or 

logical FALSE value. When the argument returns TRUE, the entry or 

expression in the value_true argument is used and returned to the cell. When 

the argument returns FALSE, the entry or expression in the value_ false 

argument is used. 

Consider the following formula that uses the IF function to determine 

whether to charge tax on an item (fig. 8.4): =IF(E5="Yes", D5+D5*7.5%, D5) 

If cell E5 (the first cell in the column where you indicate whether the 

item being sold is taxable or not) contains "Yes," the IF function uses the 

value_true argument that tells Excel to add the extended price entered in cell 

D5, multiply it by a tax rate of 7.5%, and then add the computed tax to the 

extended price. If, however, cell D5 is blank or contains anything other than 

the text "Yes," then the IF function uses the value_false argument, which tells 

Excel to just return the extended price to cell D5 without adding any tax to it. 
 

 
Fig. 8.4. Use of the IF function to check a condition and perform a 

calculation 
 

As you can see, the value_true and value_false arguments of the IF 

function can contain constants or expressions whose results are returned to 

the cell that holds the IF formula. 

Error-Trapping Formulas. Sometimes, you know ahead of time that 

certain error values are unavoidable in a worksheet as long as it's missing 

certain data. The most common error value that gets you into this kind of 

trouble is the #DIV/0! error value. Suppose, for example, that you're creating 

a new sales workbook from your sales template, and one of the rows in this 

template contains formulas that calculate the percentage that each monthly 

total is of the quarterly total. To work correctly, the formulas must divide the 
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value in the cell that contains the monthly total by the value in the cell that 

contains the quarterly total. When you start a new sales workbook from its 

template, the cells that contain the formulas for determining the quarterly 

totals contain zeros, and these zeros put #DIV/0! errors in the cells with 

formulas that calculate the monthly/quarterly percentages. 

These particular #DIV/0! error values in the new workbook don't really 

represent mistakes as such because they automatically disappear as soon as 

you enter some of the monthly sales for each quarter (so that the calculated 

quarterly totals are no longer (0). 

To see how you can use the IF function in a formula that sometimes 

gives you a #DIV/0! error, consider the sample worksheet shown in Figure 

8.5. This figure shows a blank Production Schedule worksheet for storing the 

2008 production figures arranged by month and part number. Because you 

haven't yet had a chance to input any data into this table, the SUM formulas 

in the last row and column contain 0 values. Because cell K7 with the grand 

total currently also contains 0, all the percent-of-total formulas in the cell 

range B9:J9 contain #DIV/0! error values. 

The first percent-of-total formula in cell B9 contains the following: 

=B7/$K$7 

 
Fig. 8.5. Blank 2008 Production Schedule spreadsheet that’s full of 

#DIV/0! errors. 
 

Because cell K7 with the grand total contains 0, the formula returns the 

#DIV/0! error value. Now, you’ll see how to set a trap for the error in the 

logical_test argument inside an IF function. After the logical_test argument, 

you enter the value_true argument (which is 0 in this example) and the 
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value_false argument (which is the B7/$K$7). With the addition of the IF 

function, the final formula looks like this: 

=IF($K$7=0,0,B7/$K$7) 

This formula then inputs 0 into cell B9, as shown in Figure 8.6, when 

the formula actually returns the #DIV/0! error value (because cell K7 is still 

empty or has a 0 in it), and returns the percentage of total production when 

the formula doesn't return the #DIV/0! error value (because cell K7 with the 

total production divisor is no longer empty or contains any other value 

besides (0). Next, all you have to do is copy this error-trapping formula in cell 

B9 over to J9 to remove all the #DIV/0! errors from this worksheet. 

 
Fig. 8.6. 2008 Production Schedule spreadsheet after trapping all 

the #DIV/0! errors. 
 

The error-trapping formula created with the IF function in cell B9 works 

fine as long as you know that the grand total in cell K7 will contain either 0 or 

some other numerical value. It does not, however, trap any of the various 

error values, such as #REF! and #NAME?, nor does it account for the special 

#NA (Not Available) value. If, for some reason, one of the formulas feeding 

into the SUM formula in K7 returns one of these beauties, they will suddenly 

cascade throughout all the cells with the percent-of-total formulas (cell range 

B9:J9). 

To trap all error values in the grand total cell K7 and prevent them from 

spreading to the percent-to-total formulas, you need to add the ISERROR 

function to the basic IF formula. The ISERROR function returns the logical 

value TRUE if the cell specified as its argument contains any type of error 

value, including the special #N/A value (if you use ISERR instead of 

ISERROR, it checks for all types of error values except for #N/A). 

To add the ISERROR function, place it in the IF function as the 

logical_test argument. If, indeed, K7 does contain an error value or the #N/A 
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value at the time the IF function is evaluated, you specify 0 as the value_true 

argument so that Excel inputs 0 in cell B9 rather than error value or #N/A. For 

the value_false argument, you specify the original IF function that inputs 0 if 

the cell K7 contains 0; otherwise, it performs the division that computes what 

percentage the January production figure is of the total production. 

This amended formula with the ISERROR and two IF functions in cell 

B9 looks like this: 

=IF(ISERROR($K$7),0,IF($K$7=0,0,B7/$K$7)) 

As soon as you copy this original formula to the cell range C9:J9, you've 

protected all the cells with the percent-of-total formulas from displaying and 

spreading any of those ugly error values. 

Some people prefer to remove the display of zero values from any 

template that contains error-trapping formulas so that no one interprets the 

zeros as the correct value for the formula. To remove the display of zeros 

from a worksheet, deselect the Show a Zero in Cells That Have Zero Values 

check box in the Display Options for this Worksheet section of the Advanced 

tab of the Excel Options dialog box (Office Button I Excel Options or Alt+FI). 

By this action, the cells with error-trapping formulas remain blank until you 

give them the data that they need to return the correct answers. 

 

8.3. Formula auditing. Tracing precedents and dependents 

methods 

If you don't happen to trap those pesky error values before they get out 

into the spreadsheet, then you end up having to track down the original cell 

that caused all the commotion and set it right. Fortunately, Excel offers some 

very effective formula-auditing tools for tracking down the cell that's causing 

your error woes by tracing the relationships between the formulas in the cells 

of your worksheet. By tracing the relationships, you can test formulas to see 

which cells, called direct precedents in spreadsheet jargon, directly feed the 

formulas and which cells, called dependents (nondeductible, of course), 

depend on the results of the formulas. Excel even offers a way to visually 

backtrack the potential sources of an error value in the formula of a particular 

cell. 

The formula-auditing tools are found in the command buttons located in 

the Formula Auditing group on the Formulas tab of the Ribbon. These 

command buttons include the following: 
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Trace Precedents. When you click this button, Excel draws arrows to 

the cells (the so-called direct precedents) that are referred to in the formula 

inside the selected cell. When you click this button again, Excel adds "tracer" 

arrows that show the cells (the so-called indirect precedents) that are referred 

to in the formulas in the direct precedents. 

Trace Dependents. When you click this button, Excel draws arrows 

from the selected cell to the cells (the so-called direct dependents) that use, 

or depend on, the results of the formula in the selected cell. When you click 

this button again, Excel adds tracer arrows identifying the cells (the so-called 

indirect dependents) that refer to formulas found in the direct dependents. 

Remove Arrows. Clicking this button removes all the arrows drawn, no 

matter what button or pull-down command you used to put them there — click 

the drop-down button attached to this button to display a drop-down menu 

with three options: Remove Arrows to remove all arrows (just like clicking the 

Remove Arrows command button); Remove Precedent Arrows to get rid of 

the arrows that were drawn when you clicked the Trace Precedents button; 

and Remove Dependent Arrows to get rid of the arrows that were drawn 

when you clicked the Trace Dependents button. 

Show Formulas. To display all formulas in their cells in the worksheet 

instead of their calculated values (just like pressing Ctrl+V). 

Error Checking. When you click this button or click the Error Checking 

option on its drop-down menu, Excel displays the Error Checking dialog box, 

which describes the nature of the error in the current cell, gives you help on it, 

and enables you to trace its precedents. Click the Trace Error option on this 

button's drop-down menu to attempt to locate the cell that contains the 

original formula that has an error.  

Evaluate Formula. Clicking this button opens the Evaluate Formula 

dialog box, where you can have Excel evaluate each part of the formula in the 

current cell. The Evaluate Formula feature can be quite useful in formulas 

that nest many functions within them. 

If these cells are on the same worksheet, Excel draws solid red or blue 

arrows extending from each of the precedent cells to the active cell and from 

the active cell to the dependent cells. If the cells are not located locally on the 

same worksheet (they may be on another sheet in the same workbook or 

even on a sheet in a different workbook), Excel draws a black dotted arrow. 

This arrow comes from or goes to an icon picturing a miniature worksheet 
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that sits to one side, with the direction of the arrowheads indicating whether 

the cells on the other sheet feed the active formula or are fed by it. 

You can click the Trace Precedents command button on the Formulas 

tab of the Ribbon or press Alt+MP to trace all the generations of cells that 

contribute to the formula in the selected cell (kind of tracing all the ancestors 

in your family tree). 

Figures 8.7 and 8.8 illustrate how you can use the Trace Precedents 

command button or its hot key equivalent to quickly locate the cells that 

contribute, directly and indirectly, to the simple addition formula in cell B9. 
 

 
Fig. 8.7. Trace Precedents command button clicked one time 

 

Figure 7 shows the worksheet after the Trace Precedents command 

button was clicked the first time. 

As you can see, Excel draws trace arrows from cells A5 and C5 to 

indicate that they are the direct precedents of the addition formula in cell B9. 

In Figure 7/8, you see what happened when this command button was clicked 

a second time to display the indirect precedents of this formula (think of them 

as being a generation earlier in the family tree).  

The new tracer arrows show that cells A2, A3, and A4 are the direct 

precedents of the formula in cell A5 — indicated by a border around the three 

cells. (Remember that cell A5 is the first direct precedent of the formula in cell 

B9.) 

Likewise, cells B2 and B3 as well as cell C4 are the direct precedents of 

the formula in cell C5. (Cell C5 is the second direct precedent of the formula 

in cell B9.) 

Each time you click the Trace Precedents command button, Excel 

displays another (earlier) set of precedents (until no more generations exist). 
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Fig. 8.8. Trace Precedents command button clicked two times 

 

If you are in a hurry (as most of us are most of the time), you can speed 

up the process and display both the direct and indirect precedents in one 

operation by double-clicking the Trace Precedents command button. To clear 

the worksheet of tracer arrows, click the Remove Arrows command button on 

the Formulas tab. 

Figure 8.9 shows what happened after the Trace Precedents command 

button was clicked (after clicking it twice before, as shown in Figures 7 and 

8). 

Clicking the command button reveals both the indirect precedents for 

cell C5. The formulas in cells C2 and C3 are the direct precedents of the 

formula in cell C5. The direct precedent of the formula in cell C2 (and, 

consequently, the indirect precedent of the one in cell C5) is not located on 

this worksheet. This fact is indicated by the dotted tracer arrow coming from 

that cute miniature worksheet icon sitting on top of cell A3. 

 
Fig. 8.9. Precedent located on another worksheet 

 

To find out exactly which workbook, worksheet, and cell(s) hold the 

direct precedents of cell C2, double-click somewhere on the dotted arrow. 

Double-clicking the dotted tracer arrow opens the Go To dialog box, which 

shows a list of all the precedents (including the workbook, worksheet, and cell 

references). To go to a precedent on another worksheet, double-click the 

reference in the Go To list box, or select it and click OK. (If the worksheet is in 
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another workbook, this workbook file must already be open before you can go 

to it.) (fig. 8.10). 

 
Fig. 8.10. The Go To option 

 

The Go To dialog box, shown in Figure 10, displays the following direct 

precedent of cell C2, which is cell B4 on Sheet2 of the same workbook: 

'[Error Tracer.xls]Sheet2'!$B$4 

To jump directly to this cell, double-click the cell reference in the Go To 

dialog box. You can also select precedent cells that are on the same 

worksheet as the active cell by double-clicking somewhere on the cell's tracer 

arrow. Excel selects the precedent cell without bothering to open up the Go 

To dialog box. 

You can use the Special button in the Go To dialog box (refer to Figure 

10) to select all the direct or indirect precedents or the direct or indirect 

dependents that are on the same sheet as the formula in the selected cell. 

After opening the Go To dialog box (Ctrl+G or F5) and clicking the Special 

button, you simply click the Precedents or Dependents option button and then 

choose between the Direct Only or All Levels option button before you click 

OK. 

You can also click the Trace Dependents command button in the 

Formula Auditing group of the Formulas tab on the Ribbon or press Alt+MD 

to trace all the generations of cells that either directly or indirectly utilize the 

formula in the selected cell (kind of like tracing the genealogy of all your 

progeny). Tracing dependents with the Trace Dependents command button is 

much like tracing precedents with the Trace Precedents command button. 

Each time you click this button, Excel draws another set of arrows that show 

a generation of dependents further removed. To display both the direct and 

indirect dependents of a cell in one fell swoop, double-click the Trace 

Dependents command button (fig. 8.11). 
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Fig. 8.11. Trace Dependents command 

 

Figure 8.11 shows what happened after cell B9 was selected and then 

double-clicked the Trace Dependents command button on the Formulas tab 

of the Ribbon to display both the direct and indirect dependents and then was 

clicked a third time to display the dependents on another worksheet. 

As this figure shows, Excel first draws tracer arrows from cell B9 to cells 

C12 and C13, indicating that C12 and C13 are the direct dependents of cell 

B9. Then, it draws tracer arrows from cells C12 and C13 to E12 and E13, 

respectively, the direct dependents of C12 and C13 and the indirect 

dependents of B9. Finally, it draws a tracer arrow from cell E12 to another 

sheet in the workbook (indicated by the dotted tracer arrow pointing to the 

worksheet icon). 

 

 

 Questions 

 

1. What are the main data types used by MS Excel? 

2. What are the general reasons for errors in the process of 

calculations? 

3. What are the common error messages? 

4. For what purpose are logical functions used? 

5. What logical functions can check several conditions? 

6. What is the purpose of performing formula auditing operations? 

7. What is the difference between tracing precedents and dependents 

methods? 
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Theme 9. Use of date and time functions in MS Excel. Financial 

formulas and depreciation of assets 
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 Introduction 

The purpose of this theme lies in a close study of date and time 

functions available in MS Office Excel and functions that are used to track 

financial assets. Basic operations with date and time values are given a 

thorough consideration both with the calculation of the value of financial 

assets. Capital assets depreciation methods are analyzed together with the 

MS Excel functions used to support the overall process. 

Clue notions of the theme include: date and time values; future value; 

present value; incoming cash-flows; outgoing cash-flows; net present value; 

payments; depreciation methods. 

This theme covers the following topics: Basic operations with date and 

time functions. Study of formulas that calculate elapsed dates and times. 

Basic operations with financial functions. Study of formulas that calculate 

investment and depreciation of assets. 

As a result of the study of the material presented in this theme students 

will acquire the following competencies: 

they would understand dates and times in Excel; 

they would learn how to use date and time functions; 

they would learn how Excel rounds up values; 

they would master basic investment functions; 

they would study basic depreciation functions. 

 

9.1. Understanding dates and times in MS Excel 

Excel doesn't treat the dates and times that you enter in the cells of 

your worksheet as simple text entries. Any entry with a format that resembles 

one of the date and time number formats utilized by Excel is automatically 

converted, behind the scenes, into a serial number. 

In the case of dates, this serial number represents the number of days 

that have elapsed since the beginning of the twentieth century so that 

January 1, 1900, is serial number 1; January 2, 1900, is serial number 2; and 

so forth. 

In the case of times, this serial number is a fraction that represents 

the number of hours, minutes, and seconds that have elapsed since 

midnight, which is serial number 0.00000000, so that 12:00:00 p.m. (noon) is 

serial number 0.50000000; 11:00:00 p.m. is 0.95833333; and so forth. 

As long as you format a numeric entry so that it conforms to a 

recognized date or time format, Excel enters it as a date or time serial 
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number. Only when you enter a formatted date or time as a text entry (by 

prefacing it with an apostrophe) or import dates and times as text entries into 

a worksheet do you have to worry about converting them into date and time 

serial numbers, which enables you to build spreadsheet formulas that 

perform calculations on them. 

 

9.2. Building formulas that calculate elapsed dates and times. 

Using Date Functions 

Most of the date formulas that you build are designed to calculate the 

number of days or years that have elapsed between two dates. To do this, 

you build a simple formula that subtracts the later date from the earlier date. 

For example, if you input the date 4/25/75 in cell B11 and 6/3/04 in cell C11 

and you want to calculate the number of days that have elapsed between 

April 25, 1975, and June 3, 2004, in cell D11, you would enter the following 

subtraction formula in that cell: =C11-B11 

Excel then inputs the number of days between these dates in cell D5. 

The only problem is that the program will also apply the Date format used by 

these two dates so that the result in cell D5 appears as the date: 2/8/1929. 

To display this result as a whole number, as you'd expect, you still have 

to format the result with another number format. If, for example, you apply the 

General number format to the cell D5 (you can do this quickly by pressing 

Ctrl+Shift+` or Ctrl+~), the calculated result in this cell becomes the much 

more sensible number of days: 10632. 

If you want the result between two dates expressed in the number of 

years rather than the number of days, divide the result of your subtraction by 

the number of days in a year. In this example, you can enter the formula 

=D11/365 in cell Ell to return the result 29.12877, which you can then round 

off to 29 by clicking the Decrease Decimal button in the Number group on 

the Home tab of the Ribbon or by pressing Alt+H9 until only 29 remains dis-

played in the cell. 

Some spreadsheets require that formulas calculate the amount of 

elapsed time between a starting and ending time. To build a formula that 

calculates how much time has elapsed between two different times of the 

day, subtract the ending time of day from the starting time of day. For 

example, suppose that you enter a person's starting time in cell B14 and 

ending time in CI4. In cell D14, you would enter the following subtraction 

formula: =C14-B14. 



 117 

Excel then returns the difference in cell D14 as a decimal value 

representing what fraction that difference represents of an entire day (that is, 

a 24-hour period). If, for example, cell B14 contains a starting time of 9:15 

a.m. and cell C14 contains an ending time of 3:45 p.m., Excel returns the 

following decimal value to cell D14: 6:30   AM. 

To convert this time of day into its equivalent decimal number, you 

convert the time format automatically given to it to the General format 

(Ctrl+Shift+` or Ctrl+~), which displays the following result in cell D14: 

0.270833. 

To convert this decimal number representing the fraction of an entire 

day into the number of hours that have elapsed, you simply multiply this 

result by 24 as in =D14*24, which gives you a result of 6.5 hours when you 

apply the General format (Ctrl+Shift+` or Ctrl+~) to it. 

Using Date Functions. Excel contains a number of built-in date 

functions that you can use in your spreadsheets.  

The easiest date function has to be TODAY. This function takes no 

arguments and is always entered as follows: =TODAY() 

When you enter the TODAY function in a cell by clicking it on the Date 

& Time command button's drop-down list on the Ribbon's Formulas tab or 

by typing it, Excel returns the current date by using the following Date format: 

7/23/2008 

Keep in mind that the date inserted into a cell with the TODAY function 

is not static. Whenever you open a worksheet that contains this function, 

Excel recalculates the function and updates its contents to the current date. 

This means that you don't usually use TODAY to input the current date when 

you're doing it for historical purposes (an invoice, for example) and never 

want it to change. 

The DATE function on the Date & Time command button's drop-down 

menu returns a date serial number for the date specified by the year, month, 

and day argument. This function uses the following syntax: DATE (year, 

month, day) (fig. 9.2). 

This function comes in handy when you have a worksheet that contains 

the different parts of the date in separate columns, similar to the one shown 

in Figure 1. You can use it to combine the three columns of date information 

into a single date cell that you can use in sorting and filtering. 

The DATEVALUE function on the Date & Time button's drop-down 

menu returns the date serial number for a date that's been entered into the 



 118 

spreadsheet as text so that you can use it in date calculations. This function 

takes a single argument: DATEVALUE (date_text). 

 
Fig. 9.2.  Using the DATE function to combine separate date infor-

mation into a single entry 
 

The DAY, WEEKDAY and MONTH date functions on the Date & Time 

command button's drop-down menu all return just parts of the date serial 

number that you specify as their argument: 

DAY(serial_number or date) to return the day of the month in the date 

(as a number between 1 and 31); 

WEEKDAY(serial_number or date,[return_type]) to return the day of the 

week (as a number between 1 and 7 or 0 and 6). The optional return_type 

argument is a number between 1 and 3; 1 (or no return_type argument) 

specifies the first type where 1 equals Sunday and 7 equals Saturday; 2 

specifies the second type where 1 equals Monday and 7 equals Sunday; and 

3 specifies the third type where 0 equals Monday and 6 equals Sunday; 

MONTH(serial_number or date to return the number of the month in the 

date serial number (from 1 to 12). 

For example, if you enter the following DAY function in a cell as follows: 

DAY(DATE (08,4,15) ) or just DAY(E4), where E4 contains date, Excel 

returns the value 15 to that cell. If, instead, you use the WEEKDAY function 

as follows: WEEKDAY(DATE(08,4,15)), Excel returns the value 4, which 

represents Wednesday (using the first return_type where Sunday is 1 and 

Saturday is 7) because the optional return_type argument isn't specified. If 

you use the MONTH function on this date as in the following: MONTH(DATE 

(08 ,4, 15), Excel returns 4 to the cell. Don't use these functions on dates 

entered as text entries. Always use the DATE/VALUE function to convert 

these text dates and then use the DAY, WEEKDAY, MONTH functions on the 

serial numbers returned by the DATE/VALUE function to ensure accurate 

results. 
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9.3. Operations with financial functions 

The key to using any of Excel's financial functions is to understand the 

terminology used by their arguments. Many of the most common financial 

functions, such as PV (Present Value), NPV (Net Present Value), FV (Future 

Value), and PMT (Payment), take similar arguments: 

PV (present value of an investment) is the present value that is the 

principal amount of the annuity; 

FV (future value of an investment) is the future value that represents 

the principal plus interest on the annuity; 

PMT (payment for a loan) is the payment made each period in the 

annuity. Normally, the payment is set over the life of the annuity and includes 

principal plus interest without any other fees; 

RATE is the interest rate per period. Normally, the rate is expressed as 

an annual percentage; 

NPER (number of periods for an investment) is the total number of 

payment periods in the life of the annuity. You calculate this number by taking 

the Term (the amount of time that interest is paid) and multiplying it by the 

Period (the point in time when interest is paid or earned) so that a loan with a 

three-year term with 12 monthly interest payments has 3 x 12, or 36 payment 

periods. 

When using financial functions, keep in mind that the fv, pv, and pmt 

arguments can be positive or negative, depending on whether you're 

receiving the money (as in the case of an investment) or paying out the 

money (as in the case of a loan). Also keep in mind that you have to express 

the rate argument in the same units as the nper argument, so that if you 

make monthly payments on a loan and you express the nper as the total 

number of monthly payments, as in 360 (30 x 12) for a 30-year mortgage, 

you need to express the annual interest rate in monthly terms as well. For 

example, if you pay an annual interest rate of 7.5 percent on the loan, you 

express the rate argument as 0.075/12 so that it is monthly as well. 

 

The NPV, PV and FV functions 

 Net present value is an economic standard method for evaluating 

competing long-term projects. It is defined as the total present value (PV) of a 

time series of cash flows. It is a standard method for using the time value of 

money to appraise long-term projects. 
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Each cash inflow/outflow is discounted back to its present value (PV). 

Then they are summed. Therefore NPV is the sum of all terms (9.1): 

 (9.1), where 

t - the time of the cash flow; 

i - the discount rate (the rate of return that could be earned on an 

investment in the financial markets with similar risk; 

Rt - the net cash flow (the amount of cash, inflow minus outflow) at time 

t (for educational purposes, R0 is commonly placed to the left of the sum to 

emphasize its role as (minus the) investment).  

 The discount rate is the rate used to discount future cash flows to 

their present values is a key variable of this process. 

A widespread approach to choosing the discount rate factor is to decide 

the rate which the capital needed for the project could return if invested in an 

alternative venture. If, for example, the capital required for Project A can earn 

five percent elsewhere, use this discount rate in the NPV calculation to allow 

a direct comparison to be made between Project A and the alternative. 

NPV is an indicator of how much value an investment or project adds to 

the firm. With a particular project, if Ct is a positive value, the project is in the 

status of discounted cash inflow in the time of t. If Ct is a negative value, the 

project is in the status of discounted cash outflow in the time of t. 

Appropriately risked projects with a positive NPV could be accepted. 

In financial theory, if there is a choice between two mutually exclusive 

alternatives, the one yielding the higher NPV should be selected. The 

following sums up the NPVs in various situations (table 9.1). 

Table 9.1 

NPV value ranges 

If... It means... Then... 

NPV > 0 
the investment would add value to 

the firm 
the project may be accepted 

NPV < 0 
the investment would subtract value 

from the firm 
the project should be rejected 

NPV = 0 
the investment would neither gain 

nor lose value for the firm 

Decision should be based on 

other criteria, e.g. strategic 

positioning or other factors. 

http://en.wikipedia.org/wiki/Discount
http://en.wikipedia.org/wiki/Discount_rate
http://en.wikipedia.org/wiki/Rate_of_return
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Example. A corporation must decide whether to introduce a new 

product line. The new product will have startup costs, operational costs, and 

incoming cash flows over six years. This project will have an immediate (t=0) 

cash outflow of $100,000 (which might include machinery, and employee 

training costs). Other cash outflows for years 1 – 6 are expected to be $5,000 

per year. Cash inflows are expected to be $30,000 each for years 1 – 6. All 

cash flows are after-tax, and there are no cash flows expected after year 6. 

The required rate of return is 10%. The present value (PV) can be calculated 

for each year: 

Year Cashflow Present Value 

T=0 
 

-$100,000 

T=1 
 

$22,727 

T=2 
 

$20,661 

T=3 
 

$18,783 

T=4 
 

$17,075 

T=5 
 

$15,523 

T=6 
 

$14,112 

 

The sum of all these present values is the net present value, which 

equals $8,881.52. Since the NPV is greater than zero, it would be better to 

invest in the project than to do nothing, and the corporation should invest in 

this project if there is no alternative with a higher NPV. 

The PV (Present Value), NPV (Net Present Value), and FV (Future 

Value) functions all found on the Financial button's drop-down menu on the 

Ribbon's Formulas tab (Alt+MI) enable you to determine the profitability of 

an investment. 

The PV, or Present Value, function returns the present value of an 

investment, which is the total amount that a series of future payments is 

http://en.wikipedia.org/wiki/Required_rate_of_return
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worth presently. The syntax of the PV function is as follows: 

=PV(rate,nper,pmt,[fv],[type]) 

The fv and type arguments are optional arguments in the function (indi-

cated by the square brackets). The fv argument is the future value or cash 

balance that you want to have after making your last payment. If you omit the 

fv argument, Excel assumes a future value of zero (0). The type argument 

indicates whether the payment is made at the beginning or end of the period: 

Enter 0 (or omit the type argument) when the payment is made at the end of 

the period and use 1 when it is made at the beginning of the period. 

Figure 9.3 contains several examples using the PV function. All three 

PV functions use the same annual percentage rate of 7.25 percent and term 

of 10 years. Because payments are made monthly, each function converts 

these annual figures into monthly ones. 

For example, in the PV function in cell E3, the annual interest rate in 

cell A3 is converted into a monthly rate by dividing by 12 (A3/12) and the 

annual term in cell B3 is converted into equivalent monthly periods by 

multiplying by 12 (B3 x 12). 

 
Fig. 9.3. Using the PV function to calculate the present value of 

various investments 
 

Note that although the PV functions in cells E3 and E5 use the rate, 

nper, and pmt ($218.46) arguments, their results are slightly different. This is 

caused by the difference in the type argument in the two functions: the PV 

function in cell E3 assumes that each payment is made at the end of the 

period (the type argument is 0 whenever it is omitted), while the PV function 

in cell E5 assumes that each payment is made at the beginning of the period 

(indicated by a type argument of 1).When the payment is made at the begin-

ning of the period, the present value of this investment is $0.49 higher than 

when the payment is made at the end of the period, reflecting the interest 

accrued during the last period. 
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The third example in cell E7 (shown in fig. 9.3) uses the PV function 

with an fv argument instead of the pmt argument. In this example, the PV 

function states that you would have to make monthly payments of $3,883.06 

for a 10-year period to realize a cash balance of $8,000, assuming that the 

investment returned a constant annual interest rate of 71/4 percent. Note that 

when you use the PV function with the fv argument instead of the pmt 

argument, you must still indicate the position of the pmt argument in the 

function with a comma (thus the two commas in a row in the function) so that 

Excel doesn't mistake your fv argument for the pmt argument. 

The NPV function calculates the net present value based on a series of 

cash flows. The syntax of this function is: =NPV(rate,valuel,[value2],[...]), 

where value 1, value 2, and so on are between 1 and 13 value arguments 

representing a series of payments (negative values) and income (positive 

values), each of which is equally spaced in time and occurs at the end of the 

period. The NPV investment begins one period before the period of the va-

lue 1 cash flow and ends with the last cash flow in the argument list. If your 

first cash flow occurs at the beginning of the period, you must add it to the 

result of the NPV function rather than include it as one of the arguments. 

Figure 9.4 illustrates the use of the NPV function to evaluate the 

attractiveness of a five-year investment that requires an initial investment of 

$30,000 (the value in cell G3). The first year, you expect a loss of $22,000 

(cell B3); the second year, a profit of $15,000 (cell C3); the third year, a profit 

of $25,000 (cell D3); the fourth year, a profit of $32,000 (cell E3); and the fifth 

year, a profit of $38,000 (cell F3). Note that these cell references are used as 

the value arguments of the NPV function. 

 
Fig. 9.4. Using the NPV function to calculate the net present value 

of an investment. 
 

Unlike when using the PV function, the NPV function doesn't require an 

even stream of cash flows. The rate argument in the function is set at 8 

percent. In this example, this represents the discount rate of the investment; 

that is, the interest rate that you may expect to get during the five-year period 

if you put your money into some other type of investment, such as a high-
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yield money-market account. This NPV function in cell A3 returns a net 

present value of $31,718.63, indicating that you can expect to realize about 

$1,719 more from investing your $30,000 in this investment than you would 

from investing the money in a money-market account at an interest rate of 8 

percent. 

The FV, Future value, function calculates the future value of an 

investment. The syntax of this function is: =FV(rate,nper,pmt, [pv] , [type] ). 

The rate, nper, pmt, and type arguments are the same as those used 

by the PV function. The pv argument is the present value or lump-sum 

amount for which you want to calculate the future value. As with the fv and 

type arguments in the PV function, both the pv and type arguments are 

optional in the FV function. If you omit these arguments, Excel assumes their 

values to be zero (0) in the function. 

You can use the FV function to calculate the future value of an 

investment, such as an IRA (Individual Retirement Account). For example, 

suppose that you establish an IRA at age 43 and will retire 22 years hence at 

age 65 and that you plan to make annual payments into the IRA at the 

beginning of each year. If you assume a rate of return of 8.5 percent a year, 

you would enter the following FV function in your worksheet: =FV(8.5%,22,-

1000, ,1). 

Excel then indicates that you can expect a future value of $64,053.66 

for your IRA when you retire at age 65. If you had established the IRA a year 

prior and the account already has a present value of $1,085, you would 

amend the FV function as follows: =FV(8.5%,22,-1000,-1085,1). 

In this case, Excel indicates that you can expect a future value of 

$70,583.22 for your IRA at retirement. 

The PMT function. The PMT function calculates the periodic payment 

for an annuity, assuming a stream of equal payments and a constant rate of 

interest. It’s situated on the Financial button's drop-down menu on the 

Formulas tab of the Ribbon. The PMT function uses the following syntax: 

=PMT(rate,nper,pv,[fv],[type]). 

As with the other common financial functions, rate is the interest rate 

per period, nper is the number of periods, pv is the present value or the 

amount the future payments are worth presently, fv is the future value or 

cash balance that you want after the last payment is made.  

Excel assumes a future value of zero when you omit this optional 

argument as you would when calculating loan payments, and type is the 
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value 0 for payments made at the end of the period or the value 1 for 

payments made at the beginning of the period (if you omit the optional type 

argument, Excel assumes that the payment is made at the end of the 

period). 

The PMT function is often used to calculate the payment for mortgage 

loans that have a fixed rate of interest. Figure 9.5 shows you a sample 

worksheet that contains a table using the PMT function to calculate loan 

payments for a range of interest rates (from 5 percent to 6.75 percent) and 

principals ($350,000 to $359,000). 

 

Fig. 9.5. Loan Payments table using the PMT function to calculate 

various loan payments. 
 

The table uses the initial principal that you enter in cell B2, copies it to 

cell A7, and then increases it by $1,000 in the range A8:A16. The table uses 

the initial interest rate that you enter in cell B3, copies to cell B6, and then 

increases this initial rate by 1/4 of a percent in the range C6:G6. The term in 

years in cell B4 is a constant factor that is used in the entire loan payment 

table. 

 

9.4. Capital assets amortization. Depreciation functions in Excel 

 In economics and accounting, depreciation is seen as the change in 

the market value of capital over a given period of time.It is calculated as the 

market price of the capital at the beginning of the period minus its market 

price at the end of the period. The similar concept for intangible assets is 

called amortization. 

For natural resources like minerals and oil the similar concept is called 

depletion. 



 126 

Excel lets you choose from four different Depreciation functions, 

each of which uses a slightly different method for depreciating an asset over 

time. These built-in Depreciation functions found on the Financial button's 

dropdown menu on the Formulas tab of the Ribbon include the following: 

SLN (cost,salvage,life) to calculate straight-line depreciation. This 

function returns the straight-line depreciation of an asset for one period. It’s 

the simplest and most often used technique, in which the company estimates 

the "salvage value" of the asset after the length of time over which it is 

depreciated, and assumes the drop in the asset's value is spread evenly in 

equal, yearly increments over that amount of time. The salvage value is an 

estimate of the value of the asset at the time it will be sold or disposed of; 

SYD (cost, salvage, life, per) to calculate sum-of-years’ digits 

depreciation of an asset for a specified period. It`s an accelerated schedule 

that adds up the digits for the remaining years of the useful life. An asset 

with three years of remaining useful life would add up 3 + 2 + 1 =6. The 

depreciation schedule is then 3/6th for the first year, 2/6th for the second and 

1/6th for the 3rd year, assuming no remaining value; 

DB (cost,salvage,life,period,[month]) to calculate declining balance 

depreciation. This function returns the depreciation of an asset for a 

specified period using the fixed-declining balance method; 

DDB (cost,salvage,life,period,[factor]) to calculate double-declining bal-

ance depreciation. This function returns the depreciation of an asset for a 

specified period using the double-declining balance method or some other 

method you specify. 

As you can see, with the exception of the optional month argument in 

the DB function and the optional factor argument in the DDB function, all the 

Depreciation functions require the cost, salvage, and life arguments, and all 

but the SLN function require a period argument as well: 

Cost is the initial cost of the asset that you're depreciating; 

Salvage is the value of the asset at the end of the depreciation (also 

known as the salvage value of the asset); 

Life is the number of periods over which the asset is depreciating (also 

known as the useful life of the asset); 

Per or Period is the period over which the asset is being depreciated. 

The units that you use in the period argument must be the same as those 

used in the life argument of the Depreciation function so that if you express 
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the life argument in years, you must also express the period argument in 

years. 

Note that the DB function accepts an optional month argument. This 

argument is the number of months that the asset is in use in the first year. If 

you omit the month argument from your DB function, Excel assumes the 

number of months of service to be 12. 

When using the DDB function to calculate the double-declining balance 

method of depreciation, you can add an optional factor argument. This argu-

ment is the rate at which the balance declines in the depreciation schedule. 

If you omit this optional factor argument, Excel assumes the rate to be 2 

(thus, the name double-declining balance). 

Figure 6 contains a Depreciation table that uses all four depreciation 

methods to calculate the depreciation of office furniture originally costing 

$50,000 to be depreciated over a 10-year period, assuming a salvage value 

of $1,000 at the end of this depreciation period. 

The Formula bar shown in Figure 9.6 shows the SLN formula that is 

entered into cell B9: =B8-SLN($B$3,$B$5,$B$4). 

 
Fig. 9.6. Depreciation Table showing 10-year depreciation of an 

asset using various methods. 
 

This formula subtracts the amount of straight-line depreciation to be 

taken in the first year of service from the original cost of $50,000 (this value 

is brought forward from cell B3 by the formula =B3). After creating this 

original formula in cell B9, then the Fill handle was used to copy it down to 

cell B18, which contains the final salvage value of the asset in the 10th year 

of service. 
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Cell C9 contains a similar formula for calculating the sum-of-years-

digits depreciation for the office furniture. This cell contains the following 

formula: =C8-SYD($B$3,$B$5,$B$4,$A9). 

This formula subtracts the amount of sum-of-years-digits depreciation 

to be taken at the end of the first year from the original cost of $50,000 in cell 

C8 (also brought forward from cell B3 by the formula =B3). 

After creating this original formula in cell C9, again Fill handle was 

used the to copy it down to cell C18, which also contains the final salvage 

value of the asset in the 10th year of service. 

The same basic procedure was used to create the formulas using the 

DB and DDB depreciation methods in the cell ranges D8:D18 and E8:E18, 

respectively. 

Note that, like the SYD function, both of these depreciation functions 

require the use of a period argument, which is supplied by the list of years in 

the cell range A9:A18. 

Note also, that the values in cell B4, which supplies the life argument to 

the SYD, DB, and DDB functions, matches the year units used in this cell 

range. 

 

 

 Questions 

 

1. How does MS Excel interpret date and time values? 

2. What are main date functions? 

3. Which date function is responsible for filling-in the current date? 

4. For what purpose PV and FV functions are used? 

5. What economic method is supported by NPV function? 

6. What is depreciation of assets? What functions are used to calculate 

depreciation? 

7. What is the difference between straight-line depreciation method and 

other depreciation methods? 
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Theme 10. Use of MS Excel as a database management 

software. Data look-up and retrieval methods 
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Fig. 10.1. System elements of the theme 
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 Introduction 

The purpose of this theme lies in a close study of main features of MS 

Office Excel as a database management software. Basic operations on data 

look-up and retrieval are considered together with the functions that support 

these processes. Data filtering and sorting procedures are given a thorough 

consideration both from the conceptual and technological points of view. 

Clue notions of the theme include: database; data entries; vertical 

look-up; horizontal look-up; two-way look-up; sorting; filtering. 

This theme covers the following topics: Study of database basics. 

Basic operations with look-up and retrieval of information. Study of two-way 

look-up cases. Operations concerned with sorting and filtering of information. 

As a result of the study of the material presented in this theme students 

will acquire the following competencies: 

they would learn basic characteristics of databases in MS Excel; 

they would study requirements for database creation and use; 

they would learn main look-up functions in MS Excel; 

they would study the use of sorting and filtering tools in MS Excel. 

 

10.1. Using Microsoft Excel as a database 

MS Excel is a spreadsheet program. It is in fact the application of 

choice for the majority of businesses globally. Excel has therefore been 

primarily used for developing departmental budgets, expense reports and a 

host of other accounting or financial deliverables. What some users of MS 

Excel do not know is that the software possesses excellent database tools 

built right into it. 

Though MS Excel isn’t a specialized database software, still many 

people use MS Excel as a database. Excel can be a convenient way to store 

information as a database as long as the information is not too cumbersome 

to be contained in a spreadsheet format. Because Microsoft Office comes 

with Excel, using Excel as a database is less expensive than purchasing 

additional software to house a database. 

 A database consists of an organized collection of data for one or 

more uses, typically in digital form. 

One way of classifying databases involves the type of their contents, for 

example: bibliographic, document-text, statistical. Digital databases are 

managed using database management systems, which store database 
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contents, allowing data creation and maintenance, and search and other 

access. 

In order to take full advantage of MS Excel’s database features it is 

important to structure you data properly. For professional looking databases 

spreadsheets always use consistent formatting, e.g., using the same formats 

for the column labels and row containers. Here some recommendations on 

how to set up an excel spreadsheet as a database: 

identify the data you want to include in the database. Before you can 

set up a spreadsheet as a database, you need to know what information you 

will be tracking; 

use Row 1 as headings for each item that you plan to track. For 

example, if you plan to use Excel as a database for contact information, you 

would include name, address, cell number and other headings across Row 1; 

format Row 1. Change the formatting of Row 1 to separate the 

headings from the data in your database. To do this, click the number one 

next to Row 1, which highlights the entire row. Add your formatting, such as 

bold, center and a gray background; 

freeze the heading row. Use the freeze pane feature so that your 

headings will always appear at the top of the database. For that click on the 

number two next to Row 2 to highlight the first row under the headings. Click 

the View tab. Click Freeze Panes and then Freeze Top Row; 

type in the data. Use one row for each database entry, keying in the 

information to match the heading information; 

sort the data in the database. After you enter the information into the 

database, you can view the data in a variety of ways. 

Most common operations on data in excel databases are look-up, 

sorting and filtering of information. 

 

10.2. Basic Lookup functions: VLOOKUP and HLOOKUP 

In some cases it may become necessary to look for and retrieve some 

data entries from a database. MS Excel has built-in look-up functions to 

perform this task. 

The lookup functions are located on the Lookup & Reference 

command button's drop-down list (Alt+MO) on the Ribbon's Formulas tab. 

Excel makes it easy to perform table lookups that either return information 

about entries in the table or actually return related data to other data lists in 

the spreadsheet. By using Lookup tables to input information into a data list, 
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you not only reduce the amount of data input that you have to do, but also 

eliminate the possibility of data entry errors. Using Lookup tables also makes 

it a snap to update your data lists: All you have to do is make the edits to the 

entries in the original Lookup table or schedule to have all their data entries in 

the list updated as well. 

The most popular of the lookup functions are HLOOKUP (for Horizontal 

Lookup) and VLOOKUP (for Vertical Lookup) functions. These functions are 

located in the Lookup & Reference category in the Insert Function dialog box. 

They are part of a powerful group of functions that can return values by 

looking them up in data tables. 

The VLOOKUP function searches vertically (top to bottom) the leftmost 

column of a Lookup table until the program locates a value that matches or 

exceeds the one you are looking up. The HLOOKUP function searches hori-

zontally (left to right) the topmost row of a Lookup table until it locates a value 

that matches or exceeds the one that you're looking up. 

The VLOOKUP function uses the following syntax: 

=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

The HLOOKUP function follows the nearly identical syntax: 

=HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

 

In both functions, the lookup_value argument is the value that you want 

to look up in the Lookup table, table_array is the cell range or name of the 

Lookup table that contains both the value to look up and the related value to 

return. 

The col_index_num argument in the VLOOKUP function is the number 

of the column whose values are compared to the lookup_value argument in a 

vertical table. The row_index_num argument in the HLOOKUP function is the 

number of the row whose values are compared to the lookup_value in a 

horizontal table. 

When entering the col_index_num or row_index_num arguments in the 

VLOOKUP and HLOOKUP functions, you must enter a value greater than 

zero that does not exceed the total number of columns or rows in the Lookup 

table. 

The optional range_lookup argument in both the VLOOKUP and the 

HLOOKUP functions is the logical TRUE or FALSE that specifies whether 

you want Excel to find an exact or approximate match for the lookup_value in 

the table_array. When you specify TRUE or omit the range_lookup argument 
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in the VLOOKUP or HLOOKUP function, Excel finds an approximate match. 

When you specify FALSE as the range_lookup argument, Excel finds only 

exact matches. 

Finding approximate matches is appropriate only when you're looking 

up numeric entries (rather than text) in the first column or row of the vertical 

or horizontal Lookup table. When Excel doesn't find an exact match in this 

Lookup column or row, it locates the next highest value that doesn't exceed 

the lookup_value argument and then returns the value in the column or row 

designated by the col_ndex_num or row_index_num arguments. 

When using the VLOOKUP and HLOOKUP functions, the text or 

numeric entries in the Lookup column or row (that is, the leftmost column of a 

vertical Lookup table or the top row of a horizontal Lookup table) must be 

unique.  

Figure 10.2 shows an example of using the VLOOKUP function to 

return either a 15% or 20% tip from a tip table, depending on the pretax total 

of the check. 

 
Fig. 10.2. Using the VLOOKUP function to return the amount of the 

tip to add from a Lookup table 
 

Cell F5 contains the VLOOKUP function:  

=VLOOKUP(Pretax_Total, Tip_Table, IF(Tip_Percentage=0.15,2,3)). 

This formula returns the amount of the tip based on the tip percentage 

in cell F3 and the pretax amount of the check in cell F4. 

To use this tip table, enter the percentage of the tip (15% or 20%) in cell 

F1 (named Tip_Percentage) and the amount of the check before tax in cell F2 

(named Pretax_Total). Excel then looks up the value that you enter in the 
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Pretax_Total cell in the first column of the Lookup table, which includes the 

cell range A2:C31 and is named Tip_Table. 

Excel then moves down the values in the first column of Tip_Table until 

it finds a match, whereupon the program uses the col_index_num argument 

in the VLOOKUP function to determine which tip amount from that row of the 

table to return to cell F3. If Excel finds that the value entered in the 

Pretax_Total cell ($16.50 in this example) doesn't exactly match one of the 

values in the first column of Tip_Table, the program continues to search down 

the comparison range until it encounters the first value that exceeds the 

pretax total (17.00 in cell A19 in this example). Excel then moves back up to 

the previous row in the table and returns the value in the column that matches 

the col_index_num argument of the VLOOKUP function (this is because the 

optional range_lookup argument has been omitted from the function). 

Note that the tip table example in Figure 2 uses an IF function to 

determine the col_index_num argument for the VLOOKUP function in cell F3. 

The IF function determines the column number to be used in the tip table by 

matching the percentage entered in Tip_Percentage (cell F1) with 0.15. If 

they match, the function returns 2 as the col_index_num argument and the 

VLOOKUP function returns a value from the second column (the 15% column 

B) in the Tip_Table range. Otherwise, the IF function returns 3 as the 

col_index_num argument and the VLOOKUP function returns a value from 

the third column (the 20% column C) in the Tip_Table range. 

Figure 10.3 shows an example that uses the HLOOKUP function to look 

up the price of each bakery item stored in a separate price Lookup table and 

then to return that price to the Price/Doz column of the Daily Sales list. Cell 

F3 contains the original formula with the HLOOKUP function that is then 

copied down column F: =HLOOKUP(item,prices,2,FALSE) 

In this HLOOKUP function, the range name Item that's given to the Item 

column in the range C3:C27 is defined as the lookup_value argument and the 

cell range name Prices that's given to the cell range J1:M2 is the table_array 

argument. The row_index_num argument is 2 because you want Excel to 

return the prices in the second row of the Prices Lookup table, and the 

optional range_lookup argument is FALSE because the item name in the 

Daily Sales list must match exactly the item name in the Prices Lookup table. 

By having the HLOOKUP function use the Prices Lookup table to input 

the price per dozen for each bakery goods item in the Daily Sales list, you 

make it a very simple matter to update any of the sales in the list. 
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Fig. 10.3. Using the HLOOKUP function to return the price of a 

bakery item from a Lookup table 
 

All you have to do is change its Price/Doz cost in the Prices Lookup 

table, and the HLOOKUP function immediately updates the new price in the 

Daily Sales list wherever the item is sold. 

 

10.3. Performing a two-way lookup: MATCH and INDEX functions 

In both the VLOOKUP and HLOOKUP examples, Excel only compares 

a single value in the data list to a single value in the vertical or horizontal 

Lookup table. Sometimes, however, you may have a table in which you 

need to perform a two-way lookup, whereby a piece of data is retrieved from 

the Lookup table based on looking up a value in the top row (with the table's 

column headings) and a value in the first column (with the table's row 

headings). 

Figure 10.4 illustrates a situation in which you would use two values, 

the production date and the part number, to look up the expected production. 

In the 2008 Production Schedule table, the production dates for each part 

form the column headings in the first row of the table, and the part numbers 

form the row headings in its first column of the table. 
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Fig. 10.4. Doing a two-way lookup in the Production Schedule 

table. 
 

To look up the number of parts to be produced for a particular month, 

you need to the use a bit complicated technology that consists of two 

functions: the MATCH function and the INDEX function. The MATCH function 

returns the relative position of a particular value in a cell range or array. The 

syntax of the MATCH function is as follows: =MATCH(lookup_value, 

lookup_array, [match_type]). 

The lookup_value argument is the value whose position you want 

returned when a match is found, and the lookup_array is the cell range or 

array containing the values that you want to match. The optional match Type 

argument is the number 1, 0, or -1, which specifies how Excel matches the 

value specified by the lookup_value argument in the range specified by the 

lookup_array argument. There are several rules about using of the 

match_type: 

use match_type 1 to find the largest value that is less than or equal to 

the lookup_value; 

use matc_type 0 to find the first value that is exactly equal to the lookup 

value; 

use match_type -1 to find the smallest value that is greater than or 

equal to the lookup value. 

In addition to looking up the position of the production date and part 

number in the column and row headings in the Production Schedule table, we 

need to use an INDEX function, which uses the relative row and column 

number position to return the number to be produced from the table itself. 

The INDEX function follows two different syntax forms: array and reference. 

You use the array form when you want a value returned from the table (as 
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you do in this example), and you use the reference form when you want a 

reference returned from the table. The syntax of the array form of the INDEX 

function is as follows: =INDEX(array,[row_num],[col_num]) 

The syntax of the reference form of the INDEX function is as follows: 

=INDEX(reference,[row_num],[col_num],[area_num]) 
 

The array argument of the array form of the INDEX function is a range 

of cells or array constant that you want Excel to use in the lookup. If this 

range or constant contains only one row or column, the corresponding 

row_num or col_num arguments are optional. If the range or array constant 

has more than one row or more than one column, and you have to specify 

both the row_num and the col_num arguments. Excel then returns the value 

in the array argument that is located at the intersection of the row_num 

argument and the col_num argument. 

So, for the INDEX function to find the lookup value we need to know (or 

find out) the row and column numbers of this lookup value in the lookup table. 

This job in our case would be done by the MATCH function. 

For the MATCH and INDEX functions in the example shown in Figure 4 

assigned the following range names to the following cell ranges: 

Table_data to the cell range A2:J6 with the production data plus column 

and row headings; 

Part_list to the cell range A2:A6 with the row headings in the first 

column of the table; 

Date_list to the cell range A2:J2 with the column headings in the first 

row of the table; 

Part_lookup to cell B10 that contains the name of the part to look up in 

the table; 

Date_lookup to cell Bl1 that contains the name of the production date to 

look up in the table. 

As Figure 4shows, cell B12 contains a rather long and - at first glance - 

complex formula using the range names outlined previously and combining 

the INDEX and MATCH functions:  

=lNDEX(table_data,MATCH(part_lookup,part_list),MATCH(date_ 

lookup,date_list)) 

So you can better understand how this formula works, we’ll break the 

formula down into its three major components: the first MATCH function that 

returns the row_num argument for the INDEX function, the second MATCH 
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function that returns the col_num argument for the INDEX function, and the 

INDEX function itself that uses the values returned by the two MATCH 

functions to return the number of parts produced. 

The first MATCH function that returns the row_num argument for the 

INDEX function is: =MATCH(part_lookup,part_list) 

This MATCH function uses the value input into cell B10 (named 

part_lookup) and looks up its position in the cell range A2:A6 (named 

part_list). It then returns this row number to the INDEX function as its 

row_num argument. In the case of the example shown in Figure 1 where part 

AB-102 is entered in the part_lookup cell in B10, Excel returns 4 as the 

row_num argument to the INDEX function. 

The second MATCH function that returns the col_num argument for the 

INDEX function is: =MATCH(date_lookup,date_list) 

This second MATCH function uses the value input into cell Bll (named 

date_lookup) and looks up its position in the cell range A2:J2 (named 

dat_list). It then returns this column number to the INDEX function as its 

col_num argument. In the case of the example shown in Figure 1 where June 

1, 2008 (formatted as Jun-08), is entered in the date_lookup cell in Bll, Excel 

returns 4 as the col_num argument to the INDEX function. 

This means that for all its supposed complexity, the INDEX function 

shown on the Formula bar in Figure 1 contains the equivalent of the following 

formula: 

= INDEX(table_data,4, 4), where 4 and 4 are supplied by the MATCH 

function. 

Excel then returns 306 as the planned production value for part AB-102 

in June, 2008. 

 

10.4. Sorting and filtering of information in MS Excel databases 

Sorting and Filtering allow you to manipulate data in a worksheet based 

on given set of criteria. 

 Sorting is any process of arranging items in some sequence and/or 

in different sets. The main purpose of sorting information is to optimize its 

usefulness for specific tasks. 

To execute a basic descending or ascending sort based on one column: 

highlight the cells that will be sorted; 

click the Sort & Filter button on the Home tab; 



 139 

click the Sort Ascending (A-Z) button or Sort Descending (Z-A) 

button (fig. 10.5). 

 

Fig. 10.5. Basic sorts 

To sort on the basis of more than one column: 

click the Sort & Filter button on the Home tab; 

choose which column you want to sort by first; 

click Add Level and Choose the next column you want to sort and 

Click OK (fig. 10.6). 

 
Fig. 10.6. Custom sorts 

 

 Filtering is a process of data structuring (typically a list) in some 

order to produce a new data structure containing exactly those elements of 

the original data structure according to a certain criteria. 

Filtering allows you to display only data that meet certain criteria. To 

filter: 

click the column or columns that contain the data you wish to filter; 

on the Home tab, click on Sort & Filter and Click  Filter button; 
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click the Arrow at the bottom of the first cell and Click the Text Filter; 

click the Words you wish to Filter (fig. 10.7). 

 
Fig 10.7. Filtering of data 

 

To clear the filter click the Sort & Filter button and after that lick Clear 

(fig. 10.7). 

 

 

 Questions 

 

1. What are the main requirements for MS Excel database? 

2. What is the principle of performing one-way look-up? 

3. What is the difference between one-way and two-way look-ups? 

4. What is the purpose of filtering information in a database? 

5. What sorting options are available in MS Excel? 

 

 

 

 

 



 141 

Theme 11. Use of graphics in MS Excel: creation, editing and 

formatting of diagrams 
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Fig. 11.1. System elements of the theme 
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 Introduction 

The purpose of this theme lies in a close study of charts and their use 

in MS Office Excel. Charts` element and attributes are analyzed and ways of 

diagrams creation, editing and formatting are given a thorough consideration. 

Clue notions of the theme include: charts; axis; headings; labels; 

layouts; styles; design; grid of lines. 

This theme covers the following topics: Basic operations with charts: 

creation, formatting and editing. Study of different chart types. Charts’ basic 

elements: heading, grid, axis, legend. Moving of chart objects. 

As a result of the study of the material presented in this theme students 

will acquire the following competencies: 

they would learn how to use basic chart types; 

they would master basic methods of charts creation; 

they would learn how to format and edit charts; 

they would practice different ways of data representation using different 

types of charts. 

 

11.1. Charts basics: graphic objects’ main elements and their 

purpose 

 A chart is a visual representation of data, in which the data are 

represented by symbols such as bars in a bar chart or lines in a line chart. A 

chart can represent tabular numeric data, functions or some kinds of 

qualitative structures. 

Charts are often used to ease understanding of large quantities of data 

and the relationships between parts of the data. Charts can usually be read 

more quickly than the raw data that they are produced from. They are used in 

a wide variety of fields, and can be created by hand (often on graph paper) or 

by computer using a charting application. 

Certain types of charts are more useful for presenting a given data set 

than others. For example, data that present percentages in different groups 

(such as “satisfied, not satisfied, unsure”) are often displayed in a pie chart, 

but may be more easily understood when presented in a horizontal bar chart. 

On the other hand, data that represents numbers that change over a period of 

time (such as "annual revenue from 1990 to 2000") might be best shown as a 

line chart. 
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A chart can take a large variety of forms, however there are common 

features that provide the chart with its ability to extract meaning from data. 

Typically a chart is graphical, containing very little text, since humans 

are generally able to infer meaning from pictures quicker than from text. One 

of the more important uses of text in a graph is in the title. A graph's title 

usually appears above the main graphic and provides a succinct (brief) 

description of what the data in the graph refers to. 

Dimensions in the data are often displayed on axes. If a horizontal and 

a vertical axis are used, they are usually referred to as the x-axis and y-axis 

respectively. Each axis will have a scale, denoted by periodic graduations 

and usually accompanied by numerical or categorical indications. Each axis 

will typically also have a label displayed outside or beside it, briefly describing 

the dimension represented. If the scale is numerical, the label will often be 

suffixed with the unit of that scale in parentheses. For example, "Distance 

travelled (m)" is a typical x-axis label and would mean that the distance 

travelled in metres is related to the horizontal position of the data. 

Within the graph a grid of lines may appear to aid in the visual 

alignment of data. The grid can be enhanced by visually emphasising the 

lines at regular or significant graduations. The emphasized lines are then 

called major grid lines and the rest of the grid lines are minor grid lines. 

The data of a chart can appear in all manner of formats, with or without 

individual labels. It may appear as dots or shapes, connected or 

unconnected, and in any combination of colors and patterns. Inferences or 

points of interest can be overlayed directly on the graph to further aid 

information extraction. 

When the data appearing in a chart contains multiple variables, the 

chart may include a legend. A legend contains a list of the variables 

appearing in the chart and an example of their appearance. This information 

allows the data from each variable to be identified in the chart. 

 

11.2. Creating charts in MS Excel 

In Microsoft Excel, you can represent numbers in a chart. Charts allow 

you to present information contained in the worksheet in a graphic format. On 

the Insert tab, you can choose from a variety of chart types, including 

column, line, pie, bar, area, and scatter. The basic procedure for creating a 

chart is the same no matter what type of chart you choose. As you change 



 144 

your data, your chart will automatically update.To view the charts available 

click the Insert Tab on the Ribbon. 

You select a chart type by choosing an option from the Insert tab's 

Chart group. After you choose a chart type, such as column, line, or bar, you 

choose a chart sub-type. For example, after you choose Column Chart, you 

can choose to have your chart represented as a two-dimensional chart, a 

three-dimensional chart, a cylinder chart, a cone chart, or a pyramid chart. 

There are further sub-types within each of these categories. As you roll your 

mouse pointer over each option, Excel supplies a brief description of each 

chart sub-type. To create a chart: 

select the cells that contain the data you want to use in the chart; 

click the Insert tab on the Ribbon; 

click the type of Chart you want to create (fig. 11.2). 

 
Fig. 11.2. Insert chart option 

 

Once you have created a chart you can do several things to modify the 

chart. To move the chart  click the Chart and Drag it another location on the 

same worksheet, or click the Move Chart button on the Design tab and 

choose the desired location (either a new sheet or a current sheet in the 

workbook). To change the data included in the chart click the Chart, then 

click the Select Data button on the Design tab (fig. 11.3). 

 
Fig. 11.3. Data source dialog box 
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To reverse which data are displayed in the rows and columns click 

the Chart and then click the Switch Row/Column button on the Design tab 

(fig. 11.4). 

 
Fig. 11.4. Switch Row/Column option 

 

To modify the labels and titles: 

click the Chart; 

on the Layout tab, click the Chart Title or the Data Labels button; 

change the Title and click Enter (fig. 11.5). 

 
Fig. 11.5. Labels change group 

 

The Chart Tools appear on the Ribbon when you click on the chart.  

The tools are located on three tabs:  Design, Layout, and Format. Within 

the Design tab you can control the chart type, layout, styles, and location (fig. 

11.6). The tabs become available when you create a new chart or when you 

click on a chart. You can use these tabs to customize your chart. 

 
Fig. 11.6. Chart Tools group 

 

You can determine what your chart displays by choosing a layout. For 

example, the layout you choose determines whether your chart displays a 

title, where the title displays, whether your chart has a legend, where the 

legend displays, whether the chart has axis labels and so on. Excel provides 

several layouts from which you can choose. Within the Layout tab you can 

control inserting pictures, shapes and text boxes, labels, axes, background, 
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and analysis. Within the Format tab you can modify shape styles, word styles 

and size of the chart (fig. 11.7).  

 
Fig. 11.7. Format Chart options 

 

A style is a set of formatting options. You can use a style to change the 

color and format of your chart. Excel has several predefined styles that you 

can use. They are numbered from left to right, starting with 1, which is located 

in the upper-left corner. 

When you click a chart, handles appear on the right and left sides, the 

top and bottom, and the corners of the chart. You can drag the handles on 

the top and bottom of the chart to increase or decrease the height of the 

chart. You can drag the handles on the left and right sides to increase or 

decrease the width of the chart. You can drag the handles on the corners to 

increase or decrease the size of the chart proportionally. You can change the 

position of a chart by clicking on an unused area of the chart and dragging. 

It is possible to copy a chart to MS Word. In order to do it you should 

select the chart; click Copy on the Home tab; then go to the Word document 

where you want the chart to be located; click Paste on the Home tab. 

 

 

 Questions 

 

1. What is a chart and for what purposes is it used? 

2. What are the main elements of a chart? 

3. Is it possible to remove a grid of lines from a chart? 

4. What formatting tools are available in MS Excel to change the looks 

of a chart? 

5. Is it possible to use charts created in MS Excel in other MS Office 

applications? 
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Section 5. Database management systems. MS Office Access 

Theme 12. Getting familiar with Microsoft Access database 

manager 
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Fig. 12.1. System elements of the theme 
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 Introduction 

The purpose of this theme is concerned with the study of main features 

of MS Office Access database management system. The program’s interface 

is considered in detail and basic operations concerned with the creation and 

modification of tables are given a special attention. Data types are analyzed 

and data entry techniques are considered. 

Clue notions of the theme include: database; tables; fields; primary 

key; data types; names; records, draft mode; work mode. 

This theme covers the following topics: Introduction to MS Access 

database management system. Program’s interface customizing and basic 

options study. Creating tables. Entering and erasing data. Basic operations 

with data entries. Tables adjusting and fitting. 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would get acquainted with the program’s interface features; 

they would learn how to input and edit data and move across the 

database; 

they would learn how to perform basic operations with data entries; 

they would become aware of the use of basic data types; 

they would learn how to format and edit tables. 

 

12.1. Understanding MS Access workspace 

Microsoft Access is a database software package. 

 A database is an organized collection of records. 

Telephone and address books are examples of paper databases. With 

MS Access, it is possible create a computerized database. For example, you 

can use Access to organize the students who attend a school, the courses 

they take, and the instructors who teach them. After you create an Access 

database, you can search it, manipulate it, and extract information from it. 

You use windows to interact with Access. After you start MS Access 

your screen will look similar to the one shown on Figure 12.1. 

From this initial screen, the user can create a new database (either 

blank or with some tables created with the database wizard), or open up an 

existing database. In general, the first time one begins a project, a new, blank 

database should be created. After that point, use the Open existing 

database option to re-open the database created previously. If you have 
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previously created a database, and then create it again using the same 

name, you will overwrite any work you have done. 

 
Fig. 12.1. MS Access start screen 

 

Northwind is a sample database you can download from the Microsoft 

website. We will use the Northwind database to introduce MS Access 

windows. 

An Access database consists of the following objects: tables, queries, 

forms, reports, macros, and modules. The Navigation pane displays the 

objects in a database (fig. 12.2). 

 
Fig. 12.2. MS Access navigation pane 

 

In order to manipulate the Navigation pane you can lick the double 

right-arrows  to open or close it. In this example, the objects are organized 

by type, which is not the default setting. You may want to organize the objects 
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in your database by type also. You can use the down-arrow on the top of the 

Navigation pane to change the manner in which objects are organized (fig. 

12.3). 

 
Fig. 12.3. The Access window with the Northwind database open 
 

In the upper-left corner of the Access window is the Microsoft Office 

button. When you click the button, a menu appears. You can use the menu to 

create a new file, open an existing file, save a file, and perform many other 

tasks. Next to the Microsoft Office button is the Quick Access toolbar. The 

Quick Access toolbar provides you with access to commands you frequently 

use. By default, Save, Undo, and Redo appear on the Quick Access toolbar. 

You use Save to save an object, Undo to roll back an action you have taken, 

and Redo to reapply an action you have rolled back. The Title bar is located 

at the top in the center of the Access window. The Title bar displays the name 

of the database on which you are currently working. 

You use commands to tell Access what to do. The Ribbon is used to 

issue commands. The Ribbon is located near the top of the Access window, 

below the Quick Access toolbar. At the top of the Ribbon are several tabs; 

clicking a tab displays related command groups. Within each group are 

related command buttons. You click buttons to issue commands or to access 

menus and dialog boxes. You may also find a dialog box launcher  in the 

bottom-right corner of a group. When you click the dialog box launcher , a 

dialog box makes additional commands available. 

The Navigation pane stores the objects in your database: tables, 

queries, forms, reports, macros, and modules. Objects always display with an 

icon to the right. The icon tells you the object type:  table, query, 

 form, report, macro, and  module (fig. 12.4). 
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Fig. 12.4. MS Access objects 

 

Tables. In Access, data is stored in tables. A table is a set of columns 

and rows, with each column referred to as a field. Each value in a field 

represents a single type of data. Each row of a table is referred to as a 

record. 

Queries. You use queries to retrieve specific data from your database 

and to answer questions about your data. For example, you can use a query 

to find the names of the employees in your database who live in a particular 

state. 

Forms. Forms give you the ability to choose the format and 

arrangement of fields. You can use a form to enter, edit, and display data. 

Reports. Reports organize or summarize your data so you can print it or 

view it onscreen. You often use reports when you want to analyze your data 

or present your data to others. 

Macros. Macros give you the ability to automate tasks. You can use a 

macro to add functionality to a form, report, or control. 

Modules. Like macros, modules give you the ability to automate tasks 

and add functionality to a form, report, or control. Macros are created by 

choosing from a list of macro actions, whereas modules are written in Visual 

Basic for Application. 

You double-click an object to open the object. You right-click an object 

to view a menu of options. You can use the menu to do such things as open 

objects, rename objects, and delete objects. 

Objects that are open appear on tabs. Right-click a tab to view a menu 

of options you can perform, such as save the object, close the object, or 

change the view (fig. 12.5). 

A view is a way of looking at an object. For example, in Access, data is 

stored in tables. Two of the possible ways you can view a table are Datasheet 

view and Design view. 

You can see the data contained in a table in Datasheet view. 
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Fig. 12.5. Manipulation with objects in MS Access 

 

You can see the design of a table in Design view. When you open an 

object, buttons appear in the lower-right corner of the Access 

window. You can use the View button on the Home tab to change views, or 

you can click the proper button in the lower-right corner of the window. 

 

12.2. Creating and saving a new database in MS Access 

When you start Access, the Getting Started With Microsoft Office 

Access screen appears (refer to fig. 1). You can use this screen to create a 

database. Within a database, you can do such things as enter data, create 

reports, and retrieve data. You can create a blank database or you can use 

one of the templates provided by Microsoft. When you use a template, 

Access creates forms you can use to enter data, reports you can use to 

retrieve data, and more. You can modify the forms, reports, and other objects 

to suit your needs. This tutorial will teach you how. 

The following templates are included with Access: Assets, Contacts, 

Events, Faculty, Issues, Marketing Projects, Projects, Sales Pipeline, 

Students, and Tasks. Other templates are available online. Each template 

creates a database related to the title. For example, the Faculty template 

creates a faculty database that includes tables, queries, forms, and reports 

related to faculty. In Access, you use tables to store data, queries to retrieve 

data, forms to enter data, and reports to display data. 

To use a template to create a database you should: 

start Access. The Getting Started With Microsoft Office Access screen 

appears; 
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click Local Templates. Icons representing local templates appear in the 

center of the window; 

click the icon for the template you want to use; 

click the Browse button. The File New Database window appears; 

locate the folder in which you want to store your database and Click 

OK. Then click Create. Access creates and opens your database (fig. 12.6). 

 
Fig. 12.6. Creating a database from a template 

 

A blank database is a database with nothing in it. You must create all 

the tables, forms, reports, queries, and so on. If you cannot find a template 

that suits your needs, create a blank database. After you create the database, 

Access opens to a datasheet and makes available the tools you need to 

create objects. Creating tables is the first step in building a database. 

In Access, data is stored in tables. A datasheet displays the information 

stored in a table in columns and rows. The columns are called fields and the 

rows are called records. You can use a datasheet to create a table, enter 

data, retrieve data, and perform other tasks. 

 

12.3. Creating Microsoft Access Tables. Understanding data types 

Tables are the foundation of an Access database. Access stores data in 

tables. A table is a set of columns and rows. Each column is called a field. 

Within a table, each field must be given a name and no two fields can have 

the same name. Each value in a field represents a single category of data. 

For example, a table might have three fields: Last Name, First Name, and 
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Phone Number. The table consists of three columns: one for last name, one 

for first name, and one for phone number. In every row of the table, the Last 

Name field contains the last name, the First Name field contains the first 

name, and the Phone Number field contains the phone number. Each row in 

a table is called a record (fig. 12.7). 

 
Fig. 12.7. MS Access table 

 

All of the data in a table should refer to the same subject. For example, 

all of the data in the Employees table should refer to employees, all of the 

data in the Students table should refer to students, and all of the data in the 

Courses table should refer to courses. 

You can view an Access database as a collection of related tables. For 

example, in a database that contains tables for Employees, Students, and 

Courses, the Employees table lists the employees, the Students table lists 

students, and the Courses table lists the courses students can take. 

After MS Access creates a blank database, it opens in Datasheet view 

and makes available the tools you need to create a table. Datasheet view 

displays a table as a set of columns and rows. When you view a blank 

database for the first time in Datasheet view, you see a column named ID. 

This column is by default the primary key field. 

A primary key is a field or combination of fields that uniquely identify 

each record in a table. No two records in a table should have the same 

values in every field. For example, the following should not occur in a table 

(table 12.1). 

Table 12.1 

Table with duplicate data 

Last Name First Name City 

Smith John Jonestown 

Smith John Jonestown 
 

In the real world, it is possible to have two people from the same city 

with the same first and last name. In cases like this, you can use the ID field 
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as the primary key field and use it to make each record unique. The ID field 

has a data type of AutoNumber; as a result, Access automatically creates a 

unique number for each record in the database. The resulting table will look 

like the one shown here (table 12.2). 

Table 12.2 

Modified table with duplicate data and a unique key 

ID Last Name First Name City 

1 Smith John Jonestown 

2 Smith John Jonestown 
 

The primary key is a unique identifier for a record.  The primary key 

cannot be the same for two records.  This field can never be blank. A 

composite key is a primary key that is comprised of two or more fields.  It can 

also be called a compound or concatenated key. A foreign key is a field or 

combination of fields that are related to the primary key of another table (fig. 

12.8). 

 

12.8. Primary key indicator 
 

Access provides several methods for creating a table. One method is to 

use the Rename option with the Add New Field column label to give each 

column the field name you want it to have and then to type or paste your data 

into the table. Field names can include letters, numbers, and spaces and can 

be up to 64 characters long. When choosing a field name, try to keep it short. 
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When you save your table for the first time, Access gives you the 

opportunity to name your table. Each table name must be unique; hence, two 

tables in the same database cannot have the same name. The table name 

should describe the data in the table; can consist of letters, numbers, and 

spaces; and can be up to 64 characters long. When choosing a table name, 

try to keep it short. 

You can save a table by clicking the Save button on the Quick Access 

toolbar or by right-clicking the Tables tab and then choosing Save from the 

menu that appears (fig. 12.9). 

 
Fig. 12.9. Save table option 

 

In Access, you use data types to specify the type of data each field can 

capture (table 12.3). A field with a data type of text can store alphabetic 

characters and numbers. Generally speaking, you cannot perform 

mathematical calculations by using a text field. For example, you can use a 

text field to store a street address. Unless you do some manipulation, you 

cannot use the numbers in the street address in mathematical calculations. 

You will not be able to sum or average the numbers in an address field, which 

is fine, because you probably do not want to. Alternatively, you can assign a 

Test Score field a data type of Number. You can enter numbers into the field 

and then average, sum, or perform other calculations with the numbers. 

However, you cannot enter an alphabetic character in a number field. 

After you create the fields for a table, you can enter data by typing in 

each field. As you type, Access assigns a data type to each field based on 

your entry. You may want to change the data type Access assigned to a field, 

or you may want to explicitly assign a data type to each field. You can do so 

by choosing the Datasheet tab and then selecting the proper option in the 

Data Type field in the Data Type & Formatting group. 
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Table 12.3 

MS Access data types 

Data type Use Notes 

Text Alphanumeric data. Use for text and for numbers 

that are not used in mathematical calculations. 

Use for names, addresses, and other relatively 

short pieces of text. Can store up to 255 

characters. 

 

Memo Long text. Use for long pieces of text, such as 

notes and long descriptions. Can store up to 

64,000 characters. 

  

Number Numeric data. Use for numbers you want to use 

in mathematical calculations. 

If you are working with 

currency, use the 

currency type. 

Date/Time Use for dates and times.   

Currency Use for currency. Prevents rounding 

during calculation. 

AutoNumber Unique sequential numbers or random numbers 

automatically inserted when you create a record. 

Use to create a primary key. 

  

Yes/No Logical data. Use when only one of two values is 

valid. Yes/No, True/False, etc. 

  

Hyperlink Use to store hyperlinks.   

Attachment Use to store attachments.   

OLE Object Use to attach an OLE object such as a Word 

document, Excel spreadsheet, or PowerPoint 

presentation. 

  

 

Some data types allow you to select the formatting you want. By 

formatting, you determine how data in a field displays. For example, if you 

choose a data type of number and a format of Euro, any number you enter 

will appear with a Euro sign in front. 

To explicitly assign a data type or format to a field: 

click the field label for the field to which you want to assign a data type; 

activate the Datasheet tab and click the down-arrow next to the Data 

Type field and then choose a data type; 

click the down-arrow next to the Format field and then choose a format. 
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Access assigns a data type and format to the field you selected (fig. 12.10). 

 
Fig. 12.10. Data type assignment in MS Access 

 

Access provides several ways to view the objects in your database. You 

can use Design view to create or modify an Access table. You can use the 

View button on the Home tab or the Table Design button on the Create tab to 

change to Design view. Using Design view is the preferred method for 

creating a table because it provides you with the most options and enables 

you to precisely define your table. 

 

12.4. Working with Microsoft Access tables 

After you create an Access table, you can modify it, enter data into it 

manually or import data from somewhere else, such as Excel. Data can be 

added, deleted or modified in tables using a simple spreadsheet-like display. 

To bring up this view of a single table's data, highlight the name of the table 

and then double-click on the name of the table. In this view of the Customer 

table, shown in the Figure 12.11 below, the fields (columns) appear across 

the top of the window and the rows or records appear below. This view is 

similar to how a spreadsheet would be designed. 

 
Fig. 12.11. Data entry option 

 

To add an attachment to an attachment field double-click in the 

attachment field (fig. 12.12). The Attachments dialog box appears. After that 

click Add. The Choose File dialog box appears. 
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Fig. 12.12. Attachment options 

 

To enter data into a date field you can manually type the date or select 

the date from the calendar that appears to the left of the field when you click 

in the field (fig. 12.13). You click the calendar to open it. Use the left-arrow at 

the top of the calendar to move to the previous month; use the right-arrow at 

the top of the calendar to move to the next month. When you reach the 

proper month, click the proper date. 

 
Fig. 12.13. Date input option 

 

After you create a table, you may need to modify it. You can delete 

columns, insert columns, or move columns. The Delete option permanently 

deletes columns and all the data contained in them. You cannot undo a 

column delete. 

MS Access provides several methods for moving around a table. On the 

Home tab, there is a Go To button. When you click it, a menu of options 

appears. You can use the menu to go to the first, last, previous, or next 

record in your table. 
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You can click the New option to add a new record. You can also use 

special keys and the navigation bar in Access to move around a table. The 

navigation bar appears at the bottom of the table (fig. 12.14). 
 

 
Fig. 12.14. The Go To button to move around a table 

 

Before you can perform an operation on a column or row, you must 

select it. To select a column, click the column head. To select several 

columns, click a column head and then drag. To select a row, click the blank 

area to the left of the row. To select several rows, click the blank area to the 

left of a row and then drag. To select the entire table, click the Select All 

button  in the upper-left corner of the table. 

If all of the information in a column or row does not display, you may 

want to make the column or row larger. If you want to fit more information on 

the screen, you may want to make a column or row smaller. 

In either case, you can click and drag to increase or decrease column 

width or row height. 

 

 

 Questions 

 

1. What is a database? 

2. What does a database consist of? 

3. What data types are used by MS Access? 

4. What is a primary key? What other types of keys can be used in MS 

Access? 

5. Why can’t entries in a key field be duplicated? 

6. What is the initial container of data in MS Access? 
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Theme 13. Sorting, filtering, and creating relationships 

between MS Access tables 
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Fig. 13.1. System elements of the theme 
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 Introduction 

The purpose of this theme lies in a close study of the peculiar features 

connected with data sorting and filtering in MS Access tables. The nature of 

Access filters is analyzed and questions connected with entries sorting are 

given a special consideration. A thorough analysis covers establishing of 

different types of relationships between tables in MS Access databases. 

Clue notions of the theme include: sorting; filtering; simple filter; 

compound filter; relationships; one-to-one relationship; one-to-many 

relationship. 

This theme covers the following topics: What is data sorting? What 

ways of filtering data exist? What are the basic types of data filters? What is 

the role of relationships in ensuring database integrity? What are the basic 

types of relationships between tables in a database? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the difference between sorting and filtering data in a 

database; 

they would learn the basic types of filters; 

they would become aware of the types of relationships that can exist 

between tables in a database. 

 

13.1. Sorting data in MS Access datasheets 

You can sort Access data so you can view records in the order you 

want to view them, and you can filter data so you only see the records you 

want to see. By sorting, you can put a column of information in alphabetical, 

numerical, or date order. You can sort in ascending order (alphabetical from 

A to Z, lowest number to highest number, earliest date to latest date) or 

descending order (alphabetical from Z to A, highest number to lowest 

number, latest date to earliest date). You can also sort within a sort. For 

example, you can sort by state and then sort within each state by city. When 

sorting within a sort, perform the innermost sort first. For example, if you are 

sorting by state and then city, sort the city first and then sort by state. 

You can sort records in a datasheet by a single column or by two 

adjacent columns.  To sort records by a single column you should select the 

field you wish to sort and then click the Sort Ascending or Sort 

Descending button (fig. 13.1). 
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Fig. 13.1. Data sort option 

 

It is also possible to sort data in two columns at the same time if they 

are adjacent to each other. For this one has to select the desired columns for 

sorting by holding the shift key and clicking on the columns. Then it is 

necessary to click the Sort Ascending or Sort Descending button (fig. 13.2) 

 
Fig. 13.2. Two columns sort 

 

To clear the sort just click the Clear Sort button . 

 

13.2. Filtering data in MS Access database tables 

You can apply a filter to see only the records you want to see. For 

example, perhaps your database contains students from the states of DE, NJ, 

and PA and you only want to see the students from DE. You can filter your 

data so only DE students display. 

Each time you apply a filter to a column, it replaces any previous filter 

you applied to that column. For example, if you apply a filter so you only see 

students in DE, and later you apply a filter so you only see students in NJ, 

Access clears the DE filter and then applies the NJ filter. 

You can apply filters to multiple columns in the same table. For 

example, by applying a filter first to the State field and then to the Last Name 

field, you can see all of the students in the state of DE whose last names are 

Adams. 

To apply a filter: 

click the column label for the column you want to filter and activate the 

Home tab; 

click the Filter button. A menu appears; 

uncheck the items you do not want to appear, making sure only the 

items you want are checked and click OK. 



 164 

Access filters your data and displays the word Filtered at the bottom of 

the window (fig. 13.3). 

 
Fig. 13.3. Filtering data by “state” 

 

To remove a filter сlick Clear All Filters. Access clears all the filters you 

have applied.  

In addition to simply searching for a specific value, you can apply 

several specialized filters. For example, you can find all of the records that do 

not equal the value you specify or you can find all of the records that fall 

between two dates. The following are lists of specialized filters (table 13.1). 

Table 13.1 

MS Access data filters 

Filter Comment 

1 2 

Text Filters 

Equals Finds every record in the table where the field’s value 

equals the value you enter 

Does Not Equal Finds every record in the table where the field’s value does 

not equal the value you enter 

Begins With Finds every record in the table where the field’s value 

begins with the value you enter 

Does Not Begin 

With 

Finds every record in the table where the field’s value does 

not begin with the value you enter 

Contains Finds every record in the table where the field’s value 

contains the value you enter 

Does Not Contain Finds every record in the table where the field’s value does 

not contain the value you enter 

Ends With Finds every record in the table where the field’s value ends 

with the value you enter 
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Table 13.1 (the ending) 

1 2 

Does Not End 

With 

Finds every record in the table where the field’s value does 

not end with the value you enter 

Number Filters 

Equals Finds every record in the table where the field’s value 

equals the value you enter 

Does Not Equal Finds every record in the table where the field’s value does 

not equal the value you enter 

Less Than Finds every record in the table where the field’s value is 

less than the value you enter 

Greater Than Finds every record in the table where the field’s value is 

greater than the value you enter 

Between Finds every record in the table where the field’s value is 

between the values you enter 

Date Filters 

Equals Finds every record in the table where the field’s value 

equals the date you enter 

Does Not Equal Finds every record in the table where the field’s value does 

not equal the date you enter 

Before Finds every record in the table where the field’s value is 

before the date you enter 

Greater Than Finds every record in the table where the field’s value is 

greater than (comes after) the date you enter 

Between Finds every record in the table where the field’s date is 

between the dates you enter 

All Dates in a 

Period 

Finds every record in the table where the field’s date is in 

the period you enter 

 

13.3. Creating table relationships 

Table relationships are the associations of data between tables.  By 

defining table relationships, you can pull records from related tables based on 

matching fields. In Access, you store data in multiple tables and then use 

relationships to join the tables. After you have created relationships, you can 

use data from all of the related tables in a query, form, or report (fig. 13.4). 
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A primary key is a field or combination of fields that uniquely identify 

each record in a table. A foreign key is a value in one table that must match 

the primary key in another table. You use primary keys and foreign keys to 

join tables together – in other words, you use primary keys and foreign keys 

to create relationships. 

 
Fig. 13.4. Table relationships 

 

There are two valid types of relationships: one-to-one and one-to-many. 

In a one-to-one relationship, for every occurrence of a value in table A, there 

can only be one matching occurrence of that value in table B, and for every 

occurrence of a value in table B, there can only be one matching occurrence 

of that value in table A. A one-to-one relationship is between two tables 

where the primary key in one table and the foreign key in another table are 

the same.  For each record in the first table, there is a single matching record 

in the second table (fig. 13.5). 

 
Fig. 13.5. One-to-one relationship 

 

One-to-one relationships are rare because if there is a one-to-one 

relationship, the data is usually stored in a single table. However, a one-to-

one relationship can occur when you want to store the information in a 

separate table for security reasons, when tables have a large number of 

fields, or for other reasons. 
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In a one-to-many relationship, for every occurrence of a value in table 

A, there can be zero or more matching occurrences in table B, and for every 

one occurrence in table B, there can only be one matching occurrence in 

table A. A one-to-many relationship occurs between two tables where the 

primary key in one table can be duplicated many times in another table (fig. 

13.6) 

 
Fig. 13.6. One-to-many relationship 

 

When tables have a one-to-many relationship, the table with the one 

value is called the primary table and the table with the many values is called 

the related table. Referential integrity ensures that the validity of the 

relationship between two tables remains intact. It prohibits changes to the 

primary table that would invalidate an entry in the related table. For example, 

a school has students. Each student can make several payments, but each 

payment can only be from one student. The Students table is the primary 

table and the Payments table is the related table (table 13.2, 13.3). 

Table 13.2 

List of students 

Students 

Student ID Last Name First Name 

Primary Key   

1 John Smith 

2 Mark Adams 

3 Valerie Kilm 
 

If you delete Student ID 1 from the Students table, Student ID 1 is no 

longer valid in the Payments table. Referential integrity prevents you from 

deleting Student ID 1 from the Students table. 

Also, if the only valid Student IDs are 1, 2, and 3, referential integrity 

prevents you from entering a value of 4 in the Student ID field in the 

Payments table. 
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A foreign key without a primary key reference is called an orphan. 

Referential integrity prevents you from creating orphans. 

Table 13.3 

Payment records 

Payments 

Payment ID Student ID Amount Due Amount Paid 

Primary key Foreign key   

1 1 500 500 

2 2 700 300 

3 3 500 250 

4 2 400 300 

5 3 250 250 
 

To create relationships first close all tables and forms. For that right-

click on the tab of any Object. A menu appears. Click Close All.). After that 

activate the Database Tools tab (fig. 13.7). 

 
Fig. 13.7. Database Tools group 

 

Click the Relationships button in the Show/Hide group. The 

Relationships window appears. If anything appears in the relationships 

window, click the Clear Layout button in the Tools group. If you are prompted, 

click Yes. After that click the Show Table button in the Relationships group. 

The Show Table dialog box appears (fig. 13.8). 

 
Fig. 13.8. Show Table dialog box 

 

Activate the Tables tab if your relationships will be based on tables, 

activate the Queries tab if your relationships will be based on queries, or 

activate the Both tab if your relationships will be based on both. Then double-

click each table or query you want to use to build a relationship. The tables 
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appear in the Relationships window. Click the Close button to close the Show 

Table dialog box. 

Drag the Primary table’s primary key over the related table’s foreign 

key. After you drag the primary key to the related table’s box, the cursor 

changes to an arrow. Make sure the arrow points to the foreign key. The Edit 

Relationships Dialog box appears (fig. 13.9). 

 
Fig. 13.9. Edit Relationships dialog box 

 

After that click the Enforce Referential Integrity checkbox and choose 

Create. Access creates a one-to-many relationship between the tables 

(fig.13.10) 

 
Fig. 13.10. A new relationship created 

 

When all the operations are finished click the Save button on the Quick 

Access toolbar to save the relationship. 

 

 

 Questions 

 

1. What is a relationship? What types of relationships can exist between 

tables in a database? 

2. What are the basic types of filters? 

3. What is the difference between sorting and filtering data in a 

database? 
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Theme 14. The technology of creating, editing and using 

queries, forms and reports in MS Access 
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Fig. 14.1. System elements of the theme 
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 Introduction 

The purpose of this theme lies in a close study of the main features 

connected with creating, editing and using queries, forms and reports in MS 

Access. The nature of Access queries is analyzed and questions connected 

with forms creation and use are given a thorough consideration. A detailed 

analysis covers specific aspects of the work with MS Access reports. 

Clue notions of the theme include: queries; forms; reports filtering; 

sorting; calculated fields; query criteria; reports printing. 

This theme covers the following topics: What is database querying? 

What are ways of querying data in MA Access? What are the basic types of 

forms? What is the role of calculated fields? What are the basic reports 

creation options? 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would know the difference between queries and reports in a 

database; 

they would learn how to create, edit and use queries, forms and reports; 

they would become aware of the types and purpose of forms in MS 

Access databases. 

 

14.1. Creating Microsoft Access queries 

 A query allows you to select and filter data from multiple tables. 

 Queries can be saved and utilized as often as you need them. You can 

use a query to view a subset of your data or to answer questions about your 

data. For example, if you want to view a list of student names and email 

addresses, but you do not want to see addresses and other data, you can 

create a query that displays the student’s first name, last name, and email 

address only. Alternatively, if you want to know which students live in DE, you 

can restrict your list to those students. 

A query can be based on tables or on other queries. To create a query, 

you open the tables or queries on which you are going to base your query in 

Query Design view, and then use the options in Design view to create your 

query. You then click the Run button to display the results. You can save 

queries for later use. 

To open tables or queries in Query Design view Activate the Create 

tab→Click the Query Design button in the Other group. The Show Table 
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dialog box appears→Activate the Tables tab if you want to base your query 

on tables, activate the Queries tab if you want base your query on queries or 

activate the Both tab if you want to base your query on both tables and 

queries→Click to choose the table or query on which you want to base your 

query→Click Add. The table appears in the window. After that click to choose 

the next table or query on which you want to base your query. Continue 

clicking tables or queries until you have all the tables and queries you plan to 

use→Click Close. Access changes to Query Design view (fig. 14.1). 

 
Fig. 14.1. Queries view 

 

In Query Design view, each table has an option that allows you to 

display all of the fields and all of the records in a table. This option appears 

on the field line on the drop-down menu as the table name followed by a 

period and an asterisk (tablename.*). 

After you run a query, you can easily change back to Query Design 

view and make modifications to your query or create a new query. You can 

also click the Design button  in the lower-right corner of the Access window 

to change to Design view. 

You can use an Access query to retrieve a single column of data. 

Instead of choosing the tablename.* option on the Field line in Query Design 

view, choose the name of the field you want to retrieve. You can use an 

Access query also to retrieve multiple columns of data. 

On the Field line in Query Design view, choose the field name of each 

field you want to retrieve in the order you want to retrieve them. For that open 

a table or query in Query Design view. Then choose the field names you want 

to retrieve in the order you want to retrieve them and click the Run button. 

Access retrieves the columns you chose (fig. 14.2). 
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Fig. 14.2. One and multiple columns use in a query 

 

When creating a query, you can sort the rows you retrieve in ascending 

or descending order by choosing the option you want on the Sort row in 

Query Design view. 

You can also create sorts within a sort. For example, you can sort by 

state and then within a state, you can sort by last name and then by first 

name. You specify the sort in the order you want the sort to occur. If you want 

to sort by state and then by last name within a state and then by first name 

within last name, you enter the sort in the following order: city, last name, first 

name. Your sort order may not agree with the order in which you want to 

display fields. In such a case, you can use fields that do not display to enter 

your sort order. To prevent a field from displaying, deselect the Show box on 

the Show row. 

To sort multiple columns open a table or query in Query Design view. 

Then choose the field names you want to retrieve in the order you want to 

retrieve them. Then choose the field names you want to sort by in the order 

you want to sort. After that under the fields you want to sort by, choose 

Ascending or Descending and deselect the Show button for the columns you 

do not want to display. Click the Run button. Access retrieves the columns 

you chose and displays the rows in the order you specified (fig. 14.3). 

In the examples so far, you have been retrieving all of the records 

(rows) in your table. You can, however, specify which records you wish to 

retrieve. For example, you can retrieve only those students who live in DE, 
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only the student whose student number is 5, or only those students whose 

birth date is 2/16/88. 

 
Fig. 14.3. Sort multiple columns in a query 

 

You use logical operators such as = (equal), <> (not equal), > (greater 

than), or < (less than) to restrict the records you retrieve. For example, if you 

only want to display students who live in DE, enter = "DE" in the State 

column on the Criteria line. Access will only retrieve records where the value 

in the State column is equal to DE. Selection criteria are not case-sensitive, 

so Access will retrieve records where the entry is DE, de, De, or dE (table 

14.1) 

Table 14.1 

Querying criteria 

“Value” 

Will only display items that are that exact value 

(replace the word value with what you want to 

search by) 

= Is equal to 

< Less than 

<= Less than or equal to 

> Greater than 

>= Greater than or equal to 

<> Not equal to 

Between  X  And Y Within a range (replace X & Y with values) 

Is Null Null values 

And True only if both conditions exist 

Or True if either condition exists 

Not True if the single instance is not true 
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You can apply multiple criteria to the same table. If you place two 

criteria on the same line, Access will only retrieve records where both criteria 

are met. 

For example, if you want all records where the State is equal to 

"DE" and the Last Name is equal to Smith, you would set the State field to = 

"DE" and the Last Name field to = "Smith" and you would place both criteria 

on the same line. 

If you place one set of criteria on the Criteria line and the second set of 

criteria on the Or line, Access will retrieve records if either criteria are met. 

For example, you want all records where the State is equal to "DE" or the 

Last Name is equal to Smith. 

You would set the State field to = "DE" and the Last Name field to = 

"Smith" and you would place one set of criteria on the Criteria line and the 

other set of criteria on the Or line. Access will bring back all records where 

the state equals DE and all records where the Last Name is equal to Smith no 

matter what the State is. 

You can add additional and and or statements by using the lines below 

the Or line. For And clauses, place the criteria on the same line; for Or 

clauses, place the criteria on separate lines. 

If you want to view data from two or more tables or queries, you can 

create a query that pulls the data from multiple tables or queries. The tables 

and queries from which you pull your data should have a relationship (refer to 

fig. 14.4). 

 
Fig. 14.4. Multiple table query 
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It is also possible to use calculated fields In MS Access queries. A 

calculated field is a field that gets its information from the calculations 

performed on other fields.  

You can build calculated fields in the Query screen by using the 

addition (+), subtraction (-), multiplication (*) and division (/) 

operators. Expression is a combination of functions, field names, numbers, 

text, and the operators listed above (fig. 14.5). 

 
Fig. 14.5. Build expressions option 

 

After you create a query, you can save it. You can rerun a saved query 

at any time. If you change the data on which the saved query is based, you 

will see the changes when you rerun the query. 

Once created, a query can be modified. Simply open the query in Query 

Design view and make the changes. You can add columns, change the sort 

order, change the criteria, and make other changes. 

 

14.2. Creating and using Microsoft Access forms 

Data entry forms are the primary means of entering data into tables in 

the database. Access forms are much like paper forms: you can use them to 

enter, edit, or display data. They are based on tables. When using a form, 

you can choose the format, the arrangement, and which fields you want to 

display. 

Access can automatically create several types of forms. For example, 

when you click the Form button on the Create tab, Access places all fields in 

the selected table on a form. If the table has a one-to-many relationship with 

one other table or query, Access creates a stacked form (the records are 
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displayed in a column) for the primary table and a datasheet for the related 

table. If there are several tables with a one-to-many relationship, Access does 

not create the datasheet. 

To create a form open the Navigation pane→Click the table or query on 

which you want to base your form→Activate the Create tab→Click Form in 

the Forms group. Access creates a form (fig. 14.6). 

 
Fig. 14.6. One-view forms creation technology 

 

A split form is a form in which the same data is displayed in two views 

simultaneously. One part of the form displays in Form view (stacked fields), 

while the other part displays in Datasheet view. The two views are 

synchronized, so as you select a field in one view, it is automatically selected 

in the other view. You can add, change, or delete the data in either view. 

Using a split form gives you the benefits of two types of forms in a single 

form. For example, you can use the datasheet portion to locate records and 

the form portion to edit records (fig. 14.7). 

 
Fig. 14.7. A typical MS Access split form 
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You can use the Multiple Items button on the Forms tab to create a form 

that displays multiple records, one record per row. To create a multiple items 

form open the Navigation pane. Then click the table or query on which you 

want to base your form. Activate the Create tab and click Multiple Items in the 

Forms group. Access creates a multiple items form (fig. 14.8). 

 
Fig. 14.8. MS Access multiple items form 

 

There are three ways to view forms in Access (table 14.2). 

Table 14.2 

MS Access form views 

View Comment 

Design View 

Allows you to design a form that includes a header, a footer, and 

details in the form.  You can also add images and control which fields 

appear on the form 

Form View 
This is a dynamic page which allows the user to enter and edit data or 

navigate through data in a field 

Layout View This view allows you to design the form from one of the given layouts 
 

To save a form: 

click the Save button on the Quick Access toolbar. Access saves the 

form unless you are saving for the first time. If you are saving for the first 

time, the Save As dialog box appears; 

type the name you want to give the form and click OK. Access saves 

the form. You can now access the form by using the Navigation pane. 
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14.3. Generating MS Access reports 

 Reports organize and summarize data for viewing online or for 

printing a hard copy. 

A detail report displays all of the selected records. You can include 

summary data such as totals, counts, and percentages in a detail report. A 

summary report does not list the selected records but instead summarizes the 

data and presents totals, counts, percentages, or other summary data only. 

Access has several report generation tools that you can use to create both 

detail and summary reports quickly. 

The Report button creates a simple report that lists the records in the 

selected table or query in a columnar format (fig. 14.9). 

 
Fig. 14.9. A simple MS Access report 

 

Access reports created simply by using the Report button have several 

sections. They are detailed in Table 14.3 and Figure 14.10. 

Table 14.3 

Sections of a Report 

Section Comment 

Report 

Header 

Appears at the top of the first page and displays the report title 

Page 

Header 

Appears at the top of every page and displays the headings (field labels) for 

each column 

Page 

Footer 

Appears at the bottom of every page and displays the page number and total 

number of pages 

Detail 

Section 

Appears between the page header and page footer and displays the records 

from the table or query 

Report 

Footer 

This section is optional. Appears on the last page of the report and displays 

summary information such as grand totals 
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Fig. 14.10. Sections of a Report 

 

You can also use the Report Wizard to create a report. The Report 

Wizard provides you with more flexibility than you get by using the Report 

button. You can choose the tables and fields, group the data, sort the data, 

summarize the data, choose a layout and orientation, apply a style, and title 

your report.  

When using the Report Wizard, you can group data. Grouping puts all 

of the values in a field into a group based on the field’s value. For example, if 

your data is grouped by the Department field and the records in the 

Department field have values such as Administration, Computer Science, and 

English. Access will group all of the data for the Administration department 

together, all of the data for the Computer Science department together, and 

all of the data for the English department together (fig. 14.11). 

 
Fig. 14.11. Grouping data using the Report Wizard 
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By using the Report Wizard, you can create up to four levels of sort. 

Access sorts the first level, and then sorts the second level within that sort, 

and so on. If you have grouped your data, you can summarize it by displaying 

the sum, average, and minimum or maximum value for each numeric field. 

You can choose to have your report display just the summary data or each 

detail line and the summary data. 

There is also an option that allows you to display the percent the sum of 

each group is of the grand total. All of the fields in your report may not fit on a 

single page. You can have Access automatically adjust the size of the font so 

that every field fits (fig. 14.12). 

 
Fig. 14.12. Sorting data using the Report Wizard 

 

You can choose the layout and orientation of your report. The layout 

determines where each field appears on the page. Access provides three 

options to choose from: Stepped, Block, and Outline. When you choose an 

option, the left side of the window displays a graphic of the layout. 

Orientation determines whether Access creates the report in portrait or 

landscape. Most paper, such as paper sized 8 1/2 by 11, is longer on one 

edge than it is on the other. If you print in Portrait, the shortest edge of the 

paper becomes the top of the page. Portrait is the default option. If you print 

Landscape, the longest edge of the paper becomes the top of the page. 

 A style is a set of formats consisting of such things as background 

colors, fonts, font colors, and font sizes. 

Access supplies predesigned styles that format titles, labels, and more. 

When you choose a style, the left side of the window displays a preview. 

After you create a report, you can modify it. You can add groups or 

sorts, add fields, change labels, and perform many other tasks (fig. 14.13). 
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Fig. 14.13. Adding fields to MS Access reports 

 

You can view a report in Report view, Layout view, Design view, and 

Print Preview. You can modify a report in Layout view or Design view. In 

Layout view, you can see your data, and the report you see closely 

resembles how your report will look when you print it. You can make most, 

but not all, changes to your report in Layout view. Design view displays the 

structure of your report. In this view you cannot see the underlying data, but 

you can perform some tasks in Design view that you cannot perform in 

Layout view.  

Often, the people who use Access data only see a printed report. In 

Print Preview, you can see exactly how your report will look when printed, you 

can make changes to it, and you can print it. To print, click the Print button in 

the Print group. The Print dialog box opens and you can select your print 

options. 

 

 

 Questions 

 

1. What is a database form? What types of forms can be created in a 

MS Access database? 

2. What is a query? For what purpose is it used? 

3. What is the difference between queries and reports in a database? 

What is the purpose of each? 
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Section 6. Presentations creation technology using 

MS Office PowerPoint 

Theme 15. Introduction to MS Office PowerPoint essentials 
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Fig. 15.1. System elements of the theme 
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 Introduction 

The purpose of this theme is concerned with the study of main features 

of MS Office PowerPoint presentations creation software. The program’s 

interface is considered in detail and basic operations concerned with the 

creation and modification of presentation documents are given a special 

attention. 

Clue notions of the theme include: office button; ribbon; pop-up 

menus; slides formatting; headings; backgrounds; layouts, themes; 

templates; file formats. 

This theme covers the following topics: Introduction to the Power Point 

environment. The Power Point interface and its basic elements. Power Point 

files and basic operations with Power Point presentations. Moving around 

slides and presentations. Introduction to the technology of inserting and 

manipulating slides in a presentation. Inserting slides from different sources. 

Changing the size and orientation of presentation slides. Showing of hidden 

slides during the presentation. Introduction to the technology of creating and 

modifying slides backgrounds in MS Power Point presentations. 

As a result of the study of the material represented in this theme 

students will acquire the following competencies: 

they would get acquainted with the program’s interface features; 

they would master the technology of creating slides manually and using 

templates; 

they would learn how to save presentations in different formats, 

including availability for previous versions of Microsoft Office; 

they would master basic navigational operations in the Power Point 

environment; 

they would master the technology creating new slides and using 

existing slides from other presentations and MS Word documents; 

they would learn different ways of organizing and changing the 

background for MS Power Point slides. 

 

15.1. Introducing MS PowerPoint: workspace essentials 

Microsoft PowerPoint, usually called just PowerPoint, is a proprietary 

presentation program developed by Microsoft. It is part of the Microsoft Office 

suite, and runs on Microsoft Windows and Apple's Mac OS X operating 

system. To make PowerPoint do your bidding, you need to know a little 

jargon. 
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 Presentation – all the slides, from start to finish, that you show your 

audience. Sometimes presentations are called "slide shows." Presentations 

are saved in presentation files (.pptx files). 

Slides are the images you create with PowerPoint. During a 

presentation, slides appear on-screen one after the other.  

Handouts are printed pages that you may give to the audience after a 

presentation. A handout shows the slides in the presentation. Handouts are 

also known by the somewhat derogatory term "leave-behinds." 

PowerPoint isn't just a speaker's aid, but a means of communicating 

something to an audience — an idea, a business plan, a marketing strategy. 

PowerPoint offers numerous ways to communicate with an audience above 

and beyond what can be said in words. For that PowerPoint uses colors, 

photographs and other images, tables, charts, diagrams, shapes and text-box 

shapes, sounds and videos. 

Most presentations are made to be delivered in person by a speaker, 

but you can deliver presentations from afar by choosing special commands. 

These kinds of presentations can run in your absence: 

self-running presentation –  a presentation that runs on its own and 

can be exhibited at a trade show or other public place; 

user-run presentation – a presentation that others can run. Special 

buttons permit individuals to go from slide to slide; 

a handout is a printed copy of a presentation; 

a CD (DVD) is a packaged CD copy of a presentation that others can 

show on their computers. People who don't have PowerPoint can view 

presentations after they are packed for a CD; 

a Web page is a version of a presentation formatted for display on the 

Internet or an intranet. 

Here is a short explanation of some basic elements of the Power Point 

interface (fig. 15.2). 

Title bar is the stripe along the top of the screen. It lists your presenta-

tion's name. Window buttons are for shrinking, enlarging, and closing the 

PowerPoint window. Office button is the round button you can click to open 

a menu with commands for creating, opening and saving PowerPoint 

presentations, as well as doing other file-management tasks. Quick Access 

toolbar is a toolbar with three buttons – Save, Undo, and Repeat. You see 

this toolbar wherever you go in PowerPoint. 
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Fig. 15.2. The different parts of the PowerPoint screen 

 

Ribbon is the place where the tabs are located. Click a tab – Home, 

Insert, Design, Animations, Slide Show, Review, or View – to start a task. 

Slides pane is the place on the left side of the screen where you can see the 

slides or the text on the slides in your presentation. Scroll in the Slides pane 

to move backward and forward in a presentation. Slide window is where a 

slide (in Normal view) or slides (in Slide Sorter view) are displayed. Scroll to 

move backward or forward in your presentation. Notes pane is where you 

type notes (in Normal view) that you can refer to when giving your 

presentation. The audience can't see these notes — they are for you and you 

alone. Status ban tells you information about your presentation. View 

buttons are the buttons you can click to switch to (from left to right) Normal, 

Slide Sorter, and Slide Show view. Zoom controls are used to enlarge or 

shrink the slide (in Normal view) or slides (in Slide Sorter view). 

Across the top of the screen is the Ribbon, an assortment of different 

tabs; click a tab to undertake a task. For example, click the Home tab to add 

a slide to a presentation and format the text on slides; click the Insert tab to 

insert a table or picture, among other things, on a slide. Figure 15.3 shows 

what you see when you click the Home, Insert, and Design tab on the Ribbon. 

Each tab offers a different set of buttons and galleries. 

To make the Ribbon disappear and get more room to view slides, right-

click the Ribbon and choose Minimize the Ribbon on the shortcut menu. To 

see the Ribbon again, right-click a tab name or the Quick Access toolbar and 
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deselect Minimize the Ribbon on the shortcut menu. While the Ribbon is mini-

mized, you can click a tab name to display a tab. 

 
Fig. 15.3. The commands are different on each tab on the Ribbon 

 

A Mini toolbar is a ghost-like menu that appears on-screen to help you 

do a task, as shown in Figure 15.4. Move the pointer onto a Mini toolbar, and 

it ceases being ghost-like. You can choose an option from a drop-down list or 

click a button on the Mini toolbar to complete a task. 

 
Fig. 15.4. Move the pointer over a Mini toolbar to make it come alive 

 

Depending on the task at hand, some views are better than others. 

Figure 5 demonstrates different ways of viewing a presentation. PowerPoint 

offers two places to change the view. 

View buttons on the Status bar: click a View button – Normal, Slide 

Sorter, or Slide Show – on the Status bar to change views, as shown in 

Figure 15.5. 

 View tab: click the View tab and then click a button on the Presentation 

Views group to change views, as shown in Figure 5. 

 Switch to Normal view and select the Outline tab in the Slides 

pane when you're entering or reading text. You can find the Outline tab at the 

top of the Slides pane. The words appear in outline form. Normal/ Outline 

view is ideal for focusing on the words in a presentation. 
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 Switch to Normal view and select the Slides tab in the Slides 

pane when you want to examine a slide. In this view, thumbnail slides appear 

in the Slides pane, and you can see your slide in all its glory in the middle of 

the screen. Scroll to and select a slide to make it appear on-screen. You can 

use the scrollbar in the Slides pane to find a particular slide. 

 
Fig. 15.5. Techniques for changing views 

 

 In Slide Sorter view, you see thumbnails of all the slides in the 

presentation. From here, moving slides around is easy, and seeing many 

slides simultaneously gives you a sense of whether the different slides are 

consistent with one another and how the whole presentation is holding up. 

The slides are numbered so that you can see where they appear in a 

presentation. 

 In Slide Show view, you see a single slide. Not only that, but the 

slide fills the entire screen. This is what your presentation will look like when 

you show it to an audience. You can see what a slide really looks like at this 

size. To advance from slide to slide, click the screen. To quit Slide Show 

view, press the Esc key or right-click and choose End Show on the shortcut 

menu. 

In Notes Page view, you see notes you have written to aid in your 

presentation, if you've written any. You can write notes in this view as well as 

on the Notes pane in the Normal view. PowerPoint gives you one page per 

slide (although you can change that). To get from page to page, drag the 

scrollbar. 
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Sometimes color on slides, not to mention animations and graphics, is a 

distraction. To strip down slides to their bare essence, change to Grayscale 

or Pure Black and White view. These views don't actually change the color on 

slides — they change the slides' appearance only on your computer monitor. 

Pure Black and White is especially useful for focusing on text. 

Also on the View tab are the Master views — Slide Master, Handout 

Master, and Notes Master. To switch to these views, visit the View tab and 

click the appropriate button. These sophisticated views are for handling 

master styles, the formatting commands that pertain to all the slides in a 

presentation (Slide Master view), the printed handouts you can give to 

audience members (Handout Master view), and the notes you write to 

yourself about giving a presentation (Notes Master view). 

 

15.2. Creating and saving a new presentation 

When you start PowerPoint, the program creates a new, blank 

presentation. You can make this bare-bones presentation the starting point 

for constructing your presentation, or you can get a more sophisticated, fully 

realized layout and design by starting with a template. 

 A template is a starter file for creating a presentation. Each 

presentation is founded on a template. 

Each presentation inherits its colors, designs, fonts, and slide layouts 

from the template on which it was founded (the blank presentation gets its 

design from a simple, bare-bones template). When you decide between 

creating a presentation from the blank presentation or a template, you're 

really deciding what your presentation will look like. 

Figure 15.6 shows a slide created from the blank presentation (left) and 

a slide created from a template (right). When you create a presentation with a 

template, all design decisions are made for you. You get ready-made 

background colors, fonts, and slide layouts. 

Templates are designed by artists and they look very good. Some 

templates come with boilerplate text – already written material that you can 

recycle into your presentation. However, presentations made from templates 

are harder to modify. Sometimes the design gets in the way. A loud or 

intricate background may overwhelm the diagram or chart you want to put on 

a slide. 
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For example, the clip-art image on the blank-presentation slide in Figure 

6 would look out of place on the template slide because the image and the 

template background are incompatible. 

 
Fig. 15.6. A slide made from the blank presentation (left) and a 

template (right). 

Starting from the blank presentation means doing the design work on 

your own, although, as it was mentioned earlier, designing presentations isn't 

as hard as most people think because you can choose ready-made themes 

and background styles for a blank presentation. Sometimes simpler is better. 

By starting from a blank presentation, you aren't locked into someone else's 

design choices, and you have more creative opportunities. 

PowerPoint shows you a blank presentation each time you open the 

program. You can save this presentation and start to work or, if you're 

working on another presentation already and you want to create a new, blank 

presentation, you can follow these steps to create it: 

1. Click the Office button. 

2.  Choose New on the drop-down list. 

You see the New Presentation dialog box, shown in Figure 15.7. 

3.  Double-click Blank Presentation. 

A new presentation appears. You can also create a new blank 

presentation by pressing Ctrl+N. Try visiting the Design tab and choosing a 

theme or background style to get a taste of all the things you can do to 

redesign a presentation. 

The New Presentation dialog box (refer to Figure 15.7) offers many 

opportunities for finding a suitable template. To open this dialog box, click the 

Office button and choose New on the drop-down list. As you employ the 

following techniques to find a template, remember that you can click the Back 
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or Forward button in the dialog box to retreat and advance during your 

search. 

 
Fig. 15.7. The New Presentation dialog box is the starting point for 

creating a new presentation 

Soon after you create a new presentation, be sure to save it. And save 

your presentation from time to time as you work on it as well. Until you save 

your work, it rests in the computer's electronic memory (RAM), a precarious 

location. To save a presentation, do one of the following: 

click the Save button ; 

press Ctrl+S; 

click the Office button and choose Save on the drop-down list. 

Not everyone is a proud owner of new versions of Microsoft Office 

PowerPoint. Before you pass along a document to a co-worker who has an 

earlier version of PowerPoint, be sure to save a presentation so that 

PowerPoint 97, 2000, 2002, or 2003 can open it. 

 

15.3. Understanding how slides are constructed 

Before you insert a slide, PowerPoint asks you a very important 

question, "What kind of slide do you want?" You can choose among several 

different slide layouts, the preformatted slide designs that help you enter text, 

graphics, and other things. Some layouts have text placeholder frames for 

entering titles and text. Some layouts come with icons that you can click to 

insert a table, diagram, clip-art image, picture, Excel worksheet, or video. 

To make a wise choice about inserting slides, it helps to know how slide 

layouts are constructed. Figure 15.8 shows one of the simplest layouts, Title 

and Content, in three incarnations: 
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the Title and Content layout as it appears on the New Slide drop-down 

list (left). As you will find out shortly, you create a slide by choosing a layout 

from the New Slide drop-down list; 

the slide as it looked right after it was selected, before any text was 

entered (middle); 

the finished product, after a bulleted list was entered (right). 

The Title and Content slide layout comprises two placeholder frames, 

one for entering a title and one for entering either a bulleted list or "content" of 

some kind – table, chart, diagram, picture, clip-art image, or video. Most slide 

layouts come with text placeholder frames to make the task of entering text 

on a slide easier. 

 
Fig. 15.8. A slide layout (left), the bare-bones slide (middle), and 

the finished slide (right) 
 

When you create a slide, select the layout that best approximates the 

slide you have in mind for your presentation. As you get better with 

PowerPoint, you'll discover that slide layouts are actually kind of limiting. 

You'll find yourself tweaking the layouts to remove some of the frames and 

change the size of frames. For now, remember that slides are constructed 

from frames and that frames are designed to help you lay out text and 

graphics. Remember that frames help you enter text and other content. 

After you create a presentation, your next step is to start inserting the 

slides. PowerPoint has done its best to make this little task as easy as 

possible. You can insert slides one at a time, duplicate a slide you have 

already made, steal slides from another presentation, or nab content from a 

Microsoft Word document. 

Creating a duplicate slide can save you the trouble of doing layout work. 

All you have to do is re-create a slide and then go into the duplicate and 

change its title, text, or other particulars. PowerPoint offers no fewer than 

three different ways to clone slides.  
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Stealing is wrong, of course, except when stealing slides from other 

PowerPoint presentations. One way to steal slides is to open the other 

presentation, copy slides to the Clipboard, and paste the slides into your 

presentation (see the previous section in this lesson). You can also take 

advantage of PowerPoint commands designed especially for recycling slides 

(fig. 15.9). 

Headings in a Microsoft Word document are similar to titles in a 

Microsoft PowerPoint slide. As do titles, headings introduce a new topic. They 

tell you what is to follow. 

 
Fig. 15.9. Examine and select slides in the Reuse Slides task pane 

 

A heading announces the subject of the text to follow in the same way 

that a slide title announces what the subject of a slide is. If you have the 

wherewithal to do it, you can create slides from the headings in a Word 

document. First-level headings – that is, headings assigned the "Heading 1" 

style in Word – become slide titles in your presentation. Second-level 

headings become top-level bullet points on slides; third-level headings 

become second-level bullet points on slides; and so on. Figure 15.10 shows 

what the headings from a Word document look like after they land in a 

PowerPoint presentation. 

 
Fig. 15.10. Headings from a Word document imported into a 

PowerPoint presentation. 
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PowerPoint creates one new slide for each first-level heading in your 

Word document. The new slides are given the Title and Content slide layout. 

Each first-level heading from the Word document appears in a slide title. 

Depending on how many first-level headings are in the Word document, you 

get a certain number of new slides. 

The first thing to know about changing the size of the slides in a 

presentation is don’t do it! Unless you have a very good reason for that. 

PowerPoint presentations are designed to fill a computer monitor screen. If 

your slides aren't doing that, you may have inherited an old PowerPoint 

presentation with slides that need resizing. In that case, follow these steps to 

choose a new size for the slides in your presentation: 

click the Design tab; 

click the Page Setup button. 

The Page Setup dialog box opens, as shown in Figure 15.11. 

 
Fig. 11. The Page Setup dialog box (left) and a portrait-style slide 

(right). 
 

Sometimes there appears a necessity to hide a slide when you want to 

keep it on hand "just in case" during a presentation. Hidden slides don't 

appear in slide shows unless there is a shortcut to them in some other slides. 

The best place to put hidden slides is the end of a presentation where 

you know you can find them. Follow these steps to hide slides: 

select the slide or slides; 

on the Slide Show tab, click the Hide Slide button. 

You can also right-click and choose Hide Slide. Hidden slides' numbers 

are boxed in the Slides pane and Slide Sorter window. To "unhide" a slide, 

select the slide and click the Hide Slide button again or right-click it in the 

Slides pane or Slide Sorter window and choose Hide Slide on the menu. 



 195 

Hidden slides don't appear during the course of a presentation, but 

suppose that the need arises to show one. Before showing a hidden slide, 

take careful note of which slide you're viewing now. You'll have to return to 

this slide after viewing the hidden slide (fig. 15.12). 

 
Fig. 15.12. Going to a hidden slide. 

 

15.4. Creating and modifying slides backgrounds 

From the audience's point of view, this part is very important. What your 

presentation looks like – which theme and background style you select for the 

slides in your presentation, what is the formatting style of the text – sets the 

tone. 

Besides using a pre-installed theme another option for creating slide 

backgrounds is to do it on manually. For a background, you can have a solid 

color, a transparent color, a gradient blend of two colors, a picture, or a clip-

art image. How to create these kinds of slide backgrounds on your own is the 

subject of this lesson. 

To create a background style of your own, start on the Design tab and 

click the Background Styles button. Then, on the drop-down list, select 

Format Background. You see the Format Background dialog box. From 

there, you can get to work on creating a customized background on your own. 

Using a solid or transparent color as the background of slides gives 

your presentation a straightforward, honest look. Because all the slides are 

the same color or transparent color, the audience can focus better on the 

presentation itself rather than the razzle-dazzle.  

Gradient refers to how and where two colors grade, or blend, into one 

another on a slide. As well as the standard linear gradient direction, you can 

opt for a radial, rectangular, or path gradient direction, as shown in fig. 15.13. 

Gradient backgrounds look terribly elegant. Using a gradient is an 

excellent way to create an original background that looks different from all the 

other presenters' slide backgrounds. 
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Fig. 15.13. The Gradient Type options  

 

To create a gradient background for slides, start on the Design tab, 

click the Background Styles button, and choose Format Background on 

the dropdown list. Then, in the Format Background dialog box, click the 

Gradient Fill option button. You get a different set of options in the Format 

Background dialog box. 

Before you experiment with gradients, try opening the Preset Colors 

dropdown list to see whether one of the preset options does the job for you. 

Drag the Format Background dialog box to the left side of the screen 

so that you can see your slide better, and follow these steps to create the 

gradient blend of the different colors: 

select Stop 1 on the Gradient Stops drop-down list; then click the Color 

button and select a color; then click the Add button; 

select Stop 2 on the Gradient Stops drop-down list, select a color for it 

as well, and click the Add button. 

Now you've selected the two gradient colors. You can select more 

colors if you wish. Your next task is to tell PowerPoint where to blend the 

colors. 

Clip-art images and graphics do fine for slide backgrounds. They look 

especially good on title slides. Figure 15.14 shows examples of clip-art 

images as backgrounds.  

 
Fig. 15.14. For backgrounds, clip art usually has to be at least 

somewhat transparent 
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PowerPoint comes with numerous clip-art images. You are invited to 

place one in the background of your slides by following these steps: on the 

Design tab, click the Background Styles button to open the drop-down list; 

choose the Format Background command at the bottom of the menu; click 

the Picture or Texture Fill option button and find a clip-art image you can use 

in the background of your slides. 

Another option for slide backgrounds is to use a texture (fig. 15.15).  

 
Fig. 15.15. Different textures (clockwise from upper-left): Papyrus, 

Canvas, Newsprint, and Cork. 
 

As shown in Figure 15.15, a texture gives the impression that the slide 

is displayed on a material such as cloth or stone. A texture can make for a 

very elegant slide background. 

 

 

 Questions 

 

1. What is a presentation and for what purposes is it used? 

2. What are the main elements of a presentation? 

3. Is it possible to hide slides in a presentation? 

4. What formatting tools are available in MS PowerPoint to change the 

looks of slides? 

5. Is it possible to use text created in MS Word in MS PowerPoint 

slides? 

6. What types of slide backgrounds are available in MS PowerPoint? 
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Theme 16. Adding and formatting information content to 

MS PowerPoint slides: text, tables, diagrams and graphics 
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Fig. 16.1. System elements of the theme 
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 Introduction 

The purpose of this theme lies in a close study of main operations 

connected with adding and formatting of information content to MS 

PowerPoint slides. Work with text blocks, tables, diagrams and picture 

objects are considered supplied with detailed step-by-step instructions. 

Clue notions of the theme include: text boxes; tables; diagrams; 

pictures; compression; shapes; bitmapped and vector graphics. 

This theme covers the following topics: Нow to create text boxes and 

how to place text with precision on slides. Tables creation and editing 

technology. Analysis of how PowerPoint diagrams are constructed from 

SmartArt graphics and how to create a thematic diagram 

As a result of the study of the material presented in this theme students 

will acquire the following competencies: 

they would learn different ways of formatting text on MS Power Point 

slides; 

they would master different ways of formatting tables; 

they would study different ways of formatting diagrams and images on 

MS Power Point slides. 

 

16.1. Use of text boxes on PowerPoint slides 

Text boxes give an opportunity to exercise personal creativity. They add 

another element to slides. Use them to position text wherever you want, 

annotate a chart or equation, or place an announcement on a slide. You can 

even create a vertical text box in which the text reads from top to bottom 

instead of left to right, or turn a text box into a circle, arrow, or other shape. 

Figure 16.2 shows examples of text boxes. 

 
Fig. 16.2 . Examples of text boxes 

 

In order to create a text box Open the drop-down list on the Text Box 

button and choose Horizontal or Vertical, as shown in Figure 16.3. 
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Fig. 16.3. Drawing, moving, and resizing a text box 

 

To remove a text box, select it by clicking its perimeter; then, press the 

Delete key. Deleting a text box deletes all the text inside it as well. 

Besides creating a vertical text box by opening the drop-down list on the 

Text Box button (see the previous section), you can turn a text box on its 

side, as shown in Figure 16.3. Use one of these techniques: 

drag the rotation handle: click and drag the green rotation handle 

(refer to Figure 4); 

choose a Rotate or Flip command: on the (Drawing Tools) Format 

tab, click the Rotate button and choose a Rotate or Flip command on the 

drop-down list (depending on the size of your screen, you may have to click 

the Arrange button first); 

open the Size and Position dialog box: On the (Drawing Tools) Format 

tab, click the Size group button (you may have to click the Size button first). 

You see the Size and Position dialog box. On the Size tab, enter a 

measurement in the Rotation box. Use the Size and Position dialog box to 

rotate several text boxes or other objects by the same degree (fig. 16.4). 

 
Fig. 16.4. You can turn text boxes on their ears 

 

Rather than use the conventional rectangle as a text box, use can a 

shape. PowerPoint offers no fewer than 140 different shapes, including 

arrows, circles, stars, and banners. Any of these shapes can do double-duty 

as a text box. Figure 16.5 shows examples of shapes as text boxes. Create a 
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text box with rounded corners, or to really call attention to text, use a heart or 

arrow as a text box. 

 
Fig. 16.5. Using shapes as textboxes 

 

You probably have to resize the shape to make the text fit snugly inside 

it. If your text-box shape appears not to have changed shapes, click the 

Shape Fill button and choose a color for your shape. 

Figure 16.6 demonstrates ways to change the direction of text in a text 

box or text frame. Normally, text is horizontal and reads from left to right, but 

you can turn it on its ear or stack it. In stacked text, the letters appear one 

below the next. Stacked text can be appealing when you stack a single word. 

 
Fig. 16.6. Ways to change the direction of text 

 

Follow these steps to change the direction of text in a text box or text 

frame: 

select the text box or text frames and go to the Home tab; 

click the Text Direction button and select a Text Direction option on 

the drop-down list, as shown in Figure 6. 

Choose the Horizontal option to read text the normal way. Often you 

have to change the shape of a text box to make the text fit inside it after you 

choose a Text Direction command. 

You can also change the direction of text by way of the Format Shape 

dialog box. Right-click the text box, choose Format Shape (or choose More 

Options on the Text Direction drop-down list), and click the Text Box 

category in the Format Shape dialog box. Then open the Text Direction 
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drop-down list and choose an option. Another way to change the direction of 

text is to rotate the text box or text frame holding the text. 

As shown in Figure 16.7, how text is aligned in text frames and text 

boxes is governed by two sets of commands, the Align commands and the 

Align Text commands. Align commands – Align Left, Center, Align Right, 

and Justify – control horizontal (left-to-right) alignments. Align Text 

commands – Top, Middle, and Bottom – control vertical (up-and-down) 

alignments. 

By choosing combinations of Align and Align Text commands, you can 

land text where you want it in a text frame or text box. Just wrestle with the 

two commands until you land your text where you want it to be in the text 

frame or box. 

 
Fig. 16.7. Align Text and an Align commands to position text in text 

frames and boxes 
 

Indenting text means to put a dent in a text frame or text box. Actually, 

indenting means to move text inward from the left or right side of a text frame 

or text box. 

On the printed page, how text is indented tells one something about the 

text. For example, when you see text indented from the left and right side, 

you can be pretty sure you're looking at a long, block quotation. Because 

slides present text in small doses and the text usually fits on one line, text 

indentation doesn't matter as much on slides as it does on the printed page. 

Still, indenting text in different ways can give a slide presentation variety and 

make it a little livelier. Here are the different ways to indent text. 

Left indent: text is indented from the left side of the text box or frame. 

Right indent: text is indented from the right side. Used along with left 

indents for block quotations, announcements in the text, and other occasions 

when text needs to stand out. 
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First-line indent: the first line of each paragraph is indented. Helps 

readers mark the start of a new paragraph. 

Hanging indent: the second and subsequent lines are indented, not 

the first line. Used in bulleted lists and numbered lists. In a hanging indent, 

the bullet character or number on the first line is flush with the left side of the 

text box or frame, and the other lines in the paragraph are indented. A 

hanging indent is sometimes called an outdent. 

PowerPoint offers two means of indenting indent text. To indent text 

from the left and right sides of a text box or text frame, choose between two 

options. 

Paragraph dialog box. On the Home tab, click the Paragraph group 

button to open the Paragraph dialog box and enter indentation settings, as 

shown in Figure 16.8. 

 
Fig. 16.8. Paragraph dialog box 

 

Indent Markers on the Ruler. Drag markers on the ruler to indent a 

paragraph, as shown in Figure 16.9. To display the ruler, click the View tab 

and then click the Ruler check box (you may have to click the Show/Hide 

button first, depending on the size of your screen). 

 
Fig. 16.9. Changing indents with ruler markers 



 204 

In typesetting terms, a bullet is a black, filled-in circle or other character 

that marks an item on a list. 

As Figure 16.10 shows, bulleted lists are useful when you want to 

present the reader with alternatives or present a list in which the items are 

not ranked in any order. Use a numbered list to rank items in a list or present 

step-by-step instructions, as shown in Figure 16.10. 

 
Fig. 16.10. Items aren't ranked in a bulleted list (left); use a 

numbered list to show rankor chronology 
 

Many slide layouts include text frames that are already formatted for 

bulleted lists. All you have to do in these text frames is "click to add text" and 

keep pressing the Enter key as you enter items for your bulleted list. Each 

time you press Enter, PowerPoint adds another bullet to the list. 

As Figure 16.11 demonstrates, the black filled-in circle isn't the only 

character you can use to mark items in a bulleted list. You can also opt for 

what PowerPoint calls "pictures" or symbols from the Symbol dialog box. 

While you're at it, you can change bullets colors and size. 

 
Fig. 16.11. Examples of characters that can be used for bulleted lists 

 

To use pictures or unusual symbols for bullets, start by selecting your 

bulleted list (if you've already entered the list items), clicking the Home tab, 

and opening the drop-down list on the Bullets button. Click the Bullets and 

Numbering option at the bottom of the drop-down list. 

Also it is possible to set the amount of space between lines of text and 

between different paragraphs. Changing the amount of space between lines 

is simply a matter of clicking the Line Spacing button or choosing options in 
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the Paragraph dialog box. To change spacing start either by clicking in a 

single paragraph or selecting part of several paragraphs whose line spacing 

you want to change. Then click the Home tab and change line spacing with 

the Line Spacing button or Paragraph dialog box. 

 

16.2. Use of tables on MS PowerPoint slides 

The best way to present a bunch of data at one time is to do it in a 

table. Viewers can compare and contrast the data. A PowerPoint slide isn’t 

the place for an exhaustive table like the kind found in reference books. 

Researchers can't come back to a PowerPoint table to look up information as 

they can in a book table. Still, provided that the row labels and column 

headings are descriptive, a PowerPoint table is a great way to plead your 

case or defend your position. 

As with much else in “ComputerLand”, tables have their own jargon. 

Figure 16.12 describes table jargon. You need to catch up on these terms to 

construct the perfect table. 

 
Fig. 16.12. Parts of a table 

 

PowerPoint offers no fewer than four ways to create the cells and rows 

for a table. Create your table with one of these techniques. 

Dragging on the Table menu. On the Insert tab, click the Table button, 

point on the drop-down to the number of columns and rows you want, as 

shown in Figure 16.13, and let go of the mouse button. 

Clicking the Table icon. Click the Table icon in a content placeholder 

frame. You see the Insert Table dialog box, shown in Figure 16.13. Enter the 

number of columns and rows you want for your table and click OK. 

Using the Insert Table dialog box. On the Insert tab, click the Table 
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button and choose Insert Table on the drop-down list. The Insert Table dialog 

box shown in Figure 16.13 appears. Enter the number of columns and rows 

you want and click OK. 

 
Fig. 16.13. Declare how many columns and rows you want for the 

table 
 

Drawing a table. On the Insert tab, click the Table button and choose 

Draw Table on the drop-down list. The pointer changes into a pencil. Use the 

pencil to draw the table borders, the rows, and the columns. 

It is possible to merge and split cells to make tables a little more elegant 

than run-of-the-mill tables. Merge cells to break down the barriers between 

cells and join them into one cell; split cells to divide a single cell into several 

cells (or several cells into several more cells). 

In the table shown in Figure 16.14, the cells in rows 2, 4, and 6 have 

been merged, and a baseball player's name is in each merged cell. Where 

rows 2, 4, and 6 should have nine cells, they have only one. 

 
Fig. 16.14. Merge cells to create larger cells 

 

The fastest way to adjust the width of columns, the height of rows, and 

the size of a table itself is to "eyeball it" and drag the mouse: column or row 

or a table as shown in Figure 16.15. 
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Because resizing columns and rows can be problematic, PowerPoint 

also offers these handy buttons on the Layout tab for adjusting the width and 

height of rows and columns. 

Distribute Rows: click this button to make all rows in the table the 

same height. Select rows before clicking the button to make only the rows 

you selected the same height. 

Distribute Columns: click this button to make all columns the same 

width. Select columns before giving this command to make only the columns 

you selected the same width. 

 
Fig. 16.15. The two ways to change a table's size 

 

The trick to inserting and deleting columns and rows is to correctly 

select part of the table first. You can insert more than one column or row at a 

time by first selecting more than one column or row To insert two columns, 

select two columns and choose an Insert command; to insert three rows, 

select three rows and choose an Insert command. 

It is possible to slap color on the columns and rows of your table, draw 

borders around columns and rows, and choose a look for borders. Figure 

16.16 shows the drop-down lists on the (Table Tools) Design tab that pertain 

to table decoration. 

In a top-heavy table in which the header row cells – the cells in the first 

row – contain text and the cells below contain numbers, consider changing 

the direction of the text in the header row to make the table easier to read. 
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Fig. 16.16. Tools on the (Table Tools) Design tab for decorating 

tables 
 

Changing text direction in the header row is also a good way to 

squeeze more columns onto a table. Consider how wide the table shown in 

Figure 16.17 would be if the words in the first row were displayed horizontally. 

 
Fig. 16.17. Change the direction of text to squeeze more columns 

on a table 
 

Draw diagonal lines across table cells to cancel out those cells or 

otherwise make cells look different. In Figure 16.18, diagonal lines are drawn 

on cells to show that information that would otherwise be in the cells is either 

not available or is not relevant. 

 
Fig. 16.18. Diagonal lines mark off cells as different 

 

16.3. Putting diagrams and graphics on PowerPoint slides 

Along with tables, diagrams are the best way to present ideas to an 

audience. Diagrams clearly show, for example, employees' relationships with 

one another, product cycles, workflow processes, and spheres of influence. A 
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diagram is an excellent marriage of images and words. Diagrams allow an 

audience to literally visualize a concept, idea, or relationship (fig. 16.19). 

 
Fig. 16.19. Types of diagrams in MS PowerPoint 

 

In PowerPoint, diagrams are made from SmartArt graphics. These 

diagram graphics are "interactive" in the sense that you can move, alter, and 

write text on them. In other words, you can use them to construct diagrams of 

different types (refer to fig. 16.19). 

The first step in creating a diagram is to select a layout in the dialog box 

shown in Figure 16.20. 

 
Fig. 16.20. To create a diagram, start by selecting a diagram in this 

dialog box 
 

After selecting a generic diagram in the Choose a SmartArt Graphic 

dialog box and click OK, the next step is to make the diagram your own by 

completing these tasks: 

change the diagram's size and position: change the size and position of 

a diagram to make it fit squarely on your slide; 

add shapes to (or remove shapes from) the diagram: adding a shape 

involves declaring where to add the shape, promoting or demoting the shape 
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with respect to other shapes, and declaring how the new shape connects to 

another shape; 

enter the text: enter text on each shape, or component, of the diagram. 

If you have the skill and the wherewithal, you can create a diagram from 

scratch by piecing together shapes, arrows, and connectors on the Insert tab. 

The diagram in Figure 16.21, for example, was made not from SmartArt 

graphics but from shapes, arrows, and connectors. 

 
Fig. 16.21. A homegrown diagram made without SmartArt graphics 

 

Making a diagram from scratch has some advantages. You can draw 

the connectors any which way. Lines can cross the diagram chaotically. You 

can include text boxes as well as shapes etc. 

Using graphics (pictures and photos) on Power Point slides 

A picture, so they say, is worth a thousand words. What is certain is that 

visuals help people remember things. A carefully chosen image in a presen-

tation may help audience members remember or understand what your 

presentation is about. The image reinforces in their minds the ideas that you 

are trying to put across. 

All graphic images fall into either the bitmap or vector category. A 

bitmap graphic is composed of thousands upon thousands of tiny dots 

called pixels that, taken together, form an image (the term "pixel" comes from 

"picture element"). A vector graphic is drawn with the aid of computer 

instructions that describe the shape and dimension of each line, curve, circle, 

and so on. 

Resolution refers to how many pixels comprise a bitmap image. The 

higher the resolution, the clearer the image. Resolution is measured in dots 

per inch (dpi), sometimes called pixels per inch (ppi). Images with more dots 

(or pixels) per inch are clearer and display more fineness of detail. When you 

scan an image, your scanner permits you to choose a dots-per-inch setting. 
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High-resolution images look better but require more disk space than low-res-

olution images. 

Compression refers to a mathematical algorithm by which bitmap 

graphic files can be made smaller. In effect, compression enables your 

computer to store a bitmap graphic with less disk space. Some bitmap 

graphic types can't be compressed; other bitmap graphic types are 

compressed using either lossless or lossy compression. 

Color depth refers to the number of colors that can be displayed in a 

graphic file. The larger the color depth, the larger the number of colors that 

can be displayed, the richer the graphic looks, and the larger its file size is. 

Color depth is measured in bits. To get technical on you, color depth is 

measured in the number of bits that are needed to describe each pixel's color 

in the image. 

Follow these steps to insert a graphic on a slide: 

click the Insert tab and open the Insert Picture dialog box; 

select a file in the Insert Picture dialog box and click the Insert button. 

Figure 16.22 shows a graphic that has been made over several times 

with the Brightness and Contrast commands. Select a graphic, go to the 

(Picture Tools) Format tab, and experiment with the Brightness and Contrast 

commands to alter a graphic's look. You'll find the Brightness and Contrast 

commands in the Adjust group. 

 
Fig. 16.22. Experiments with the Brightness and Contrast 

commands 
 

In MS PowerPoint it is possible to crop-off part of a graphic. Cropping 

means to cut off part of a graphic. You can cut strips from the side, top, or 

bottom to do the job. In Figure 16.23, the cropping tool was used to cut off all 

but the head of a figure to turn a portrait into a head shot. 

A good thing about PowerPoint is that it allows to compress graphics to 

save disk space. By compressing graphics, you reduce their file size and 

consequently the file size of your presentation. 
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Fig. 16.23. You can cut off parts of a graphic with the Crop tool 

 

Not all graphics can be compressed, and some types of graphics lose 

their integrity when they are compressed. You can't resize lossy-compressed 

graphics without their looking odd. Compress graphics to make presentations 

load faster and make e-mail messages with PowerPoint attachments travel 

faster over the Internet (fig. 16.24). 

 
Fig. 16.24. Compressing graphics 

 

Compressing a graphic file reduces its points per inch (ppi) setting. The 

Compress Pictures command compresses the graphics in a presentation. 

You see the Compress Pictures dialog box shown on the left side of the 

Figure 16.24. 

 

 

 Questions 

 

1. What is a text box and for what purposes is it used? 

2. What are the main elements of a diagram? 

3. Is it possible to create a diagram from random shapes? 

4. What table formatting tools are available in MS Excel? 

5. What is the difference between bitmapped and vector graphics? 

6. What is the reason to compress graphics in a presentation? 

7. What types of diagrams are present in MS PowerPoint? 
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